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DISTRESS PROCEDURES

Telex Distress Alert Button IB-352 (Class 1 only)

1. Open the distress button cover on the 1B-352.
2. Press and hold down the [DISTRESS] button six seconds.

@ [ INMARSAT-B j @

TELEX DISTRESS ALERT BUTTON
(@ T —
@ ————— )
(€ )]
- )
———— ]

-
Keep pressed for 6 s in case of DISTRESS.
The alert is transmitted with steady lighting.

DISTRESS > DISTRESS
button ‘

TELEX DISTRESS BUTTON
TYPE 1B-352
SERNO. [ — ]
COMPASS SAFE DISTANCE
STD[0.8 Jm STEER [0.6 Jm

FURUNO ELECTRIC CO., LTD.
52 +-Cho, Nis! iya

9-52 Ashihara-Cho, Nishinomiy:
City, Japan MADE IN JAPAN

Telex Distress Alert Button I1B-352

The unit beeps intermittently and the red lamp on the button flashes. When the unit
beeps continuously and the red lamp lights, the distress message is sent to the LES.
Your outgoing message and message from the LES appear on the terminal unit and are
printed.

Message from designated LES

343112345 FURU X Your ship's answerback code

MARITIME

LAT 34 00 N, LONG 136 00 E ------------- Position

04 05 UTC, 24 MAY- Date

8 Nature of distress (8: Undesignate) | These are
180 Ship's course transmitted.
10 Ship's speed

3. After the distress alert has been transmitted the line with the LES remains connected.
Send a message to the LES by direct keyboard input.
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Telephone Distress Button IB-362, Handset 1B-882-362
(Class 1, Class 2)

The [DISTRESS] button is incorporated in the hanger of the Handset IB-882-362 or in the
Telephone Distress Alert Button IB-362 in the case of the Handset IB-882.

no

»

@ ( INMARSAT-B ) @

TELEPHONE DISTRESS ALERT BUTTON

——————— >
——————— >

———————
——————— >
———————

Keep pressed for 6 s in case of DISTRESS.
The alert is transmitted with steady lighting. DISTRESS

r button
DISTRESS »| DISTRESS
button ‘

TELEPHONE DISTRESS BUTTON
TYPE 1B-362

SERNO. [ ]
COMPASS SAFE DISTANCE
STD[0.8_Jm STEER [0.6_]m

FURUNO ELECTRIC CO., LTD.

9-52 Ashihara-Cho, Nishinomiya
City, Japan MADE IN JAPAN

Telephone Distress Alert Button 1B-362 Hanger of Handset IB-882-362

Pick up the handset.
Open the distress button cover.
Press and hold down the [DISTRESS] button six seconds.

The distress alert device beeps intermittently and the red lamp on the button flashes.
When the device beeps continuously and the red lamp lights, the priority of the handset is
set to “Distress.”

Press the [@®] key on the handset.
Dial an LES, referring to Appendix B, and press the [#] key as below. (The beep stops
when you are connected with the LES.)

IRERNRC

—
LES No.

Commence communication with LES, giving your ship’s name, nature of distress,
assistance needed and description of your vessel.
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A SAFETY INSTRUCTIONS

/AN WARNING /A WARNING

ELECTRICAL SHOCK HAZARD
Do not open the equipment.

Only qualified personnel
should work inside the
equipment.

Do not approach the radome
closer than 6 meters when
it is transmitting.

The radome emits radio waves
which can be harmful to the
human body, particularly

the eyes.

Leave the equipment powered while
underway.

Distress cannot be communicated unless
the equipment is powered.

Wait at least 30 minutes after turning off
the power before entering the radome.

The gyro motor rotates for some time after
the power is turned off.

Do not disassemble or modify the
equipment.

Fire, electrical shock or serious injury can
result.

Turn off the power immediately if water
leaks into the equipment or the equip-
ment is emitting smoke or fire.

Continued use of the equipment can cause
fire or electrical shock.

Do not place liquid-filled containers on
the top of the equipment.

Fire or electrical shock can result if a liquid
spills into the equipment.

Do not operate the equipment with wet
hands.

Electrical shock can result.

Keep heater away from equipment.

Heat can alter equipment shape and melt
the power cord, which can cause fire or
electrical shock.

Any repair work must be done by a
licensed radio technician.

Improper repair work can cause electrical
shock or fire.

Use the proper fuse.

Fuse rating is shown on the equipment.
Use of a wrong fuse can result in damage
to the equipment.
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A CAUTION

Do not use the equipment for other than
its intended purpose.

Use of the equipment as a stepping stool,
for example, can result in personal injury
or equipment damage.

A warning label is attached to the
terminal, communication and antenna
units. Do not remove any label. If a label
is missing or damaged, contact a
FURUNO agent or dealer.

( A WARNING A\ \ Terminal, Communication

To avoid electrical shock, do not Unit -
remove cover. No user-serviceable | Name: Warning Label (1)

parts nside. Type: 86-003-1011-0
A A | Code No.: 100-236-230

A WARNING

(((, )) Hazardous microwave radiation.
A Can cause severe injury or illness.

Keep at least 6m from INMARSAT-B radome.

Radiation Level At

100W/m? 1.0m
25W/m? 4.0m
10W/m? 6.0m

Antenna Unit

Name: Radiation Warning Label
Type: 16-007-7902-0

Code No.: 100-216-340
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FOREWORD

A Word to the Owner of the FURUNO FELCOM
82A/82B

Congratulations on your choice of the FURUNO FELCOM 82A (Class 1),
FELCOM 82B (Class 2) Inmarsat-B Mobile Earth Station. We are confident you
will see why the FURUNO name has become synonymous with quality and
reliability.

For over 50 years FURUNO Electric Company has enjoyed an enviable
reputation for quality marine electronics equipment. This dedication to
excellence is furthered by our extensive global network of agents and dealers.

This equipment is designed and constructed to meet the rigorous demands of
the marine environment. However, no machine can perform its intended function
unless operated and maintained properly. Please carefully read and follow the
recommended procedures for operation and maintenance.

We would appreciate hearing from you, the end-user, about whether we are
achieving our purposes. Thank you for considering and purchasing FURUNO
equipment.

Features

The FELCOM 82A/82B mainly consists of an antenna unit, communication unit
and a handset. FELCOM 82A is additionally equipped with a terminal unit. The
FELCOM 82A provides telephone, facsimile, telex and data services. The
FELCOM 82B provides the same services as the FELCOM 82A excluding telex.

The main features of the FELCOM 82A/82B are

« Conforms to the following standards: IMO A. 808(19), IMO A. 694(17), IEC
61097-10 (1999), IEC 60945 (1996), IEC 61162-1 (2000)

« Compact handset functions as main telephone

« Automatic telephone/fax switching

+ Toll charges calculator

- Personal ID to monitor telephone, handset and fax usage

« Internal gyro interface

+ 9.6 kbps data communication

« High speed fax communication

« Automatic input and update of ship’s position and gyrocompass heading with
position and heading data inputs

« Non-rewind antenna

+ HSD communication function provided as standard.


http://www.reelschematic.com

SYSTEM CONFIGURATION,
PROGRAM NUMBERS

Aluo gz8 NOD134 10}
1371vdVd Pue (3un uoneslunwwoo)
Hod Y3 LNIYd Usamiag o|qe = g#
'288-4| 19SpUBH UJM 8SN IO = | #

L# ¢9€-91 NOLLNE SS341SId INOHdT 13l _H_

(Ajuo vzg N0O134) NOLLONAF |
Nmm-m__ NOLLNE 1¥3TV SS3HLSIA xm:m_h_H_‘ ““““““““““““““““““ P

(Aluo wzg WODT134)
z8s-4l

ele-gal
Xod

Alddns o0 -—-—- -
uondQ ---------

A|ddns psepuejlg ———

1INN

TVNINY3L

(Aluo wz8 WOD134)

01S-dd
Y3LNIYd
ZH 09/0S ‘oseyd |
OVA 0£2-022
/SLL-001

[4:;

suiew s, diys

¢g8c-4al
1INN
NOILVOINNAINOD

V1vd 19’6

spun ¢ "Xep
c¢/lg-4l N_O._.<O_DZ_ OZ__>_OOZ_

d0208-X¥410682-Xv4 TIIsovd ° 7 00

““““ o NSRS S S

d0£08-Xv4/0982XV4 FTINISOVS OVA 00
““““““““ _H_H.‘.‘.‘H.‘.‘"llll.........
S¢C-TIN Fommmou_ m_zo_._n_m_._m_._.

¢9€-2¢88-41/288-94I
13SANVH

(1/1L00Z 2Z00-€¥10-591 ONAS
(271002 ¥00-2¥L0-G9L  AOW3A
(Z1/0002) LOO-¥¥L0O-G9L  3A0D3A
(2/1002) 200-2G10-G9L LISANVH
(¥/1002) ¥00-9%10-591 NY3L
(¥/2002) 800-G¥10-G91 NIVIN
"ON NOISHIA WVID0dd

Xi


http://www.reelschematic.com

www reelschematic.com

This page is intentionally left blank.



http://www.reelschematic.com

1.

INMARSAT-B SYSTEM

1.1

1.2

What is Inmarsat?

The International Maritime Satellite Organization (Inmarsat), founded in 1979, is
the international governing body for maritime satellite communication. Its purpose
is to provide global communications for ships, land mobile and aircraft, using
satellites to overcome the problems that exist with conventional radio
communications.

The Inmarsat system is made up of three major components: the space segment
provided by Inmarsat, the Land Earth Stations (LES) provided by Inmarsat
signatories, and Mobile Earth Stations (MES). The Operation Control Center
(OCCQC), located at Inmarsat headquarters in London, controls the overall system.

Geostationary Satellites

The type of satellites used for maritime communication are geostationary
satellites. Four satellites, one for each of four ocean regions, are placed in nearly
36,000 km-high 24-hour circular orbits rotating in synchronous with the earth,
providing mobile-to-land, land-to-mobile, and mobile-to-mobile communications.
The satellites remain fixed over a given place on the earth's equator, so an
Inmarsat subscriber is always within coverage of a satellite.

Geostationary satellite
(35,860 km above Equator)
Earth Speed: 11,070 km/h

Revolution: 23 hrs 56 min

Geostationary satellites of the Inmarsat system

1-1


http://www.reelschematic.com

L INMARSAT-B SYSTEM

1.3 Service Area

The Inmarsat system divides the world into four regions and each region is
covered by its own satellite. The regions are Atlantic Ocean Region-East (AOR-
E), Atlantic Ocean Region West (AOR-W), Pacific Ocean Region (POR), and
Indian Ocean Region (IOR). The reason for two regions in the Atlantic Ocean is
to solve the coverage gap problem there.

Inmarsat satellite data

Region Satellite Satellite position
AOR-West Inmarsat-3, F4 54.0°W
AOR-East Inmarsat-3, F2 15.5°W

IOR Inmarsat-3, F1 64.0°E
POR Inmarsat-3, F3 178.0°E
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1.4

System Bodies

1. INMARSAT-B SYSTEM

The Inmarsat system consists of the bodies shown in the figure below.

ocCcC

SN

| . | ! !
| ! | | |
| ! | | |
i | | | :
i |7LES LES |_....._| LES | Same as left l Same as left iSame as left I
! ! ! ! !
| | | | |
i | | g !
i %%jjtellite I i | |
i i i i i
| | i i |
| g MES Sem | | | !
e e | | |
: : : : :
AOR-West AOR-East IOR POR

OCC: Operation Control Center
SCC: Satellite Control Center

NCS: Network Coordination Station
MES: Mobile Earth Station

LES: Land Earth Station

Inmarsat system bodies

The function of each body in the Inmarsat system is as shown in the table below.

Inmarsat bodies

Body

Function

Operation Control Center (OCC)

The OCC is the nerve center of the
system and is located at the Inmarsat’s
headquarters in London. The OCC
provides continuous, round-the-clock
cooordination for all functions in the
Inmarsat system.

Satellite Control Centers (SCC)

The SCCs main function is to correct
satellite rotation error.

Network Coordination Stations (NCS)

Each region has an NCS. The NCS
controls the lines of communication and
broacasts information such as
navigational warnings, weather reports
and news.

Mobile Earth Stations (MES)

Mobile Inmarsat-B stations including
aircraft.
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1.5 Inmarsat-B Services

The Inmarsat-B maritime satellite communication system provides digital
telephone (voice), facsimile, telex and data (9600 kbps) and HSD services. Use
of the latest digital technology means lower toll charges than in Inmarsat-A, since
high output power satellites are not required and data is transmitted at high
speed.

1.6 Comparison of Inmarsat Systems

Inmarsat provides worldwide communication services for both maritime and land
subscribers, and consists of four systems, A, B, C, M and Mini-M. The following
table shows the services available with each system.

Comparison of Inmarsat systems

Service | Inmarsat-A | Inmarsat-B Inmarsat-C Inmarsat-M Inmarsat Mini-M
Voice YES YES NO YES YES
Facsimile YES YES NO YES YES
Telex YES YES YES NO NO
Data YES YES YES YES YES
HSD YES YES NO NO NO

1-4
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2.

2.1
2.1.1

SETTING UP

Controls
Terminal unit (Class 1 only)

ESC

F1

AEEE)

Num Prt Sc

Lock

F4

FIEEIE) ) E

Scrol\ Pause
ock
Break

Syqu

%

8

@E

I

Caps Lock

-« Enter

f Shift

< Shlft

PgU

(Ctrl

Alt

‘

PgDn

)
CtrI --—
[Home]

End

Keyboard

Key description

Esc
F1-F10

Backspace
Insert
Delete
Home
End

PgUp
PgDn
tl, —, -
Enter
Shift

Cancels key input and returns to previous display screen.

These keys select menus (F1-F4) and telex functions (F5-F7,
F9-F10).

Deletes the character to the left of the cursor.

Works the same as PASTE function.

Deletes the character to the right of the cursor.

Moves the cursor to the top of a message being edited.
Moves the cursor to the bottom of a message being edited.
Goes to the previous page of the editor screen.

Goes to the next page of the editor screen.

Control the cursor.

Registers key input.

Selects upper and lower case alphabet or numerics and symbols.
Press and hold down the key to get upper case letters. Note that
only upper case letters are used in telex.

2-1
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2.1.2

2-2

Alt

Space Bar

Caps Lock

Tab

Ctrl

Fn

Num Lock

Executes the shortcut key operation when combined with an
alphabet key. See page 3-39.

Inserts a space. In addition, it displays file list, partial view of a file,
etc. depending on menu.

Turns upper case letter input on or off. Press this key while pressing
and holding down the [Shift] key to get all capital letters. CAPS
appears on the display when the keyboard is set for upper case
letter input.

Inserts horizontal tab characters. The number of tab characters the
key can insert per line of text can be programmed for two, four or
eight tabs on the Editor Setup menu.

Executes the shortcut key operation when combined with an
alphabet key. See page 3-40.

Combined with an arrow key, it scrolls the screen (1, 1) or shifts the
cursor (—, -).

Turns numeric input on or off. Note that you cannot enter some
alphabet when the Num LED is lit.

Note: In telex, lower case, #, &, *, $ and % are not used. A full list of characters
usable in telex appears on page D-2.

Handset

(N

L Earpiece
N — ey oy Alarm LED
= (Flashes for
system
5 &Y failure.)
- Controls
See next
E)age forx
description.)
Loudspeaker
Microphone

Front Rear

Handset
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Control description

ﬁ REDIAL

HOLD ~ Inter
Print - comm
FUNC ABBR ' DEL
Quit Find Prty
4 GHI 5 JKL

J

wWww.reeischematic.com

r
05

:

Symbols
-H-11-01-MH-11-
Dl-[<1-[1-1I[[1-11]1-

--=-0-M0-0-
Cl-01-0-T01-1[@ ~[]~
[+ - [1- - [$] - ¥ - [%] -]

2. SETTING UP
Control Function
- Opens communication line (off hook.)
REDIAL Redials selected number.
prres Disconnects communication line (on
hook).
HOLD Print | » Holds connected party.
* Prints screen showing symbol “00".
=  Shifts cursor upward.
 Increases earpiece volume.
Intercomm Turns intercom on/off.
« « Shifts cursor leftward.
e Selects menu option, parameter.
S5 e Decreases earpiece volume.
 Shifts cursor downward.
)  Shifts cursor rightward.
e Selects menu option, parameter.
FUNC Quit |« Opens/closes menu.
e Returns to standby display.
ABBR Find | Abbreviated dialing number functions
DEL Prty  Selects priority.
» Deletes entry.
1-9 * Inputs corresponding alphabet or
numeric.
* Mode e Separator
» Alternately enables alphabet and
numeric input.
» Alternately selects East/West and
North/South and vice versa.
0 Symb  Inputs “0” and symbols (see figure
at left).
# Ent » End code

Terminates menu operation.
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2.2  Turning On the Power

There is no particular order for turning on the units of the system. The handset is
powered when the communication unit is turned on.

. ol /s o/ NN

(]
(]

“'“““"3 mmmmmm Lot p— p
I je | e
POWER Switch +—> ¢ B F
4 ® a = P < ® p
o ] POWER Switch
Communication Unit .
Printer

BRILL Control

l[ ]l

POWER Switch —> 2. & E—==<4— Floppy Disk

- —  Drive

Terminal Unit

Location of power switches

When the communication unit is powered it supplies power to the handset and
the antenna unit. If a navigator and gyro are connected, the antenna unit is
automatically oriented towards the satellite selected. Several minutes later the
satellite is “acquired” and the system goes into stand-by, awaiting
communcations. You can see the standby displays for the terminal unit and
handset on the next page.
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2. SETTING UP

The standby display on the terminal unit appears about ten seconds after turning
on the power. After turning on the power, you can begin communications when
the message “Ocean Region registration complete” appears. (The Channel
Status indication should show “SYNC” and the MES Status indication,
“Ready”. )This takes about five minutes.

N
-------------------------------------------------------------------------- (00-09-08 15:04) ----.

Dat e 2000- 09- 08 Tx ElIRP Level 000
Ti me 15: 04( UTQ) Tx RF Level 000

Rx CN 053
Current Satellite POR —— Rx I F AGC Level 154
Channel Status SYNC -—]
VES St at us Ready RX SYN oK
T OFF — Tx SYN oK
Headi ng 270 DEG
Ant enna Beari ng 209 DEG
Ant enna Azi mut h 119 DEG Ant enna St at us REMOTE
Ant enna El evation 30 DEG El AXIS (0 ¢

Az AXI S (0 ¢
Posi ti on LAT 34:00. OON Cross EIl AXIS (04

LON 135: 00. 00E

Rx Channel 11292
NAV DATA NVEA Tx Channel 10000
GYRO DATA K

Indications shown when
equipment is ready to communicate.

Standby display (terminal unit)

The handset goes into standby about three seconds after the communications
unit is turned on. “Ready” appears when the handset is ready for communications.
When the power is supplied to the handset the display screen changes in the
following sequence.

FELCOM 82 2000-08-29
12: 34 UTC
| nmarsat-B I nmarsat - B
Mobi |l e FELCOM 82
Termi nal —
After 3 sec. Yiul AORE Ready<—— Ready for
(c) FURUNO communications
Start-up display Standby display

Signal strength

Yul,Yu,¥i: Communications possible
Y : Signal strength too low to communicate.

Standby display (handset)
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2-6

When “Ready” is displayed on the terminal unit and handset the following can be
done, with the equipment in the default setting.

Handset, telephone communications

» When the handset rings, pick it up and press the @] key to communicate with
party.
* When a telephone rings, pick up its receiver and communicate with party.

* Dial subscriber’'s number (LES, subscriber’'s number or ship ID) to
communicate.

For handset operation see Chapter 4 and for telephone operation see Chapter 5.

Telex communications (Class 1 only)

* Send a telex message automatically, provided that station and LES have been
registered in the equipment.

* Receive and read a telex message.

For details see Chapter 3.
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2. SETTING UP

2.3 Menu Operational Overview
2.3.1  Terminal unit (Class 1 only)

prilelledi thiel expoet upfVRURHRI SIBELLL Al RSt BB eakl

Menu ~ | \ (Not ied) ’\ /

COEDCE EDEEDE ) EI EY
OOoocag*~ gOoaodg

W%@\

Menu

1. To select a menu or function press the corresponding function key F1-F10 (F8
is not used). For example, press the [F4] key to display the Setup menu.

2: LES List

3: Termnal Setup
4: Editor Setup

7: W ndow Col or

Setup menu

2. Key in desired menu number with the numeric keys. Alternately you may
select a menu by using the [1] or [1] key and then pressing the [Enter] key.
After setting option, press the [Enter] key.

4. Press the [Esc]| key to return to the standby display.

w
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2.3.2 Handset

1. Press the [FUNC Quit] key to display the main menu. Note that some menus
and displays show triangle(s) and/or a square at the top right-hand corner of
the display. See page 4-2 for their meanings.

Mai n Menu Mai n Menu
v A

1
Reserved for user-{ 2 —» |6 MES
customization. — - | g LEIIS’I‘:AX

=
(See paragraph Select: [ Ent] <+— |Select: [ Ent]
4.11.5 on page

4-21 for further *Appears when HSD terminal's
details.) OID/DID number is registered in
the handset.
Main menu (default menu)

2. Press appropriate numeric key to choose menu desired, or use the [=] or [¥]
key to select menu desired and press the [Ent] key.
3. Press the [FUNC Quit] key several times to close the menu.

2-8
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2.4
2.4.1

24.2

2. SETTING UP

Adjusting Display Brilliance
Terminal unit (Class 1 only)
Adjust the [BRILL] control to suit lighting conditions.

Note: If the terminal unit is turned off with brilliance set to minimum the display
will be black when the terminal unit is turned on again. Use the [BRILL]
control to adjust display brilliance.

Handset

The handset has facilities for adjustment of keyboard and LCD backlighting, LCD
contrast, key beep on/off, and call ring volume.

1. Press [FUNC Quit], [6] and [1] to display the Handset menu.

61Handset 6l1Handset

v A
——» |5 KeyClick :
2 ldleLight:1 OF F/ eI
3 LCDBright:5
4 Buzzer Vol : 7 <
Lo: [ -] Hi : [ ®] Lo: [ =] Hi:][®]

Handset menu
2. Press appropriate numeric key referring to above illustration to select item and

then press [{{] or [] to set level. For IdleLight and KeyClick select ON or OFF.

BackLight:  Sets backlighting for the LCD and keyboard. Setting range: 0 —
3, Default: 3. “0” provides no backlighting.

IdleLight: Turns backlighting for the LCD and keyboard on or off when
the handset is hung in the hanger. Settings: ON, OFF, Default:
OFF.

LCDBright:  Adjusts brightness of LCD. Setting range 0 — 9, Default: 5. “0”
provides no brightness.

BuzzerVol:  Adjusts volume of call ring. Setting range: 0— 9, Default: 7. “0”
turns off the call ring.
KeyClick: Turns key beep, which sounds for valid key input, on or off.

Settings: ON, OFF, Default: ON.

Press the [Ent] key.
4. Press the [FUNC Quit] key several times to close the menu and return to the
standby display.

w
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2.5

2-10

Registering the Password at the Handset

There are two handset menu modes: User and Administration. The User mode
provides only a simple menu. The Administration mode requires a password to
open menus. When the system is powered the User mode is in effect.

The password set at the factory is 0000. In this setting you can go into the
Administration mode without a password. To require a password with the

Administration mode enter it as follows:

1. Press [FUNC Quit], [6] and [7] to display the Password input screen.

67Password

old :HR___

Password input screen

2. Key in 0000. Password is shown with asterisks. If you are not using the
factory-set password (0000) enter current password.

3. Press the [>*] key to select the New field.

4. Enter password desired and press the [Ent] key. You may use any four
numerals for the password.

5. Press the [¥*] key to select Conf.

6. Enter password again and press the [Ent] key. The message “The password
is changed.” is displayed.

7. Press the [FUNC Quit] key to close the menu. (If the password entered is
invaild the message “Password error!” appears. Enter the password again.)

Store the password in a safe place. To clear the password, enter old password in
the Old field and 0000 in both the New and Conf fields.

Note: Normally the operational mode is the “User mode.” To change to the
Administration mode, do the following:

a) Press [FUNC Quit], [6] and [3] to display the Change Mode input screen.
63Change Mode

User - Admi n
Enter Passwd:

m___
[ Ent ]

Enter:

b) Enter four digit-password and press the [Ent] key. Password entered is
shown with asterisks.
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2.6

2. SETTING UP

Distress Message Setup (Class 1 only)

The distress message, transmitted when the Telex Distress Alert Button 1B-352 is
operated, may be set up from the handset and terminal unit.

This procedure is done from the Administration mode. See page 2-10 for how to
choose the Administration mode.

Ship’s name
1. Press [FUNC Quit], [5] and [8] to show the DMG menu.
58 DMG 58 DMG
v A
Sh—all> Speed: AUTO
2 Maritime:Y
3 Nature:8
4 Course: AUTO | -——
Select: [ Ent] Select: [ Ent]
DMG menu
2. Press the [1] key to show the Ship’s Name input screen.
58 DMG
ALPH

Ship”s Name:

Enter: [ Ent]

DMG menu, ship’s name input screen

3. Enter your ship’s abbreviated name (telex answerback code) in four
alphanumeric characters with the alphanumeric keys and press the [Ent] key.
If an invalid name is entered the message “Input Error. Invalid data.” appears
and three seconds later the main menu is shown.

4. Press the [FUNC Quit] key to close the menu.

Inmarsat station type (ship or shore

The default station type is maritime; do not change the setting.

1. Press [FUNC Quit], [5] and [8] to show the DMG menu.
2. Press the [2] key to select Maritime.

58 DMG
Mari ti me:

2 No

Enter: [ Ent]

DMG menu, station type entry
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3. Press the [1] key to select Yes for ship station, or press the [2] key to select No
for shore station.

4. Press the [Ent] key followed by the [FUNC Quit] key.

Nature of distress

Select nature of distress. The default nature of distress is Undesignated.

1. Press [FUNC Quit], [5] and [8] to show the DMG menu.
2. Press the [3] key to select Nature.

58 DMG 58 DMG 58 DMG

Nature: 8 v Nature: 8 AV Nature: 8 AV
2 Flooding — (6 Sinking ——

3 Collision 7 Disabl e&Adr

4 Grounding 8 Undesignate

Enter:[Ent] ~+— |Enter:[Ent] ~<+—— |Enter:[Ent]

2-12

DMG menu, nature of distress options

3. Press appropriate numeric key to select nature of distress (default: 8
Undesignated). You can toggle between the three nature of distress screens
with the [=] and [¥] keys.

Note: The nature of distress is automatically restored to “Undesignated” after
one hour.

4. Press the [Ent] key followed by the [FUNC Quit] key.

Course

Do this step when there is no course data due to position-fixing equipment failure.

1. Press [FUNC Quit], [5] and [8] to show the DMG menu.
2. Press the [4] key to select Course.

58 DMG

Course:
(0

oo
00-3

59)

Enter: [ Ent]

DMG menu, course input screen

3. Enter course with the numeric keys.
4. Press the [Ent] key.
5. Press the [FUNC Quit] key to close the menu.
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2. SETTING UP
Speed
Do this step if it is necessary to enter speed manually because of GPS navigator
failure.

1. Press [FUNC Quit], [5] and [8] to show the DMG menu.
2. Press the [5] key to select Speed. (The speed 99 knots is shown when no
navigator is connected.)

58 DMG

Speed: El9
(00-99)

Enter: [ Ent]

DMG menu, speed input screen

w

Enter speed with the numeric keys.

4. Press the [Ent] key. If invalid data is entered the message “Input Error. Invalid
data.” appears and three seconds later the main menu is shown.

5. Press the [FUNC Quit] key to close the menu.

Note: This procedure may also be done from the terminal unit. The keying
sequence is [F4], [6], [2], [Enter].

2-13
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2.7  Choosing Where (LES) to Transmit Own Ship’s
Distress Signal

Select the LES where your vessel will transmit the distress signal. This procedure
is done from the Administration mode. See page 2-10 for how to change to the
Administration mode.

1. Press [FUNC Quit], [5] and [7] to show the Distress LES menu.

57Di stress LES 57Di stress LES
O v OA

1 _AORE: 001 JEENCCIIES> Sat5: - - -

2 POR : 003 —» |6 Satb6: ---

3 | OR : 003 7 Sat7: ---

4 AORW: 001 (=) |8 sats8: ---

Sel ect: [ Ent] <+— |Select: [ Ent]

Distress LES menu

2. Press appropriate numeric key to select an ocean region. For example, select
AOR-E. Your display should look as below.

57Di stressLES

AORE: []12

Enter: [ Ent]

Distress LES input screen, AORE selected

3. Key in LES to use in three digits and press the [Ent] key.
4. Repeat steps 2 and 3 to enter distress LES for other regions.
5. Press the [FUNC Quit] key several times to close the menu.

Note: This procedure may also be done from the terminal unit. The keying
sequence is [F4], [6], [3], [Enter], [1], [Enter].

2-14
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2. SETTING UP

2.8  Setting Up the Handset, Communication Unit
2.8.1  Selecting ocean region to use

Ocean region is selected according to current position. In the default setting the

ocean region is automatically selected (position and heading data required) when

the system is powered. If you are in a region where coverage overlaps you can
select the satellite manually as shown below.

1. Press [FUNC Quit], [5] and [1] to display the Satellite menu.

51Satellit 51Satellit i
ate ! eA ate I eAV 51SateII|tev

— -

=~ 6 Saté6 2 POR

7 Sat7 3 1 0OR

+— |8 sats8 ~<+—— |4 AOR-W
Enter: [ Ent] Enter: [ Ent] Enter:[Ent]
Satellite menu (default order)

2. Press corresponding numeric key to select satellite to use. AUTO provides for
automatic selection of satellite. Sat 5-Sat 8 are not used. You can toggle
between satellite selection screens with the [=] and [¥] keys.

3. Press the [FUNC Quit] key several times to close the menu.

Note: This procedure may also be done from the terminal unit. The keying

sequence is [F4], [6], [1], [Enter], [1], [Enter].
2.8.2 Choosing navarea(s) from which to receive Inmarsat services

You may select Navarea(s) from which to automatically receive information, for
example, weather broadcasts.

1. Press [FUNC Quit], [5] and [5] to display the Area menu.

55Ar ea
]
1 WMORN * Not used
2 |1 MO~
3 | CAO*
4 NAVAREA
Select: [ Ent]
Area menu
2. Press [4] to select NAVAREA. (WMO, IMO and ICAO are not applicable to
Inmarsat.)
55Area
NAVAREA
No. 1: H-
No. 2:
Enter: [ Ent]

Area menu, NAVAREA selected
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3. Enter area number in two digits (enter leading zero in case of one-digit
navarea) with the numeric keys and press the [Ent] key. See the map below

for navarea number.

4. Press the [FUNC Quit] key several times to close the menu and return to the

standby display.

Note 1: This procedure may also be done from the terminal unit. The keying

Note 2: If invalid data is entered, the message “Input Error! Input data is invalid.”

2-16

sequence is [F4], [6], [3], [Enter], [2], [Enter].

appears and three seconds later the main menu appears.
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2.9 Manual Entry of Position

When position data from the GPS navigator is not being received correctly, enter
latitude and longitude position manually from the handset in order to acquire and
track a satellite manually. When there is no position input, the status indication for
NAV DATA on the terminal unit changes from NMEA to NONE and the NAV
indication on the handset flashes.

1. Press [FUNC Quit], [5], [4] to show the Position input screen.
54Position

LAT: [@O0.00 N
LON: 000. 00 E

N/ S: [ Mode]
Enter: [ Ent

]

Position input screen

Note: If position data is correctly input from a navigator current position and
the message “NMEA valid” are shown on the position input screen. In
this case entry of position is not necessary.

2. The cursor is selecting LAT. Enter latitude with the numeric keys. Use the
[Mode] key to switch coordinate from North to South and vice versa if
necessary.

Press [x*] to select LON. Enter longitude similar to how you entered latitude.
Press the [Ent] key to conclude input.

5. Press the [FUNC Quit] to close the menu and return to the standby display.

s W

Note: If invalid data is entered, the message “Input Error! Input data is invalid.”
appears and three seconds later the main menu appears.

2-17


http://www.reelschematic.com

www reelschematic.com

2.10

2-18

Manual Entry of Heading

When heading data from the heading sensor is not being received correctly, enter
heading manually from the handset in order to acquire and track a satellite
manually. The system indicates no or wrong heading data by displaying “GYRO
DATA NONE” on the terminal unit and flashing “GYRQO” on the handset.

Further, to match the FELCOM 82’s heading display with heading sensor readout
input heading manually as below.

1. Press [FUNC Quit], [5] and [2] to display the Gyro input screen.

Enter: [ Ent]

Gyro input screen

2. Press [¥].

3. Press [({] to select ON. (This enables manual input of heading.)

4. Press [R].

5. Key in current heading with the numeric keys.

6. Press [¥].

7. When the gyrocompass readout becomes the same as the heading entered at
step 5, select the HOLD field and press [))] to select OFF. (This lets the
gyrocompass follow the heading set at step 5.)

8. Press the [Ent] key.

9. Press the [FUNC Quit] key several times to close the menu.
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2. SETTING UP

Setting Date, Time

This section shows you how to input date and time and choose time format and
time zone.

Note 1: This procedure is done from the Administration mode. See page 2-10 for
how to choose the Administration mode.

Note 2: Input of date and time are not necessary when the system is interfaced
with a GPS navigator and it is functioning.

Date and time

1. Press [FUNC Quit], [6] and [4] to show the Date&Time menu.
64Dat e&Ti me

1 Date&Ti me

2 Date Form
3 Time Zone

Sel ect :

[ Ent]

Date&time menu

2. Press the [1] key to select “1 Date&Time.”
64Dat e&Ti me

Dat e:
20[@0-03-01
Ti me
00: 00(UTC)
Enter: [ Ent]

Date&time input screen

w

Enter year in four digits, and date, month and day in two digits each including
leading zero where necessary. Use the [({] or [)] key to select location.

Press [¥].

Key in UTC time and press the [Ent] key.

. Press the [FUNC Quit] key several times to close the menu.

SROIES

If you enter invalid data the message “Input Error! Input data is invalid.” Is
displayed and three seconds later the main menu appears.
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Date form

1. Press [FUNC Quit], [6], [4] and [2] to show the Date Form menu.

64Dat e&Ti me
Date For m:
1 YYYY- MM- DD

2 MMM- DD- YYYY
3 DD- MMM- YYYY
(FEB-29-2000)
Enter: [ Ent]

Date form menu
2. Press appropriate numeric key to choose date format desired and press the
[Ent] key.
3. Press the [FUNC Quit] key several times to close the menu.

Time zone

The Inmarsat system uses UTC time. If you would rather use local time, enter the
time difference between it and UTC as shown below.

1. Press [FUNC Quit], [6], [4] and [3] to show the Time Zone input screen.
64Dat e&Ti me

Ti me Zone:
EY: 00

Zone Name: UTC
Dn:[ L] Up:[ 1]
Enter: [ Ent]

Time zone input screen

2. Use the [=] or [¥*] key to enter time difference between your time and UTC
time. Each press increments (decrements) the hour digit by one hour. The
setting range is —13 to +13.

3. Select minute position with [?] and enter minutes with the [=] or [~] key. Each
press increments (decrements) the minute indication by 15 minutes.

4. Press the [)] key to select Zone Name.

5. Enter the name of the time zone in three letters with the alphabet keys and
press the [Ent] key. For example, if you want to use Japan Standard Time,
enter JST. For how to enter alphabet see page 4-2. If an invalid zone is
entered the message “Input Error! Input Time zone is invalid.” is displayed
and three seconds later the main menu appears.

6. Press the [FUNC Quit] key several times to close the menu.
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2.12 Terminal Unit Setup (Class 1 only)

The terminal unit is set up on the Terminal Setup menu. Press [F4] followed by [3]
to display this menu. Default settings are as shown in the figure below.

[1] key Dat e
u (MW DD- YY) == Epter month, day
(Date Entry)  and year.
[2] key Ti me
[} (HH MW t--= Enter hour and
- minute in that
(Time Entry) order.
Terminal Setup 3] k rDate Di splay Form
. : ey | 1:YY-Mv DD > :
1: Date . 00-08-31 2+ MV DD- VY fSOer::g’; (tj;tl:esgsplay
2. Tine : 16:45 ——— | 3. DD- MW YY :
3: Date Display Form : YY-M\DD ﬁk — Screen Saver —
€y | 1: Mode ON-------o-- > ON turns off the LCD
4: Screen Saver : ON . .
2: Mode OFF when there is no key
5. Comm Time Display : ON input for 10 minutes.
6: Incoming Call Alarm: ON Press any kgy to turn on
) the LCD again.
7. Special Char . Default [5] key '
8: Answerback Code . Regi st er ed— —— Comm Ti me ——
............................................. ; g zp: Zy g:\'F ™ Turn telex communication
To change: ENTER To quit: ESC i o time display on/off.
[6] key_l ncom ng Cal | —
1: Alarm ON - ...~ Turn receive
2 Alarm OFF message alarm
on or off.
. —Speci al Char —
Special Characters [7] key| 1: Default
2: Norway --= Press appropriate
Default .
prau HENA 3. Sweden numeric key to select
Norway | |A |O 4: WK character set. Spare 1
denla 1A e e ©1 and Spare 2 are
Sweden O G 2 reserved for future use.
UK @|% | £
[8] key

—— = Displays answerback code. To escape,
press the [Esc] key.

Terminal setup menu
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2.13 Editor Setup (Class 1 only)

The "editor screen” is where you will create and edit files, and you may format it
as desired on the Editor Setup menu. Press [F4] followed by [4] to show this
menu. Default settings are as shown in the figure below.

2-22

—— Text Mbdde
[1] key 10 TELEX woooeooennn. --> Upper case letters
2: ASCl ---------- only.
‘> Both upper and lower
case letters.
(Cannot edit Telex
message at "ASCIIL.")
—— Edit Mbde
[2] key 1: Insert === --> Inserts character at
Editor Setup 2: Overwite..... cursor location.
1: Text Mode TELEX —— > Writes over character
o Edit Mbd | . at cursor location.
. 1 e nser [3] key — \Wrd Wap
3: Word Wap N £ N } Turns on/off automatic
2: OFF .
4: Line No. OFF hyphenation at end of
5: Tab Wdth 4 char 'Y
7: Cursor Type Bl ock [4] key 1: ON Turns line numbering
2: OFF on/off.
8: Scroll Hal f Screen—
To change: ENTER To quit: ESC
Tab W dt h—
[5] key | 1: 2 char Sets quantity of
2: 4 char character spaces
3: 8 char between horizontal
tabs.
[6] key [— Colum Wdth (Column width is fixed
69/1ine (TELEX) | in Telex at 69
characters/line.)
— Cursor Type—
[7]1 key | 1. B ock Selects cursor
2: Underline configuration.
(o |
2:
Scrol | Sets how much the
[8] key 1: Eull Screen screen moves up over
1 2: Half Screen } the page, when PAGE
UP or PAGE DOWN
keys are operated.
Editor setup menu
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2.14 Terminal Unit Display Color

You may change the background and foreground colors for the various display
screens on the terminal unit as follows:

1. Press [F4] and [7] to display the Window Color Change menu.

W ndow Col or Change

1: Wndow Col or Set up
2. Default Col or

To change: ENTER To quit: ESC

Window color change menu

2. Press the [1] key to select 1 Window Color Setup.

W ndow Col or Set up

[ Base Wndow ]
Fore Color [ L-VH TE ]
Back Color [ BLUE ]

To change: ENTER To Change Value: L< = >R

Window color setup menu

3. Press[-]to select item to adjust.

BASE WINDOW: Standby display

TLX BACK SCROL: Communications memory display
TELEX: Communications display

EDIT1 — EDIT 2: Editor screens

FUNCTION: Function keys bar

SUB MENU1-SUB MENU 4: Sub menus

MESSAGE: Status message
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EDIT

TLX BACK-SCROL

BASE WINDOW

Fil el Edit iTelex WSetup VRUNFRISHBELL M JIA st JIBreak

1: < [1] UNTI TLED1 > |
2: ————— Di spl ay Conm Menory

MENU

[ Tel ex Online]
<«——TELEX

St at us Message

< MESSAGE

Press [1] to select Fore Color.

Press [ -] to select foreground color desired.

Press [1] to select Back Color.

Press [ -] to select background color desired.
Press the [Enter] key to register your selection.
Press the [Esc] key to return to the standby display.

© 0N OB

To restore all default color settings, press [2] at step 2 in the above procedure to
select “Default Color” and then press the [Enter] key.

Note: The same color cannot be selected for both background and foreground.
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3.1
3.1.1

TELEX COMMUNICATIONS
(Class 1 only)

Before Beginning Communications

Overview
Telex communications methods

A telex message may be sent three ways:

« Auto telex (page 3-11)
« Manual telex (page 3-14)
« Programmed telex (page 3-18)

Before you can transmit a telex message automatically or by timer program you
must first register the LES codes and telex numbers of stations you wish to call.

This is also recommended for greater convenience on manual transmission.

Further, you will need to prepare text messages.

Telex messages

Telex messages which you create may be stored on floppy disks. To send a telex
message retrieve it from a floppy disk and then transmit it. For how to create a

telex message see page 3-4.
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3.1.2 Registering, deleting LES
Registering LES

246 LESs can be registered.

1. Atthe standby display, press [F4] and [2] to display the LES List.

LES Li st
No. : LES Code : LES Nane

To print: CTRL+P To edit: ENTER To quit: ESC
7 A 1

/ /

The display shown on the Return to normal display.
next page appears.

To print LES List.

LES list

2. Operate the arrow keys to select desired number from the LES List and press
the [Enter] key. The LES List Edit display appears.

LES List Edit (No. 001)

1: LES Access Code : [ |

2: LES Nane

3: Renarks

To del ete this LES: BS To quit: ESC

LES list edit display

3. Enter LES in three digits, referring to the LES list Appendix C. For example,
enter 003 for the Yamaguchi, Japan LES. (To change LES code already
entered, press the [Backspace] key successively, then enter LES code.)

4. Press the [1] key to select LES Name.

5. Enter LES name (maximum 15 characters). For example, type YAMAGUCHI.

6. If desired, press the [1] key to select Remarks and enter remarks (max. 25
characters).

7. Press the [Esc] key to return to the LES List display.

8. Press the [Esc] or [Enter] key to register and quit.

Deleting LESs

Delete LES name with [Backspace] key at step 3 in previous procedure and then
press the [Enter] key.
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3. TELEX COMMUNICATIONS

3.1.3 Registering, deleting stations
Registering stations

You may register 64 stations.

1. At the standby display, press [F4] and [1] to display the Station List.

Station List
No. : Station Nane

(o
N
/
\

To print: CTRL+P To edit: ENTER To quit: ESC

Station list

2. Operate the arrow keys to select empty station number and press the [Enter]
key. The Station List Edit display appears.

Station List Edit (No.O01)
1: Stn. Nane [ |
2: Telex No. :
3: Answer back :
4: Renmar ks

To delete this stn: BS To quit: ESC

Station list edit display

3. Enter station name. (To change station name already entered, press the
[Backspace] key successively, then enter station name.)
4. Press the [1] key to select Telex No.

5. Enter subscriber's telex number (max. 20 characters), referring to the
examples shown in the figure below.

Example: MES to Land
00 720 5644325

‘ _|_— Telex No.
Country No.
Automatic Call

Example: MES to MES
00 OO0 O------ a

Subscriber’s ID No.

Ocean Region —» 581: Atlantic Ocean-East
Automatic Call 582: Pacific Ocean

583: Indian Ocean

584 Atlantic Ocean-West

Sample telex subscriber numbers

6. Press the [1] key to select Answerback.
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7. Enter answerback code (max. 20 characters). If you don't know the complete
answerback code, enter a part of it or subscriber's telex number.

Note: The answerback code is used by the LES to verify identification in
automatic and programmed telex. When a receiving station is called it
sends the answerback code to the sending station and if it is different
from what is registered here the line is disconnected. Answerback code
is not applicable to manual telex. Further, if it is not entered messages
may be garbled depending on the operator to which you are
connected.

8. If desired, press the [1] key and enter remarks (max. 25 characters).
9. Press the [Esc] or [Enter] key to finish.
10. Press the [Esc] key several times to return to the standby display.

Deleting stations

Delete station name with the [Backspace] key at step 3 in above procedure, and
then press the [Enter] key.

3.1.4 Creating message files

There are two types of telex messages: routine and confidential. This section
shows how to create both, beginning with routine.

Creating routine message files

At the standby display, press [F1] and [1] to select New Text. The display
provides an untitled window for creating a message.

Cursor

< [1] UNTITLED1 >
Line Number

- 0001] ‘

S S

TELEX 1 Char. [Line 1/ 1 Col. 1] [lnsert ]
i i i i
| | | |
Telex input; No. of Cursor Possible to insert
capital letters characters position character at
input cursor position

Untitled window
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3. TELEX COMMUNICATIONS

Type your message, in capital letters. #, &, *, $, and % cannot be used. At the
end of the message type the characters NNNN (end of message code). To
receive notice of call duration from the LES and have communication line
disconnected automatically upon completion of the call, type five periods after
NNNN. This feature is available regardless of message priority.

< [1] UNTITLEDL >
TO FURUNO

ATTN: MARI NE DEP.

FM EUROCPEAN VENTURE
REF: TLX00-001 AUG. 10. 00
SUBJECT: TEST M5G

TYPE YOUR MESSAGE HERE.
RGDS/ MASTER
NNNN ... ..

Example telex message
Working memory

The FELCOM 82 has two working memories to which you can load a file.

Floppy Disk

Working Memory

----- >
—\_KO— Screen
_____ | |

(File)

Working memory

When you try to load a file into an occupied memory working memory, by
pressing [F1] and [1] (New Text), the display asks you if you want to save (to a
floppy disk) and clear the file currently loaded on the working memory before
clearing the display.

Cl ose Text

i ?
(S?;/Ieef Inlareré) YES -- This display asks you
NO if you want to save
current file before
clearing the display.

Close file prompt

T o save the file to a floppy disk, press the [Enter] key. To close the file without
saving it, press [!{] to select “No” and press the [Enter] key.
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Confidential messages

If communicating with a FELCOM 80/81/82, you can prepare a confidential
message by entering S???-addressee code (-password): in the first line of the
message text. You can also receive confidential messages containing this header
from a land subscriber or any other MES.

Confidential messages, unlike routine messages, are neither displayed nor
printed when received. You will learn how to open and print confidential

messages in a later section.

1. Press [F1] and [1] at the standby display to open the untitled window.
2. Prepare a confidential message referring to the figure below.

—— Be sure to enter colon.

S7?7??- addressee code: (text of message)

Maximum 8 characters J

To prepare: Type S, 3 question marks, hyphen, addressee code,
colon and text of message.

Confidential message with addressee code

— Be sure to enter colon.

S???- addressee code - password: (text of message)

Maximum 8 characters ‘—,

To prepare: Type S, 3 question marks, hyphen, addressee code,
hyphen, password, colon and text of message.

Confidential message with addressee code and password

How to prepare a confidential message

3-6


http://www.reelschematic.com

www reelschematic.com

3.1.5

3. TELEX COMMUNICATIONS

Saving message files

You can save message files to a floppy disk two ways:

* By “Save Text” (files remains on the display), or
* By “Close Text” (files is saved and display is cleared).

Formatting floppy disks

Before you can save a file to a floppy disk the disk must be formatted. Formatting
prepares the disk for use with the system.

1.
2.
3.

5.

6.

Insert blank floppy disk label side up in the disk drive on the terminal unit.
Press the [F1] key to show the File menu.
Press [9] to select Format Disk and press the [Enter] key.

Drive A
Sel ect Di sk Type 1. 44VB

720KB

Selecting disk type

Select disk type, 1.44 KB for 2HD or 720 KB for 2DD, and press the [Enter]
key.

You are asked if it is all right to format the disk. Select Yes and press the
[Enter] key.

Press the [Enter] key again to format the disk.

Saving message file, retaining file on screen

1.

2.

Press [F1] and [4] to select Save Text. The display should look something like
the figure shown below. (If name is already entered, press the [Backspace]
key successively to erase data.)

Save Text
Savi ng File Name

(file nane)

Save file prompt

Enter file name (max. eight characters plus three-character extension) and
press the [Enter] key.

(ex.) FURUNO-1.TXT

EMaximL;L Extension name (3 characters)

8 characters  may be entered.

Sample file name
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Saving message file, closing screen

1. Press [F1] and [3] to select Close Text. The display should look something
like the figure shown below.

Cl ose Text

Save file? YES
(file nane)

Close file prompt
2. Press the [Enter] key.

Save Text
Savi ng File Nane

(file nane)

Save file prompt

3. Enter file name and press the [Enter] key.The message is saved and the
screen is cleared.

3.1.6 Opening message files

To open a message file from a floppy disk, do the following:

1. At the standby display, press [F1] and [2] to select Open Text. The display
shows a list of files stored on the disk. (Note that the directory MESSAGE is
automatically created when the a file is saved to a floppy disk.)

Open Text

MEEl Merge (TAB: Change)
[ AX \ MESSAGE\ MARI NE. TXT

-File Name- - Si ze- -Date & Tine -
<Parent Directory> 00- 09- 18 15: 05
MARI NE. TXT 15 00- 09-18 15: 05

FURUNO TXT 20 00-09-10 11: 00

To sel ect: ENTER To view SP,/?\\CE To quit: ESC

Press space bar to view first part of file.

Open text display

2. Select a file by operating the arrow keys and press the [Enter] key. (To view a
portion of a file, tap the space bar.)

3. To open another file on a blank screen select it with the arrow keys and press
the [Enter] key. To tack the file onto a file currently opened, use the [Tab] key
to select Merge before pressing the [Enter] key. (The default option (Load)
opens the file on a blank screen.)

Load: Open file on a blank screen.
Merge: Tack file at cursor location in file currently displayed.

4. Press the [Enter] key.
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3.1.7

3. TELEX COMMUNICATIONS

Note: If both working memories are occupied, the following display appears.

Cl ose Text

Saye file? YES
(file name) NO

Save the file in one of the working memories by pressing the [Enter] key, or select
"NO" and press the [Enter] key to clear the display without saving the file.

Other File menu operations

Deleting files from floppy disks
You can delete unnecessary files from a floppy disk as follows:

1. Press [F1] and [5] to select Delete File.

2. Press the arrow keys to select file to delete. (If you want to view the first part
of the file, press the space bar.)

3. Press the [Enter] key. The display asks you if it is alright to delete the file.

Del ete File: FURUNO YES

Del ete OK? NO

Delete file prompt

4. Press the [Enter] key.

Changing file name

1. Press [F1] and [6] to select Rename File.
2. Press the arrow keys to select file then press the [Enter] key.

ad d nane: FURUNO TXT

TAB: Copy from ol d- nane
AN

Press Tab key to copy
previous name.

Display for entering new file name

3. Enter new file name and press the [Enter] key.

Printing file contents

1. At the standby display, press [F1] and [7] to show file list.
2. Select file and press the [Enter] key.
3. Press the [Enter] key again to print.
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Temporarily erasing displayed file (editor screen

You can show the standby display when the editor screen, communications
display and communications memory are active.

1. Press [Alt] + [Z]. Opened communications display, communications memory
are temporarily erased and the displays erased are shown at the bottom of

the screen.
Editor Screen —— Editor Wndow 1 : [ File name ]
No. Editor Wndow 2 : [ closed ]
Tel ex Online : Inactive Di spl ay Conm Menory : Active
Communications Display Communications Memory

Communications Display
File Name: File name shown on the display

closed: No file name shown on display

Communications Display, Communications Memory
Inactive: File name shown on the display
Active: File temporarily erased

Standby display, bottom of display

2. To restore editor screen, communications display, communications memory,
press [Alt] + [Z] again.
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3.2
3.2.1

3. TELEX COMMUNICATIONS

Automatic Telex

Automatic telex procedure overview

A telex message is automatically sent using pre-registered LES, station and
subscriber number. Answerback codes are automatically exchanged between
sender and receiver.

There are two ways to prepare a telex message for automatic transmission:

(1) Select message from floppy disk
(2) Prepare message on the editor screen

Case (1) Case (2)
Prepare message on Select message from
editor screen beforehand. floppy disk.

| |

Select subscriber from Station
List.

Select LES from LES List.

Select file from floppy disk.
(Case (1) only)

Select "SEND". You are automatically connected to
selected LES and message is transmitted to selected
subscriber. (Your ship’s answerback code is
automatically attached at the head of message.)

Automatic telex overview
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3.2.2 Detailed procedure
1. At the standby display (or "Editor" screen), press [F3] and [1] to display the

Auto Telex display.
Aut o Tel ex
(M St at i on Nane D
[ Telex No. : ] -
SEND
2: LES Access Code : ___ ( )
3: File to Send : CANCEL
You can also open the ——> To open tabl e: SPACE To quit: ESC<l- press [Esc]
Station Name list by to return to
pressing the space standby
bar. display.

Auto telex display

2. Press [1] or the space bar to display the Station List.
Station List

No. . Station Name

01 :  FURUNO

02 ;. MARI NE

n\"3

~— ~—

08

| To select: ENTER =~ To quit: ESC

Station list

3. Operate arrow keys to select station and press the [Enter] key.
4. Press [2] to display the LES List.

LES Li st
No. : LES Code : LES Nane

To sel ect: ENTER To quit: ESC

LES list

o

Operate arrow keys to select LES and press the [Enter] key.

If you want to send the message currently displayed on the editor screen go
to step 8. To send a file stored on a floppy disk, insert appropriate floppy disk
in the disk drive on the terminal unit and press [3] to display the file list.
Operate the arrow keys to select file and press the [Enter] key.

. Press the right arrow key to select "SEND".

o

© N

SEND [ . > To transmit
CANCEL }-------- > To escape
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9. Press the [Enter] key to transmit, or select CANCEL and press the [Enter] key
to cancel transmission.

You are automatically connected to the LES selected and your message is sent
to station selected. After the message is transmitted, the line with the LES is
automatically disconnected. If five periods are typed at the end of the message,
notice of call duration appears prior to disconnection of the line.

Note: If the answerback code registered in the station list is different from what
the receiving station sends to you communication is not possible. The line
is then automatically disconnected.

Disconnecting line with LES manually
Press [F10] (Break). Notice of call duration does not appear.

Returning to standby display

After the line with the LES is disconnected, press [Esc] key to return to the
standby display, or [F3] and [8] (or [Alt] + [W]) to return the editor screen.

If you wish to connect newly the line with an LES, wait 30 seconds after the line

has been disconnected, otherwise an error message appears, resulting in no
connection.

3-13
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3.3 Manual Telex

To transmit a telex message manually, the operator selects station, LES,
subscriber number, and manually transmits answerback code.

3.3.1 Manual telex procedure overview

Key in LES number.
(Communication line with LES is
established.)

Y

Key in subscriber’s Telex number.

Y

Transmit message.

Manual telex overview

3.3.2 Detailed procedure
1. At the standby display, press [F3] and [2] to display the Call LES display.

Call LES
1: [NSSENII IO} : 003( YAMAGUCH! )
2: Priority - Routine
3: Service Code L
________________________________________________________________ CANCEL
Press space bar to ——> To open table: SPACE To input table: ENTER To quit: ESC<«— pregs [ESC]
display list. 4|\ to return to
Press [Enter] to manually standby
enter LES code. display.

Call LES display

2. Select appropriate LES, automatically (a) or manually (b)
a)Key in LES number (if one is already entered used the [Backspace] key to
delete it) and press the [Enter] key, or
b) Press the space bar to display the LES List. Operate the arrow keys to select
LES and press the [Enter] key.
3. Press the [{] key to select Priority.
4. Press the space bar.
—— Priority——
1.

2. Safety
3. Urgent

Priority display
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5. Select communications priority by pressing appropriate numeric key among
1-3 (normally, press [1] for Routine) and press the [Enter] key.

Safety: Communicating important meteorological or navigation warning.
Urgent: Communicating safety of ship or safety of person.

6. If necessary, select service code, otherwise go to step 7. Set the cursor on
Service Code and press the space bar. Then, key in service code in two digits
and press the [Enter] key. Note that some services may not be available
depending on LES.

Service Code Function

00 Automatic call

11 International operator
12 Dialing guide

32 Medical advice

33 Technical assistance
38 Medical assistance

7. Press the [-] key to select SEND.

SEND [ S > To transmit
CANCEL |-------- > To escape

8. Press the [Enter] key. “GA+” (Go Ahead) should be displayed on your screen,
meaning you are now connected with LES selected.

LED ID: 222 (Perth)
Example < Priority: Routine - "SEND" - [Enter]

Service Code: None (none entered)

Date and TIme (UTC)

00-06-09 00:39 YMP 222 > June 9, 2000, 00:39

These are
automatically

displayed.

343164810 JFKS X > Your ship’s answerback code
GA+

Display

Sample manual telex message
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9. Atthe standby display, press [F3] and [3] to show the Call Station display.

Call Station

(No. @ . Station Name ]
01 FURUNO

Call station display
10. Operate the arrow keys to select station desired. Wait for "GA+" from LES.
11. After "GA+" is displayed, press the [Enter] key. Selected station's telex
number appears on the display as shown below. If the number is wrong,
press [F10] to disconnect the line.

Note: You must enter subscriber's telex number within 15 seconds after
"GA+" is displayed. Otherwise, the line with the LES is disconnected.

00: Automatic Connection
720: Country Code (Japan)
Example | 5644325: Subscriber No.

+: End Code
Telex No. GA+
\> 007205644325+ 1> Date (9th), Time (Local time),
These are = --------!|  Communication No.
automatically 090940=300534 )
5644325FURUNO J ------------ > Other station’s answerback code
""""""""""""""""""" > 343164810JFKS X  ---------}> Your ship’s answerback code
Press _— |
[F6] (HRIS) key.

Charges are calculated
from this point.

Sample manual telex message

12. After other station's answerback code appears on your display, press the [F6]
(HRIS) key to send your ship's answerback code. (Charge calculation begins
from when you send answerback code.) Prepare and transmit message right
away as on the next page.
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13. You may prepare a telex message two ways: Type message from keyboard
or retrieve a file from floppy disk.

To retrieve file from floppy disk;
a) Insert floppy disk in drive. At the standby display, press [F3] and [4] to

display the Transmit File display.

-Fil e Nane-
SAITO- 1

Transmt File
-Si ze-
<Dl R>

-Date
00- 09-

& Tinme -
18 15: 05

Transmit file display

b) Operate the arrow keep to select file. (To display the first part of the file,

press the space bar.)

14.Press the [Enter] key to transmit the file. (Transmit messages appear at the

bottom of the display.)

Note 1: The line can be manually disconnected with [F10].
Note 2: The line can be automatically disconnected by typing five periods at the

end of the message.

Returning to standby display

After the line with the LES is disconnected, press [F3] and [8] (or Alt + W) to

return to the standby display.

If you wish to connect newly the line with an LES, wait for 30 seconds after the
line has been disconnected, otherwise an error message appears, resulting in no

connection.
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3.4

3.4.1

3-18

Programmed Telex
The FELCOM 82 can be programmed to automatically send a telex message at a

specific time or at regular intervals. Eight such programs can be programmed.

You don't need to worry if the communication line is busy when the programmed
time arrives: The FELCOM 82 waits for the line to become free and then
automatically sends the message two minutes afterward.

Programmed telex overview

Select subscriber from station list.

l

Select LES from LES list.

l

Insert floppy disk containing file to
send in disk drive.

l

Select the program mode.

l

Register program.

l

When Status is "ON," the program mode
becomes active and file is sent.

Programmed telex overview
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3.4.2 Programming

1. Press [F3] and [5] to display the Program Telex display. If there are no
programs entered, the display looks like the one shown below.

Program Tel ex

No. LES -Destination- -Filenane- -Mode- Status

01<<<No data >>>
02<<<No data >>>

08<<<No data >>>

To change status: ENTER To edit: SPACE To quit: ESC

=z Z. A
Press [Enter] key to 438;)3% bar to P/ress [Esc] key to

enable or disable edit program selected. quit.
program selected.

Program telex display
2. Select unused number and press the space bar to enter program data.

Edit (No.1)

ISt at i on Nane :
[ Tel ex No. : ]

2: LES Access Code: —— ENTRY

3:File to Send : POSITION. RPT [defaul t] [DELETE

4: Progr am Mode : [ ]

Edit display for program telex

w

Press [1] (or tap the space bar) to display the Station List.

4. Operate the arrow keys to select station desired and then press the [Enter]
key. The Edit display appears.

Press [2] to show the LES list.

Operate the arrow keys to select LES desired and then press the [Enter] key.
7. Set appropriate floppy disk into the disk drive on the terminal unit. At the Edit
display, press [3] to display the file list.

Note: If file is not specified, the file "POSITION.RPT" (ship's position) is
automatically selected and sent when the time specified arrives.

o o

LAT 32:08:35N
LON 140:56:87E

Sample position report file
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8. Operate the arrow keys to select file desired and then press the [Enter] key.
9. Press [4] to select Program Mode. Select desired mode, enter transmission
start and stop times (or transmission interval) and then press the [Enter] and

[Esc] keys.
[11 —— Start Tine —
\ =
Vbde — S (w

1:ONE Ti MB --ovmmemmmoefomemneneesd (Enter transmission start time,
2:-Interval ---------- your local time.)
3: Schedule ---------- :

0 [21 —— Interval —

e > @o:0o0

Enter transmission interval, from

10 min. to 99 hr. 59 min. When

the "Status" indication in the
Program Telex display (shown

on the next page) is turned on the
message is transmitted immediately.
It will then be retransmitted at the
time interval entered here.

[3] < Schedul e
N g 1B
2. & L _ 8
— — — —
4— - — —
You can enter four
transmission start times.
The interval between start
times must be at least 10
minutes.
Mode menu
10. Press the [—] key to select "ENTRY".
SN |---------------> Select to register program.
DELETE}---------------> Select to delete program.
(See next page.)
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3.4.3

3. TELEX COMMUNICATIONS

11. Press the [Enter] key to register program. The display shows the particulars

of the program registered.

Program Tel ex

. LES - Destination - - Filenane - -

Subscriber’s name.
LES ID (access code)

OFF means program is disabled.
The [Enter] key toggles ON and OFF.

Sample program telex list

12. To enable a program, press the [Enter] key. “ON” appears in the Status

column. Transmission starts at the interval selected at step 9.

13.To return to the standby display, press the [Esc] key twice.

Deleting programs

1.
2.

3.

»

At the standby display, press [F3] and [5] to select Program Telex.
Operate the arrow keys to select program to erase and then tap the space
bar.

Press the [- ] key and then press the [{] key to select DELETE.

Press the [Enter] key to delete the program.

Press the [Esc] key to return to the standby display.
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3.5
35.1

3-22

Receiving
Receiving routine messages

When you receive a routine telex message the audible alarm sounds. (The alarm
does not sound when it is disabled at Incoming Call Alarm on the Terminal Setup
menu ([F4], [3] and [6])). The message fills the "Telex Online" display shown
below and is printed. You can silence the alarm by pressing [F9].

Tel ex Online

Telex online display

Retrieving routine messages

All received routine messages are stored in the communications memory (16K
byte capacity). To retrieve a message from the communications memory, do the
following:

1. Press the [B] key while pressing and holding down the [Alt] key.
2. You can scroll the screen by pressing and holding down the [Fn] key while
pressing [T] or [{].

Note: When the terminal unit is turned off all contents of the communications
memory (transmitted and received routine messages) are cleared.
Therefore, you may wish to save or print out important messages. For how
to print the communications memory see paragraph 3.8.5 on page 3-33.
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3.5.2 Receiving confidential messages

When you receive a confidential message the audible alarm sounds and the
display shows the message "Confidential message received". (The alarm does
not sound when it is disabled at Incoming Call Alarm on the Terminal Setup menu
([F4], [3] and [6])). To silence the alarm, press [F9].

Confidential messages are neither displayed nor printed, however they are stored
in the confidential message memory (capacity: 16K bytes). When this memory
becomes full, the oldest confidential message is deleted to make room for the
latest.

Retrieving confidential messages
1. Atthe standby display, press [F3] and [6] to select Confidential Msg.

Confidential Message

No. Addressee- -Prty- -RX Ti me- - Durati on- -Si ze
1 FURUNO Rou 00-09-19 17:30 00:03'00 235
> 2% SAI TO Rou 00-04-10 15:25 00:02'17 149

Asterisk marks files -

. <<< End of Message >>>
with passwords.

To print:CTRL+P To view ENTER To del ete:DEL To quit:ESC

1 /\ A\
Press [Ctrl] + [P] to print ~ Press [Enter] to view part Press [Delete] to delete
selected file. of selected file. selected file.

Confidential message list

2. Operate the arrow keys to select the message you want to retrieve.
(Messages with a password are marked with an asterisk. Enter password.
Password is not displayed during or after its entry.)

password: 1

Password input screen

3. Press the [Enter] key to retrieve the message.
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Printing confidential messages

1. Press [F3] and [6].

2. Operate the arrow keys to select file.

3. Press [Ctr]] + [P]. If the message contains a password enter it before pressing
those keys.

Deleting confidential messages

1. Press [F3] and [6].

2. Operate the arrow keys to select message to delete. Press the [Delete] key.
(If the message contains a password, enter it before pressing the [Delete]
key.)

3. Select YES and then press the [Enter] key.
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3.6

3.6.1

Polling

Polling means one station (the polling station) interrogating another or others (the
polled station or group of stations) for the purpose of receiving a message. The
polling station may be a ship station (MES) or a shore subscriber, while the polled
station is always an MES.

When a polled MES finds the polling command in the received message, it
requests the station sending the polling command to transmit its ID number. In
this way, the authenticity of the polling station is confirmed. The polled MES then
responds automatically in a predetermined manner, either with a data reporting
message or by initiating a ship-to-shore or ship-to-ship message transfer.

Polling procedure overview

A land or MES station transmits
polling command to your vessel.
(/POLL :'_"R/)

File No.

Your vessel automatically
requests the station to transmit
its personal ID number.

The station transmits its personal
ID. Your FELCOM 82 confirms
that it has this personal ID
registered.

|

If personal ID numbers match,
your FELCOM 82 automatically
transmits requested file to
polling station.

Polling overview
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3.6.2 Polling setup

Entering personal ID number

A personal ID number is used to confirm identity in polling and consists of up to
eight digits. Eight sets of IDs may be entered, corresponding to eight different
stations. The ID number can be any combination of alphanumerics characters
and should be agreed on by both the polled and polling station beforehand.

1. At the standby display, press [F4] and [5] to display the Polling Configuration

display.
Pol i ng Configuration
Pol 1 i ng Response
1: POSI TION. RPT (Position Report)
2: . User defined A
3: . User defined B
4: : User defined C
5: . User defined D
6: Personal ID Entry
1*«<2 3 4 5 6 7 8
To open tabl e:% To quit: ESC
\
Press space bar to Asterisk appears  Press [Esc] to quit
display file list. when ID is this display.

registered.

Polling configuration display

2. Press [6] to select Personal ID Entry.
Personal ID
Lwll™
2:

8:

Personal ID window

3. Use the arrow keys to select appropriate number.
4. Enter personal ID number (maximum eight characters) followed by the [Enter]
key.
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3.6.3
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Selecting a polling response file

1. Atthe standby display, press [F4] and [5] to display the Polling Configuration
display.

2. Press one of the keys 2 to 5 to select polling response file number. (You can
also select it by operating the arrow keys followed by the space bar.)

3. Operate the arrow keys to select file from a floppy disk. (To display the first
part of the file, tap the space bar.)

4. Press the [Enter] key.

5. Press the [Esc] key to return to the standby display.

File number 1 is reserved for position information. When a subscriber requests
this information, your position, input by navaid, is sent to the subscriber.

Note: To delete a polling response file, select it and press the [Delete] key.

Transmitting the polling command

Your ship transmits the polling command to retrieve a file from other station
(MES).

Automatic transmission

1. Input polling command and save it to a floppy disk.
a) Press [F1] and [1].
b) Type the polling command: /POLL [a file no. 1-5]/ at the beginning of the file.
and save file to a floppy disk.
c) Save file to floppy disk.

Manual transmission

1. Connect with subscriber.

2. Type /POLL, file number (1-5) and /. Called station requests your personal ID.

3. Input your personal ID so the other station can transmit information
requested.
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3.7

3.7.1

3.7.2

3.7.3

3-28

Distress Communications

Transmit the distress alert only in a life endangering situation. If the navigator is
not outputtting data, enter position and heading manually as shown on page 2-17
and page 2-18.

Transmitting the distress alert

1. Open the distress button cover on the 1B-352.
2. Press and hold down the [DISTRESS] button six seconds.

Distress communications

You are automatically connected to an LES. If you are not pressed for time, you
may send a telex message to the LES by direct keyboard input.

Distress alert transmission when you are not pressed for time

If you are not pressed for time you may specify the nature of distress from the
handset as follows, before transmitting the distress alert.

1. Press [FUNC Quit], [5], [8] and [3].
2. Press [3] to select Nature of Distress.
3. Hit numeric key corresponding to nature of distress.

1: Fire, Explosion 6: Sinking

2: Flooding 7: Disabled & Adrift
3: Collision 8: Undesignated

4: Grounding 9: Abandoning

5: Listing

4. Press the [DISTRESS] button six seconds to transmit the distress alert.
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3.8 Editing, Printing Text

This section discusses how to edit and print text.

3.8.1 Displaying the Edit menu
The Edit menu, displayed by pressing [F2], is where you begin all text editing

operations.

1: Undo ALT+X
20 cut DEL |
3. Copy ALT+C
4. Paste I NS
5. Select All  ALT+A |
'6: Search  ALT+F |
7: Repl ace ALT+R
'8 Goto Top | HOVE |
9: CGoto Bottom END

A: Goto Line ALT+L
'B: Change Text  ALT+V |

Edit menu

3.8.2 Cutting, pasting text

Cutting text

1. Place the cursor on the first character of the text to be cut.

2. Highlight the text to be cut by pressing and holding the [Shift] key while
pressing the [ -] key (or [t] key). If you highlight text which you do not want to
cut, press the [ ] key to adjust the highlight.

Untitled 2

CONGRATULATI ONS ON YOUR CHO CE OF FELCOM 82 | NMARSAT

B MOBI LE EARTH STATI ON.
VE ARE CONFI DENT THAT YOU W LL ENJOY MANY YEARS OF

OPERATION WTH THI'S FI NE PI ECE OF EQUI PMENT.

.

Message with text highlighted

3. Press [F2] and [2]. The highlighted text is cut and the remaining text is
reformatted.

If a mistake is made, you can restore the text by immediately selecting Undo from
the Edit menu.

3-29


http://www.reelschematic.com

Www reelischematic.com

3.8.3

3.8.4

3-30

Pasting text

To paste the cut text to a new location:

1. Place the cursor at the exact spot in the message where the cut text is to start.
2. Press [F2] and [4] (or the [Ins] key).

Copying and pasting text

You may copy a portion of text and paste it elsewhere as follows:

1. Select the text to copy.

2. Press [F2] and [3] (or [Alt] and [C]). The text selected is copied in the paste
buffer memory. Control is returned to the standby screen.

3. Place the cursor at the exact spot in the message where the copied text is to
start.

4. Press [F2] and [4] (or the [Ins] key).

Other edit features
Undoing text

Use the Undo feature to return the file to its most recent state. For example, you
have cut text but want to restore it. Then, you would select Undo in the Edit menu
to restore the text to its most recent location. (Note that [Alt] + [X] are shortcut
keys for the Undo function.)

Selecting all text

The Select All feature lets you select an entire file. This feature can be useful
when you want to combine files. The procedure below explains how to tack the
file loaded in working memory 1 onto the end of the file loaded in working
memory 2.

1. Load floppy disk which contains file to copy. Suppose it is loaded in working
memory 1.

Press [F2] and [5] (or [Alt] + [A]). The entire file appears in inverse video.
Press [F2] and [3] (or [Alt] + [C]). The file is placed in the paste buffer memory.
Load another file in working memory 2.

Place the cursor at the exact spot in the message where the text now in the
paste buffer memory is to start and press the [F2] and [4].

ok own
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Paste

Working @ Buffer Holds cut or
Memory 1 | Transfer Memory copied text
@|Retrieve (copy)
Floppy file.
Disk
®| Retrieve
file.
Working
Memory 2
@ Paste (Combine)

Sequence for combining files

Searching text

The Search feature lets you search for text in a forward or backward direction.

1. Display text and press [F2] and [6] (or [Alt] + [F]) to show the Search window.

Sear ch

Di r
Search string : [
----------------------------------------- Backwar d
ESC. Quit

Search window

2. Type the word you want to find. Select Forward or Backward to search the file
in a forward or backward direction respectively from the cursor position. Press
the [Enter] key to begin the search.

When the word is found, the cursor stops at the first character of the word. Press
the [Enter] key to continue the search.

Replacing text

The Replace feature helps you replace every occurrence of a word or phrase with
another word or phrase in a file.

1. Press [F2] and [7] (or [Alt] + [R]) to show the Replace window.

Repl ace

Mode
Search string:
o |7QJery

Repl ace with :
------------------------------- Backward

Replace window

N

Type the word you want to replace on the "Search string” line.

Press the [1] key to select "Replace with." Type the new word.

4. Select Forward or Backward to search the file in a forward or backward
direction respectively from the cursor position.

w
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5. Select whether you want to be queried or not each time the word is found.

Query: Stop at each occurrence of word to answer yes or no to replacement.
All: Replace every occurrence of word without stopping to confirm.

6. Press the [Enter] key to start the replacement.

Going to a specific line of text

This feature places the cursor at the head of a line desired. Press [F2] and [A] (or
[Alt] + [L]) to select Goto Line.

Got o Line
Junp to Line No. : I

Goto line window

Key in line number and press the [Enter] key. The cursor shifts to the head of the
line selected.

Going to top of text

Press [F2] and [8] to go to the top of a text message. Note that this can also be
done with the [Home] key.

Going to bottom of text

Press [F2] and [9] to go to the bottom of a text message. Note that this can also
be done with the [End] key.

Switching between two text windows

Press [F2] and [B] (or Alt + V) to switch between text windows.
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3.8.5

Printing messages

Message printing procedure overview

After message is received or
transmitted, change display from
"Telex" screen to "Communications
memory" screen.

Set range to copy and select "Copy"
function in Edit menu.

Return to standby display.

In File menu, open new file with
"New Text."

In Edit menu, select "Paste" function.

Save message to floppy disk.

Execute "Print File" function.

Message printing procedure overview

3. TELEX COMMUNICATIONS

All transmitted and received routine messages are stored in the communications
memory (capacity 16K bytes). Note that the contents of the communications
memory are cleared when the terminal unit is turned off.
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Detailed message printing procedure

1. After a message is received (or transmitted), press [B] while pressing and
holding down [Alt] to change the display from "Telex" screen to
"Communications memory" screen.

2. Place the cursor on the first character of the text to copy and highlight the text
to copy by pressing and holding down [Shift] while pressing [-] (or [{]).

THE QUI CK BROMWN FOX JUMPS OVER THE LAZY DOG 1234567890
THE QUI CK BROMWN FOX JUVPS OVER THE LAZY DOG 1234567890
iz =gOV e § BROMN FOX JUMPS OVER THE LAZY DOG 1234567890

File in communications memory

w

Press [F2] and [3] (Copy). ("Cut" function not available.)

4. Return to standby display by pressing [B] while pressing and holding down
[Alt].

5. Press [F1] and [1] (New). The untitled window display appears.

6. Press [F2] and [4] (Paste). The copy text selected in step 3 is pasted in the
untitled window.

7. Press [F1] and [4] (Save Text).

To save, enter file name and press [Enter].

9. Press [F1] and [7] (Print File). The display shows a list of files stored on the
disk.

10. Select file to print with the arrow keys and press [Enter]. To stop printing,

press [Esc].

®
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3.9

Main Menu Description

This paragraph provides descriptions for each menu.

[F1] File menu

The File menu is where you will create, name and save messages (to floppy disk).
You can also print messages from this menu.

o ~NOo o1~ WDN PP

1: New Text ALT+N
2: Open Text ALT+O
3: Cose Text ALT+Q
4: Save Text ALT+S
5. Delete File  ALT+D
6: Rename File
7: Print File ALT+P
'8: Gear ConmMemory
'o: Format Disk
File menu
- New Text: Opens new file in a working area.
: Open Text: Opens file from a floppy disk.
: Close Text: Removes file from a working area.
: Save Text: Saves file to a floppy disk.
: Delete File: Deletes file from floppy disk.
: Rename File: Changes file name.
: Print File: Prints file in a floppy disk.

: Clear Comm Memory: Clears all transmitted and received routine messages

from communications memory.

: Format Disk: Formats disk for use in system.
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[F2] Edit menu

The Edit menu provides text editing facilities, and it may be used when a text
window is open.

W > O© 0N O O

5w NP

:Undo:

Cut:

: Copy:
. Paste:

. Select All:

. Search:

: Replace:

: Goto Top:

. Goto Bottom:
: Goto Line:

: Change Text:

1: Undo ALT+X
20 cut DEL |
3. Copy ALT+C
4. Paste I NS
5 Select AIl  ALT#A |
'6: Search  ALT+F |
7: Repl ace ALT+R
'8 Goto Top | HOVE |
9: Goto Bottom END

A: Goto Line ALT+L
'B: Change Text  ALT+V |

Edit menu

Cancels the last change (cut, copy or paste).
Removes the selected text and stores it in the paste buffer.
Copies the selected text and stores it in the paste buffer.

Inserts the text stored in the paste buffer at the current
location of the cursor.

Selects the entire current file for cut and copy.

Searches a specified word.

Replaces a word with a different word or character string.
Brings the cursor to the top line of the current file.

Brings the cursor to the last line of the current file.

Moves the cursor to the desired line in the current file.
Alternately displays two open files.
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[F3] Telex menu

3. TELEX COMMUNICATIONS

The Telex menu is where you begin all phases of telex communication.

w N

~N O 01 B~

: Auto Telex:
: Call LES:
: Call Station:

: Transmit File:

: Program Telex:

: Confidential Msg:

: Communication Log:

: Change Window:

1: Auto Tel ex ALT+T

2. call LGS |

3: Call Station

4. Transnit File

5. Program Telex |

'6: Confidential Msg |

7. Communication Log |

'8: Change Wndow  ALT+W |
Telex menu

Automatic telex transmission.
Manually connects communication line with LES.

Selects a station from the Station List or enters telex
number directly through keyboard.

Selects file to transmit.

Programmed telex.

Opens confidential messages.

Stores routine received messages, and destination, call
duration, date and time of all transmitted routine
messages. The log holds 25 messages. When the log
is full, the oldest message is deleted to make room for
the latest. You can also print messages from this menu.
Switches between editor screen and standby display.
For example, you are editing a message and a
message arrives. The display changes to the
communication display, however if you want to
continue editing the message while receiving, select
this menu item.
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[F4] Setup menu

The Setup menu is where you enter your initial settings, including often-used
stations and LES.

1: Station List
2: LES List

3: Term nal Setup
4: Editor Setup

7: W ndow Col or

Setup menu

1: Station List: Registers receiving station. 64 stations may be
registered.

2: LES List: Registers LES. 246 LESs may be registered.

3: Terminal Setup: Sets up the terminal unit.

4: Editor Setup: Formats editor screen.

5: Polling Configuration: Selects the file to transmit when the FELCOM 82 is
interrogated.

6: Comm Unit Setup: Sets up the communication unit with ocean region,
navarea, etc. These menu items are common to both
the communication unit and handset.

7: Window Color: Selects terminal unit display colors.

F5] WRU

Requests other station's answerback code (Who are You?). (The mark “.r” is

displayed and printed.)

[F6] HRIS

Transmits your ship's answerback code (Who are You?).

[F7] BELL

Sounds bell at receiving station.

[F8] (Not used)
[F9] Alm Rst

Silences audible alarm which sounds when a message is received.

[F10] Break

Disconnects the communication line manually.
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3. TELEX COMMUNICATIONS

3.10 Keyboard Shortcuts
3.10.1 [Alt] key

You can control many of the FELCOM 82's functions directly from the keyboard
with the [Alt] key as shown in the table below.

Shortcuts with the [Alt] key

Key Function

Alt + N Same as New Text in File menu.

Alt+ 0O Same as Open Text in File menu.

Alt+Q Same as Close Text in File menu.

Alt+S Same as Save Text in File menu.

Alt+D Same as Delete File in File menu.

Alt+P Same as Print File in File menu.

Alt + X Same as Undo in Edit menu.

Delete Same as Cut in Edit menu.

Alt+C Same as Copy in Edit menu.

Insert Same as Paste in Edit menu.

Alt + A Same as Select All in Edit menu.

Alt + F Same as Search in Edit menu.

Alt + R Same as Replace in Edit menu.

HOME Same as Goto Top in Edit menu.

END Same as Goto Bottom in Edit menu.

Alt + L Same as Goto Line in Edit menu.

Alt +V Same as Change Text in Edit menu.

Alt+B Shows communications memory display, where transmitted
and recevied messages are stored. Repeat to go to standby
display.

Alt+T Same as Auto Telex in Telex menu.

Alt + W Same as Change Window in Telex menu.

Alt+Z Escape from editor screen or telex screen to “system status
display.” Repeat to return to previous screen.
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3.10.2

3-40

[Ctrl] key

The [Ctrl] key provides the shortcut key operations shown in the table below.

Shortcuts with the [Ctrl] key

Key Function
Ctrl+ E Same as [1] key.
Ctrl + X Same as [!] key.
Ctrl+S Same as [ ] key.
Ctrl + D Same as [-] key.
Ctrl + A Moves cursor one character leftward.
Ctrl+ F Moves cursor one character rightward.
Ctrl+ G Same as [Delete] key.
Ctrl +H Same as [Backspace] key.
Ctrl + | Same as [Tab] key.
Ctrl + M Same as [Enter] key.
Ctrl+C Same as [Pg Dn] key.
Ctrl+ R Same as [Pg Up] key.
Ctrl+Z Scrolls screen one line downward.
Ctrl + W Scrolls screen one line upward.
Ctrl + [ Same as [Esc] key.
Ctrl +V Same as Edit Mode in Editor Setup menu in Setup menu.
Ctrl + P Prints current screen.
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HANDSET COMMUNICATIONS

4.1

Signal level

Y :Cannot communicate.

This chapter covers handset communications, using the Handset |1B-882/IB-882-
362. The handset functions to make calls to shore and other ships. It also
functions to set up the Class 1 system.

Standby Display

The standby display appears about three seconds after turning on the
communication unit. This is where you begin all handset operations.

Ocean region in use (AORE, AORW, POR, IOR)

Ready or Busy appears.

Date —— il i
Time % g O g 4 g l8JT ég Ready: Shown when synchronized with
| nmarsat-B common channel.
FELCOM 82 Busy: Shown when communication line
Yl a Oﬁ E Ready is in use (connection or disconnection).
NAV GYRO FAI L~<— Appears (and flashes) for system failure.

’ \ ) (ALARM LED on handset also flashes.)
Y, :weak signal strength

Yil : Medium signal strength

Appear (and flash) when respective input is lost.
For gyro, select "Hold" at the heading input screen

Yl : strongest signal strength to display "GYROQ" steadily. For how to enter

position and gyro heading manually, see page
2-17 and 2-18, respectively.

Standby display
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4.2  Display Markers; How to Enter Data, Symbols

N

Markers

A square and/or triangle(s) appear at the top right corner of relevant displays.
They indicate what action can be taken on the current screen.

41 MNbnitor

_J

O A v - Markers
LON 135: 22. 31E

TX El RP 000
Tx RF 000
Rx Si gnal 028

RX | F AGC 133

O: Current screen can be printed (with the [Print] key).
V¥ : Continues on next page. Use the [x] key to scroll the screen down.
A Continued from previous page. Use the ] key to scroll the screen up.

How to Enter Alphanumeric Data, Symbols

Alphanumeric data

You enter alphabet with the keys 2-9 and numerics with the keys 0-9. To switch
between alphabet and numeric press the [Mode] key. The display shows NUM or
ALPH at the top right corner of the display with each press of the [Mode] key.

66 Personal ID 66 Personal ID _
Entry ALPH — Alphabet Entry NUM — Numeric
USER NAME: U;ER NAVE:
PI!D_: 000 ~¢—|PID 000

[Mode]
Enter: [Ent] key Enter: [Ent]

To switch between upper and lower case alphabet, first display ALPH and then
press appropriate alphabet key to display alphabet and case desired. For example,
each press of the [ABC] key changes the alphabet and alphabet case in the
sequence shown below.

|—>A—>B—>C—>a—>b—>c—|

Symbols

Use the [Symb] key to input symbols shown below on menus. Each press of the
key selects a symbol in the sequence shown. Do not use the [#] and [*] keys to
input corresponding symbol; since they function as the end code and prefix code
canceller, respectively.

B e il e B g b e e (0
DI=[<I=Pl-l]-[]]

[{- B=>E-U-11-07
(=== l-l@1-[]
[+]>L]> B [$->¥-[%] -]

Selecting where to input data
Use the arrow keys.
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4. HANDSET COMMUNICATIONS

4.3  Calling

The Inmarsat-B system provides telephone services for both land and maritime
subscribers.

4.3.1 General calling procedure

There are two methods by which to make a call: direct dial or dial after pressing
the [wm] key.

Note: If you using a prefix dial number see paragraph 4.3.2. Further, for dialing
using a personal ID see paragraph 4.3.3.

Direct dialing

1. Confirm that the signal strength indicator is showing at least one vertical bar
and the indication “Ready” is displayed.
2. Pick up the handset and dial number, referring to the examples below, within

20 seconds of picking up the handset.
2000-08-29
12:34 UTC
Di al : R

“Dial” display

Dialing procedure for calling land subscriber

JOdpeon Oogoddnon

LES No. Service Country Area
Code Code  Code

LES No. = See Appendix C.
Country Code = See Appendix B.

Subscriber's No.

Dialing procedure for calling MES

g dididdoiobda

LES No. Service Sea Area
Code No.

Vessel ID No.

871 Atlantic Ocean-East
872 Pacific Ocean
873 Indian Ocean
874 Atlantic Ocean-West

Sea Area

Note: If you misdial press the [w&] key and then redial.
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3. Press the [@n] key to call. The following display appears during calling.

4-4

2000-08-29
12:34 UTC

ORG-= Calling
HSET
Yul POR Ready

“Call” display

4. When subscriber answers begin communications.

Answer —

2000-08-29
12:34 UTC

ANS 001' 23" +— Communication time
HSET
Yul POR Ready

“Answer” display

5. You may adjust the volume of the earpiece by pressing the [=x] or [¥*] key.
6. Press the [wm] key to finish communications.

7. Hang up the handset.

Note 1: The standby display automatically appears 20 seconds after hanging up

the handset.

Note 2: Wait at least 30 seconds between communications. Otherwise, an error
message is displayed and no communications can be made.

Note 3: If, for some reason, an LES cannot be reached the tone sounds in the
handset to denote reason. Further, the reason is printed out.

LES status and tone interval

Reason Tone Interval
Busy ‘—'0-5 sec | 05sec
ON OFF

. 0.25 sec| 0.25 sec

Congestion 4} .........

g ON OFF ‘
No Service Continuous |
ON I
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4. HANDSET COMMUNICATIONS

Note 4: Below are commonly available services and service codes.

Service code and service

Service Code Service
00 Automatic Call
11 International Operator
12 Information
32 Medical Advice
33 Technical Assistance
34 Person-to-person Call
35 Collect Call
36 Credit Card Call
37 Time And Charges Call
38 Medical Assistance

Operator-assisted call
1. Dial the following:

0000

LES No. Service
Code

l

11: International Call
34: Person-to-person Call
35: Collect Call

2. When the operator answers give the following:
a) your ship's name or MES ID
b) whether the call is operator-assisted or collect call (national, area code or
Maritime Country Code)
c¢) For person-to-person call, name of subscriber

Note: If you are connected to a wrong subscriber, hang up the handset, re-call
the operator and request reconnection.

4-5
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4.3.2

4-6

Dialing by first pressing the [am] ke

1. Confirm that the signal strength indication is showing at least one vertical bar
and the indication “Ready” is displayed.
2. Pick up the handset and press the [@l] key. The “dial” display appears. (See
page 4-3.)
3. Dial subscriber’s complete number.
Note: If you misdial, press the [w] key. Press the @] key again and then dial
number. Further, dial each digit within five seconds of the previous digit,
otherwise the call will be canceled.

4. Press the [#] (end code) key. The “calling” display appears. (See page 4-4.)
The remaining procedure is the same as from step 4 in “Direct dialing” on
page 4-3.

Dialing prefix number

You may wish to automatically enter a prefix code anytime the handset is picked
up or the [@m] key is pressed. This is useful for automatically dialing a part of an
often-called number.

Registering prefix dialing number

The prefix dialing number is useful for dialing parts of often-called numbers such
as an LES area or service code. This function is done from the Administration
mode. See page 2-10 for how to choose the Administration mode.

1. Press [FUNC Quit], [7] and [3] to display the Prefix Code input screen.

73Prefix Code
|
Prefix Dial:

Enter: [ Ent]

Prefix code input screen

2. Enter prefix number (max. 10 digits), considering where you dial the most. For
example, enter 00300813 (003, KDDI, 00: Automatic call, 81, Japan, 3,
Tokyo) if most of your calls go to Tokyo.

Press the [Ent] key.

4. Press the [FUNC Quit] key to close the menu.

w

To delete the prefix number, hit the [DEL Prty] key at step 2.
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Dialing the prefix number

1. Confirm that the signal strength indication is showing at least one vertical bar

and the indication “Ready” is displayed.

4. HANDSET COMMUNICATIONS

2. Pickup the handset and press the @] key. If the prefix number is 00300813,

for example, the display appears as below.

Prefix number

Prefix: "*"|l--——Tocancel prefix
number, press
the [*] key.

-los-zg
4Y UT
0030081

Prefix number (00300813)

3. Dial subscriber’'s complete number, excluding any portion already dialed with

the prefix dialing number.
4. Press the [#] key. The “call” display appears. (See page 4-4.)

Dialing with no prefix number

1.

no

2000-08-29
12: 34 UTC
Di al : R

“Dialing” display

Dial subscriber’'s complete number.
Press the [#] key. The “calling” display appears. (See page 4-4.)

Confirm that the signal strength indication is showing at least one vertical bar
and the indication “Ready” is displayed.

Pickup the handset and press the [w] key.
Press the [*] key to release the prefix dialing number.

4-7
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4.3.3

4-8

Calling when personal ID is in effect

Personal IDs may be registered to control handset usage and monitor toll
charges. Using personal IDs you can know who uses telephones or facsimiles
and when. For how to register personal IDs see paragraph 4.13 Personal 1D
Number.

1. Confirm that the signal strength indicator is showing at least one vertical bar
and that the indication “Ready” is displayed.
2. Pick up the handset and press the [@] key.

2000-08-29
12: 34 UTC

Dial : B_______
(PI'D Enable)
Yil POR Ready

Dial display, PID enabled

3. Enter three-digit personal ID number. (Do this before selecting priority and
after the prefix dialing number appears.)

4. Enter subscriber’'s complete number.

Press the [#] key.

o
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4. HANDSET COMMUNICATIONS

4.4  Redialing

The redial feature automatically redials a previously dialed telephone number.
The latest 10 dialed telephone numbers are stored in the memory, and they are
numbered 0-9, 1 the latest dialed number and 0 the oldest dialed number. Each
time the redial feature is used the oldest dialed number stored in the memory is
erased. Like numbers are not stored.

Note: The handset records telephone numbers entered with the numeric keys.
Therefore, if you change the prefix dial code after making a telephone call,
the same telephone number cannot be redialed. For further information
about prefix dialing see page 4-6.

1. Confirm that the signal strength indicator is showing at least one vertical bar
and that the indication “Ready” is displayed.

2. Press the [REDIAL] key. The display should look something like the one
below. If there are no numbers stored only the message “No Data” appears.

REDI AL
v
1-9, 0 appears —r 1 FURUNO )
<~—— Name appears in case of
Di al : 0030081 7} abbreviated dialing number.
98631131 “No entry" appears otherwise.
Cal |l : OFFHOOK

Note: * at the head of the tel. no. means prefix dial
number not used when dialing.

Redial display
3. Use the [®] or [¥*] key or numeric keys to select redial number.
Note: If you used the numeric keys to select a number omit step 4.
4. Press the [@l] key to redial number selected.

4-9
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4.5

45.1

4.5.2

4-10

Receiving

Receiving a telephone call in the Inmarsat system is exactly the same as with a
conventional telephone: simply pick up the handset and listen to the party. When
a call is received the display looks something like the one below.

2000-08-29
12:34 JST

l ncoming Call
: HSET

Yil POR Busy

“Incoming call” display

Call received at handset

When a call is received at the handset, the handset rings, and the display shows
(and flashes) “Incoming Call: TELO.”

Pick up the handset.

Press the [@l] key and communicate with party.
Press the [wm] key to disconnect the line.

Hang up the handset.

el A

Call received at location other than handset

When a call is received at a location other than the handset, the handset rings,
and its display shows (and flashes) “Incoming Call: X” (X = TELn*, FAXn*, TELEX,
MSD, or HSD. n = terminal no., * =). When more than one call arrives the lowest
terminal no. is displayed.

2000-08-29
12: 34 UTC
ORG

TELEX

Where call was received

Yil POR Busy

“Receiving” display (telex)
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4. HANDSET COMMUNICATIONS

4.5.3 Receiving distress, safety, urgent call

When you receive a distress, safety or urgent call, a tone sounds in the handset
according to call priority as below.

Call type and tone interval

Call Tone Interval
Distress * ’f H f * f *| *|02sec) 2_5_99 .............
ON OFF! ON I OFFI ON I OFFI ON OFF ON OFF
*=0.1sec
*k *E | 04sec 2 sec
Urgent | oot * =0.1sec
on Torr | oN T oFF OFF ‘ =09 sec

*x | % 0.7 sec 2 sec
Safety onloFF }—HN OFF { =0.1sec
1sec 2 sec
Routine | g1 L |

4-11
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4.6

4.6.1

4.6.2

4-12

Holding, Forwarding a Call

For how to hold and forward a telephone call, see page 5-6.

Holding a call

1. Press the [HOLD Print] key. “HOLD” appears on the display.

2000-08-29
12:34 UTC
ANS 001 23
HSET

HOL D
YM POR Busy

“Hold call” display
Note: If you don't hang up the handset, press the [HOLD Print] key again to talk.

Forwarding a call

You can forward a call to a telephone in the MES network on board your ship by
dialing its intercom number.

1. When you receive a call which is intended for another telephone, press the
[HOLD Print] key and dial appropriate intercom number.
2. After confirming connection, press the [w8] key.

If you dial an invalid intercom number, you will hear the "busy tone". Press the
[HOLD Print] key and repeat steps 1 and 2. If there is no answer, press the
[HOLD Print] key to cancel forwarding.
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4.7 Intercom

In the MES network on board the vessel you can communicate with a telephone

by dialing its intercom number. Note the intercom communications are not saved
to the communications log. For intercom communications by telephone, see page
5-6.

4.7.1 Using the intercom
1. Pick up the handset.
2. Press the [Intercomm] key.

2000-08-29
12:34 UTC

Intercom H

Y|I| POR Ready

“Intercom” display

3. Enter intercom number (1-3) of telephone you wish to call. (If you dial an
invalid number, you will hear the "busy tone". Hang up the handset and dial
again.)

4. Press the [##] key upon completion of call. The intercom display is erased and
the standby display appears.

4.7.2 When receiving a call during intercom use

When you receive an outside call while talking via the intercom, you will hear
three beeps of 0.3 seconds duration followed by 2.1 seconds of no tone. Press
the [#] key to conclude intercom use, and then press the [@8] key to
communicate.

4-13
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4.8

4.8.1

4-14

Abbreviated Dialing

You may register abbreviated dialing telephone numbers, and dial them in just a
few steps. 50 abbreviated dialing numbers may be registered.

Programming abbreviated dialing numbers

1. Press the [ABBR Find] key. Your display should look something like the one
shown below if no abbreviated dialing numbers have been entered.

ABBR LI ST

No dat a.

Menu: [ *]

Abbreviated dialing number list, no entries

2. Press the [*] key to show the Abbreviated Dialing menu.

ABBR MENU

2Edi t

3Remove
4HSD Cal
Select: [ Ent]

Abbreviated dialing menu

Note: “2 Edit” does not appear when no abbreviated dialing numbers are
registered. “1 Entry” does not appear when 50 abbreviated dialing
numbers have been registered.(In this case delete unnecessary
abbreviated dialing numbers to enter new ones.) Further “3 Remove”
and “4 HSD Call” do not appear unless OID/DID number for the HSD
terminal is registered.

3. Press the [1] key to select 1 Entry.

ABBR ENTRY
NUM

Abbreviated dialing number input screen

4. The cursor is now at the location where you enter a three-digit abbreviated

dialing program number, 000-999. Use the numeric keys to enter a three-digit
program number.

5. Press the [¥*] key to select the Name field.
6. Enter the name (20 characters max.) you wish to register the number under.

For example, a company name or a person. You can use the [Mode] key to
switch between upper and lower case alphabet and numerics.
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4.8.2

4. HANDSET COMMUNICATIONS

7. Press the [¥] key to select the Dial field.

Enter telephone number, up to twenty digits.

9. Press the [Ent] key to register followed by the [FUNC Quit] key to close the
menu.

o

Note: Prefix dial number can be combined with abbreviated dial number. For
example, the prefix dial connects via the Yamaguchi, Japan operator
(0030081). Then, if you want to connect via a different LES, register the
following abbreviated dialing number.

bl O obbidddn

Prefix LES No.  Service Country Area Subscriber's No. End
cancel Code Code Code Code

* is registered with the abbreviated dialing number, therefore the line is not
connected to the Yamaguchi but to the LES you select.

Dialing abbreviated dialing number

By selection of abbreviated dialing number

Select the abbreviated dialing number by entering the number it is registered
under as below.

1. Press the [ABBR Find] key.

2. Use the [=] or [~] key or numeric keys to select abbreviated dialing number
desired.

3. Press the [@l] key to dial.

By search

Use the search feature to find desired abbreviated dialing number as below.

1. Press the [ABBR Find] key.
2. Press the [ABBR Find] key again to display the Abbreviated List search
screen.

ABBR LI ST
Search ALPH
001 FURUNO

Dial : 01234567
890123456789
Find: B_

Abbreviated list search screen

3. Use the numeric keys to enter up to five alphanumeric characters in the Find
field.

4. Press the [Ent] key to search.

5. After finding desired abbreviated dialing number, press the [@] key to dial.

4-15


http://www.reelschematic.com

www reelschematic.com

4.8.3

4.8.4

4-16

Deleting abbreviated dialing numbers

You may delete unnecessary abbreviatd dialing numbers as follows:

PN PRE

Press the [ABBR Find] key.

Press [*] to show the Abbreviated Dialing menu.

Press the [3] key to select 3 Remove.

Use the [=] or [¥*] key or numeric keys to select abbreviated dialing number
to delete.

Press the [DEL Prty] key. You are asked if it is all right to clear selected
abbreviated dialing number.

Press the [Ent] key to delete.

Press the [FUNC Quit] key to quit.

Editing abbreviated dialing numbers

o0k w

Press the [ABBR Find] key.

Use the [=] or [¥*] key to select abbreviated dialing number to edit and press
the [Ent] key.

Press [*] to show the Abbreviated Dialing menu.

Press the [2] key to select 2 Edit.

Edit data as appropriate and press the [Ent] key.

Press the [FUNC Quit] key to quit.
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4.9

Urgent/Safety Communications

Urgent or safety communications is possible by setting priority before calling. The
priority automatically becomes “routine” after completion of call.

Safety communicates important meteorological or navigation warning.

Urgent communicates safety of ship or safety of person.

1.
2.

No ok~

Pick up the handset.

Press the [DEL Prty] key to select priority desired. Each pressing of the key
selects priority in the sequence shown below. Safety and Urgent priorities are
shown on the “dial” display.

r Safety — Urgent — Routine —|

2000-08-29
12: 34 UTC

Dial: __ ______
Priority S_a_f_e_t?/ _______
Yl POR Ready

“Dial” display, safety priority
Press the [@l] key.
Dial LES in three digits and press [#].
Communicate with LES.
Press the [«m] key to finish communications.
Hang up the handset.

Note: Personal ID and prefix dial are temporarily disabled in safety/urgent

communications.
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4.10 Distress Communications

Distress telephone communications are initiated with the DISTRESS button. This
button is found on the hanger of the Handset IB-882-362 or on the Telephone
Distress Button I1B-362 when using the Handset IB-882. When the button is
operated the priority of the handset is automatically set to DISTRESS.

1. Pick up the handset.

2. Open the distress button cover.

3. Press and hold down the [DISTRESS] button six seconds. The priority
automatically becomes “DISTRESS.”

4. Press the [wm] key.

5. Dial an LES in three digits, referring to the LES Access Code Lists in
Appendix C, and press the [#] key.

Note: The LES designated on the Distress LES menu (menu 57) is
autotmatically called if there is no key input within 15 seconds after
pressing the [wl] key.

6. Commence communication with LES, giving your ship’s name, nature of
distress, assistance needed and description of your vessel.
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4. HANDSET COMMUNICATIONS

4.11 Menu Operations
4.11.1 User and Administration modes
The user mode provides the basic functions of the Display, Setup and MES
menus.
4Di spl ay 5Setup 6 MES
2Comm. Log 2Gyro 2Menu Style
3Ant enna 3Change Mode
4Position
Select: [ Ent] Select: [ Ent] Select: [ Ent]
4 Display menu 5 Setup menu 6 MES menu

User mode menus

The Administration mode provides the entire menu system. It is accessed with a
password, thus its use is restricted to authorized personnel.

4 Display menu

5 Setup menu

6 MES menu

7 TELFAX menu

8 HSD menu*

4Di spl ay 4Di spl ay 4Di spl ay

v AV A
1 Monitor] 5 Print Al 9 Print MSDj
2 Comm. Log 6 Print Setup 0O Print HSD*
3 Ti me&Charge 7 Print MES
4 System Log 8 PrintTELFAX
Select: [ Ent] Select: [ Ent] Select: [ Ent]
5Setup 5Setup 5Setup

v AV A
2 Gyro 6 Backup NCS 0 RcvAlarm
3 Antenna 7 DistressLES
4 Position 8 DMG
Select:[Ent] Select:[Ent] Select:[Ent]
6 ME S 6 MES 6 MES

v AV A
2 Menu Style 6 Personal I D 0 ForcedCl ear
3 Change Mode 7 Password
4 Date&Ti me 8 Test
Select:[Ent] Select: [ Ent] Select: [ Ent]

*Appears when OID/DID

7TTELFAX 7TTELFAX A isregistered'

v
1 Time Limit
2 Credit Call
3 Prefix Code
4 Echo Cancel
Select: [ Ent] Select: [ Ent]
8 HSD 8HSD 8 HSD

v A A
1 Dest. No 5 Auto Rate 9Print HSD
2 Call TEL 6 Command
3 Data Rate 7 Character
4 Dial Method 8 lgnore DTR
Select: [ Ent] Select:[Ent] Select:[Ent]

Administration mode menus
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4.11.2 Changing operation mode

4.11.3

4-20

1. Press [FUNC Quit], [6] and [3] to display the Change Mode input screen.

Current mode is USER

2. Do one of the following depending on the mode in use:

a) To change to the Administration mode, enter the password and press the
[Ent] key. (Password is not shown on the display; only asterisks (*) are

shown.)

63Change Mode 63Change
USER - ADMI N ADMI N -
Enter Passwd: OR

Enter: [Ent] Change:

Mo de

USER

[ Ent]

Current mode is ADMINISTRATION

Change mode input screen

b) To change to the User mode, press the [Ent] key.
3. Press the [FUNC Quit] key to close the menu.

Changing User mode format

Two types of menu formats are available: Simple and Detailed. “Simple,” the
default setting, provides the menus of the User mode. This menu format is useful
for ships which require access to basic functions of the handset. “Detailed”
provides the menus of the Administration mode, and requires a password to open

menus.

1. Press [FUNC Quit], [6] and [2] display the menu style menu.

62Menu

Enter

1 Simple
2 Detailed

[ Ent]

Styl e

Menu style menu

2. Press the [2] key to select Detailed.
3. Press the [FUNC Quit] key to close the menu.
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4.11.4

4.11.5

4. HANDSET COMMUNICATIONS

How to open a menu when using the Administration mode

For example, to open the Date&Time menu, do the following:

1. Press [FUNC Quit], [6] and [4]. The following display appears.
64Dat e&Ti me

ADMI N Command
Enter Passwd:

m___
Enter: [ Ent]

Date&time menu, prompt for password

2. Enter four-digit password and press the [Ent] key. If the password entered is
correct, the menu selected appears.

64Dat e&Ti me
1 Dat e&Ti me

2 Date Form
3 Time Zone

Select: [ Ent]

Date&time menu

Note: If the password is incorrect, the message “Password error!” appears and
three seconds later the main menu appears.

Customizing the User menu

You may freely choose three items to display on positions 1, 2 and 3 on the User
menu.

Adding menus

1. Press the [FUNC Quit] key.

2. Press appropriate numeric key among 1-3 to select the location where you
want to add a menu. For example, press the [2] key to select position 2. Your
display then looks like the one below.

Mai n Menu
v
1
3
4 Displa
[

y
Select:[Ent]

Main menu
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4-22

3.

4.

5.

Press the [Ent] key, and the Custom Menu input screen appears.

Custom Menu

I nput
Menu item
No. [go

Enter: [ Ent]

Custom menu input screen
Enter the two-digit menu number you want to add and press the [Ent] key.
(See the menu tree at the back of this manual for menu number.) For example,
key in 61 to add the Handset menu. Your display then looks as below.

Mai n Menu
v

1

3

4 Display
Select: [ Ent]

Main menu

If the menu number entered at step 4 does not exist the message “Input Error!
Menu no. is not available.” appears and three seconds later the main menu
appears. Menu 49 cannot be entered unless MSD OID/DID number is
registered. Menus 40, 81, 82, 83, 84, 85, 86, 87 and 88 cannot be entered
unless HSD OID/DID number is registered. For how to register MSD and HSD
numbers see the installation manual.

Press the [FUNC Quit] key to close the menu.

Deleting menus

1.
2.
3.

Press the [FUNC Quit] key.

Select the menu item which you want to delete.

Press the [DEL Prty] key. Your display should look something like the one
below.

Custom Menu

Menul:
Antenna

is cleared.
ARE YOU SURE?
Enter: [ Ent]

Prompt for deleting custom menu

Press the [Ent] key to delete the menu selected.
Press the [FUNC Quit] key to close the menu.
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4.12

4. HANDSET COMMUNICATIONS

Communications Log

The communications log stores the latest 50 received and transmitted telephone,
telex, MSD, HSD and facsimile calls, numbered from 01-50.

1. Press [FUNC Quit], [4] and [2] to show the Communications Log. The figure
below shows sample Tx and Rx log entries.

Max. No. T: Transmit
|
o 42Cofmm./ Log Communication Time
Communication NOo.———{ 02/ 50 T AV ("OVER" shown for time
bate, Tlme-Sént —C: % (3) 0 8 0 ? ° 5 2 g 0 )/ exceeding 999 min. 59 sec.)
Priority — ROU POR HSET-<—— Communications Mode
ROU: Routine 001- Ofs 1717986 HSET: Handset
SAF: Safety 68851 TELn: Telephone
URG: Urgent | FAXn: Facsimile
DIS: Distress Ocean Region TLX: Telex
TST: Distress Test AORE MSD: 9.6k DATA Communications
AORW HSD5: HSD communications (56 kbps)
. IOR HSD6: HSD communications (64 kbps)
Subscriber No. POR SYS: Inmarsat system message
(Sent over telex.)
n = Terminal No.
Txlog
R: Receive
|
42Comm Log
03/50 CJAV
2000-08-29
13: 00( 15" 30)
ROU POR HSET
LESNo.—— 00 3 -
Rx log

Sample communication log entries

2. Use the [=] or [¥*] key to scroll the screen if necessary. You can print the log
by pressing the [HOLD Print] key.

3. Press the [FUNC Quit] key to close the menu and return to the standby
display.
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4.13

4.13.1

4-24

Personal ID Number (PIN)

Personal ID numbers (hereafter referred to as PIN) may be assigned to
personnel to monitor usage of telephones and faxes. You must enter correct PIN
before dialing in order to make a call. 50 PINs may be assigned. This function is
done from the Administration mode. See page 2-10 for how to select the
Administration mode.

Entering PIN
1. Press [FUNC Quit], [6] and [6] to display the Personal ID menu.

o

66 Personal | D

1 PI D: Di sabl €
2 PID Entry

3 List/Edit

Select: [ Ent]

Personal ID menu

Note: If 50 PINs are registered 2 PID Entry is not displayed. In this case
delete unnecessary PINs in order to enter new ones.

Press the [2] key to select 2 PID Entry.

66Personal 1D
Entry ALPH
USER NAME:
u_________

P11 D: 000
Enter: [ Ent]

Personal ID input screen

Use the alphanumeric keys to enter user’'s name (max. 10 alphanumeric
characters and symbols) and press the [Ent] key. Multiple like names cannot
be used.

Press [¥].

Enter PID number in three digits (any number between 000 and 999).

Press the [Ent] key.

Note 1: If the name or PIN entered at step 3 or 5 is already registered, you
are asked if it is OK to overwrite the name or PIN. Press the [ENT]
key to overwrite, or [FUNC Quit] to enter a different name.

Note 2: If both name and PIN pair are already registered control is returned
to the main menu.

Press the [FUNC Quit] key to close the menu.
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4.13.2

4.13.3

4. HANDSET COMMUNICATIONS

Enabling PIN usage
PIN usage is “disabled” in the default setting. When you enable it, you must enter
personal ID to dial from a telephone or facsimile.

1. Press [FUNC Quit], [6] and [6] to display Personal ID menu.
2. Press the [1] key to select Disable.

66Personal I D
Pl D Mode
2 Enabl e

Select: [ Ent]

Personal ID menu

3. Press the [2] key to select Enable.
4. Press the [FUNC Quit] key to close the menu.

To disable use of the PIN select Disable at step 2 in the above procedure.

Note: With the PIN feature enabled, error results if a number is dialed without
entering PIN or if an unregistered PIN is entered.
Editing, printing the PIN list

PINs may be edited or deleted as necessary.

Editing the PIN list

1. Press [FUNC Quit], [6] and [6].
2. Press the [3] key to select Personal ID List.

66Per sonal I D
List AV
USER NAME:
FURUNO

PI D: 001

Edit: [ Ent]

Personal ID list

3. Use the [®] or [¥*] key to select personal ID to edit.
4. Change data as necessary and press the [Ent] key.
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5. To delete a PIN, do the following:
a) Delete user name with the [DEL Prty] key. (The PIN itself cannot be
deleted.)
b) Press the [Ent] key. The display looks as below. Press the [Ent] key again
to delete the number, or press the [FUNC Quit] key to quit.

66 Personal I D

PID (000)
is cleared.

ARE YOU SURE?

Clear:[ Ent]

Prompt for clearing personal ID

6. Press the [FUNC Quit] key to close the menu and return to the standby
display.

Printing the PIN list

1. Press [FUNC Quit], [6], [6] and [3].
2. Press the [HOLD Print] key to print. Below is a sample PIN list printout.

------ 66 Personal |D List <2000-06-20 00: 00(UTC)> -----------------------
Nane . PI D Nanme :PI D Nane Pl D Nane : Pl D Nane :PID
FURUNO : 001 BART 1145 REGA E 1927 CARM NE : 557 MARI O 1123
CEORCGE 1422 ENRI QUE :310 | AN :100 LI UG 1219 ZAK 1610
FRANK : 345 RAUL 1489 Bl LL : 780

Personal ID printout
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4.14

4.14.1

4. HANDSET COMMUNICATIONS

Toll Charges

You may display and print approximate toll charges. This procedure is done from
the Administration mode. See page 2-10 for how to choose the Administration
mode.

Setting the toll charge calculator

LESs do not send toll charges to MESs. Therefore, you may wish to calculate the
toll charges assessed to you with the built-in toll charge calculator. You may
register the toll charge units for 50 LES. The toll charge calculator provides only
an estimate of the toll charges. Actual charges may be different.

1. Press [FUNC Quit], [6] and [5] to display the Charge Info input screen.
65Charge I nfo
O

LES: 01

Unit Ti me:
060( Sec)

uni Charge:

t
003. 00( SDR)

Charge info input screen

Enter LES number.

Press the [>*] key to select Unit Time.

Enter appropriate unit time (000 sec. to 999 sec.).

Press the [¥] key to select Unit Charge.

Enter appropriate unit charge and press the [Ent] key. (SDR means Special
Drawing Right and it is the common unit charge used by all LES to assess toll
charges.)

7. Press the [FUNC Quit] key to close the menu and return to the standby
display.

2R
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4.14.2 Displaying toll charges

4.14.3

4-28

1. Press [FUNC Quit], [4] and [3] to display the Time&Charge menu.
43Ti me&Charge

1 List by LES
2 List by PID
3 Data Clear

Select: [ Ent]

Time & Charge menu

2. Pressthe [1] key to select 1 List by LES, or press the [2] key to select 2 List by
PID.

43Ti me&Charge 43Ti me&Charge
AV AV

LES: 003 <GEORGE >

T 0001: 20’ 00" COUNT: 010

R 0000:50" 00" T 0000: 20" 00"

0000160(S R) 0000040( SDR)

Quit:[Quit] Quit:[Quit]

Time and Charge by LES Time and Charge by Personal ID

Sample time & charge data

3. Use the [=] or [¥*] key to scroll the display if necessary.
4. Press the [FUNC Quit] key to close the menu and return to the standby
display.

Clearing toll charges data

Press [FUNC Quit], [4] and [3] to display the Time&Charge menu.
Press the [3] key to select 3 Data Clear.

You are asked if you are sure to clear all toll charge data.

Press [8], [2] to clear all toll charge data.

Press the [FUNC Quit] key to close the menu and return to the standby
display.

aogrwnNPRE
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4.15

Forced Clear

4. HANDSET COMMUNICATIONS

You can clear the communication line as below when it cannot be cleared through
normal means. This procedure is done from the Administration mode. See page

2-10 for how to choose the Administration mode.

1. Press [FUNC Quit], [6] and [O] to display the Forced Clear display.

Note: If you are not currently connected the message “MES is idle.” is
displayed and three seconds later the standby display appears.

2. Press [8], [2] to clear the current connection. The display shows “Now

60ForcedCl ear

Current Calll
will be
cleared
ARE YOU SURE?
Clear: [ 82]

ForcedClear display

clearing” followed by “Call cleared.” After the call is cleared the main menu

appears.

3. Press the [FUNC Quit] key to close the menu.
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4.16

4.16.1

4-30

Optional Telephone/Fax Setup

The TELFAX menu functions to set up the telephones and faxes of the FELCOM
82 system.

This procedure is done from the Administration mode. See page 2-10 for how to
choose the Administration mode.

Restricting telephone call length

You may restrict telephone call length on outgoing calls from telephones. (You
cannot restrict call length for the handset or internal calls.) The default setting is
no time limit. When it is 30 seconds before the time limit is to arrive, an audible
warning sounds in the telephone or handset to alert the user. For forwarded calls
the call time is counted from when the call was received.

If no OID/DID is set for a telephone the Time Limit menu shows “NONE” for the
telephone which does not have an OID/DID number. You may restrict call length
for such a telephone, however the setting is shown as NONE unless an OID/DID
number is entered.

How to restrict telephone call length

1. Press [FUNC Quit], [7] and [1] to show the Time Limit menu. (“NONE”
appears instead of OFF or ON when no OID/DID is registered.)

Li mit
O

1 TEL1: OFF

2 TEL2: OFF

3 TEL3: OFF

71Ti me

Select: [ Ent]

Time limit menu

2. Press appropriate numeric key to select TEL1, TEL2 or TEL3.

71Time Limit
TEL1

O
2 Limit Time
3 Answer Only
Enter: [ Ent]

Time limit selections
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4. HANDSET COMMUNICATIONS

3. Press the [2] key to select 2 Limit Time. (OFF removes time restriction; select
Answer Only to restrict usage of telephone selected to answer only.)

71Ti me
TEL1

Li mit

Enter:

Li mit

Ti me: [§0

[ Ent]

Telephone time limit input screen

4. Key in time with the numeric keys and press the [Ent] key. The available time

range is 01 to 99 minutes.

Note: You cannot enter 00 to remove the time restriction. 00 assigns the
function of the telephone as “answer (receive) only.”

5. Press the [FUNC Quit] key to close the menu and return to the standby

display.

Printing the call time limit list

You may print the call time limit list to get a hard copy of call time restrictions you

have set.

1. Press [FUNC Quit], [7] and [1] to show the Time Limit menu.
2. Press the [HOLD Print] key to print. Below is a sample call time limit list

prinout.

TEL1 : OFF (NO LIMT)
TEL2 : R/ O (ANSVER ONLY)
TEL3 : 30 mi nute(s)

------ 71 Call Time Limit <2000-06-20 00:00(UTC)>

Call time

limit prinout

3. Press the [FUNC Quit] key to close the menu and return to the standby

display.
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4.16.2 Setting telephone/fax for answer only

The telephone and facsimile are set at the factory for both calling and receiving. If
desired you can designate a telephone or facsimile as “answer (receive) only.”
This procedure is done from the Administration mode. See page 2-10 for how to
choose the Administration mode.

1. Press [FUNC Quit], [7] and 1 to show the Time Limit menu.

71Time Limit
O

1 TEL1: OFF

2 TEL2: OFF

3 TEL3: OFF

Select: [ Ent]

Time limit menu
2. Press appropriate numeric key to select TEL1, TEL2 or TEL3.

71Time Limit
TEL1

O
2 Limit Time
3 Answer Only

Enter: [ Ent]

Time limit options

3. Press the [3] key to select Answer Only.
4. Press the [FUNC Quit] key to close the menu.
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4.16.3

4. HANDSET COMMUNICATIONS

Setting telephone as “credit call usage” telephone

You may wish to restrict the use of a telephone for credit card calls only. This can
be done when a credit call adapter is connected to the system.

Assigning telephone function as “credit call”
1. Press [FUNC Quit], [7] and [2] to display the Credit Call menu.

4,
<

Printing credit call list

only.”

Press the [Ent] key.
Press the [FUNC Quit] key to close the menu .

72Credit Call
O

1 TELFAX1: OFF
2 TELFAX2: OFF
3 TELFAX3: OFF

Select:[ Ent]

Credit call menu

72Credi t
TELFAX1

1 OFF
2 ON

Cal |

Enter: [ Ent]

Credit call on/off screen

Press appropriate numeric key to select TELFAX1, TELFAX2 or TELFAXS.

Press the [2] key to select ON to assign function of telephone as “credit card

You can print out a hard copy of the credit call list as below.

1. Press [FUNC Quit], [7] and [2] show the Credit Call menu.
2. Press the [HOLD Print] key to print. Below is a sample credit call list printout.

------ 72 Credit Call
TEL1 : OFF
TEL2 : ON
TEL3 : OFF

<2000- 06- 20 00: 00( UTC) >

Credit card call setting printout
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4.16.4

4-34

Echo canceller

If you hear noise through the receiver of a telephone or handset turn on the echo
canceller function as follows to suppress it.

Turning on the echo canceller

1. Press [FUNC Quit], [7] and [4] to show the Echo Cancel menu.
74Echo Cancel

]
1 TEL1 : OFF
2 TEL2Z2 : OFF
3 TELS : OFF

4 HANDSET: OFF
Select: [ Ent]

Echo cancel menu

2. Press appropriate numeric key to select TEL1, TEL2, TEL3 or HANDSET.

74Echo Cancel
HANDSET

1 OFF

2 ON

Enter: [ Ent]

Echo cancel options

3. Press the [1] key to select OFF, or press the [2] key to select ON.
4. Press the [Ent] key.
5. Press the [FUNC Quit] key to close the menu.

Printing the echo canceller list

You can print out a list of echo canceller settings as below.

1. Press [FUNC Quit], [7] and [4] to show the Echo Cancel menu.
2. Press the [HOLD Print] key to print. Below is a sample echo cancel list
printout.

------ 74 Echo Cancel <2000- 06-20 00: 00( UTC)> ---------
TEL1 : OFF
TEL2 @ ON
TEL3 : OFF
HANDSET: OFF

Echo cancel printout
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4. HANDSET COMMUNICATIONS

4.17 Printing

The Display menu provides for display and printing of monitor (system status),
communications log, toll charges, system log, system setup, and the MES,
TELFAX, HSD and MSD menus.

4.17.1 How to print
1. Press the [4] key to select 4 Display.

4Di spl ay 4Di spl ay 4Di spl ay

v AV A
— | TR ¢
2 Comm. Log 6 Print Setup 0 Print HSD*
3 Ti me&Charge 7 Print MES
4 System Log <«—— |8 Print TELFAX | «—
Select: [ Ent] Sel ect: [ Ent] Select:[Ent]

* Shown when OID/DID
number is registered.

Display menu

2. Press appropriate numeric key to select item which you want to print.

=

: Monitor

: Communications Log

: Time and Charge Menu

: System Log (error messages, etc.)

: Print All (Setup, MES, TELFAX, HSD, MSD terminal AT&V commands)
: Setup Menu

MES Menu settings

: TELFAX Menu settings

: MSD terminal AT&V commands

: HSD Menu settings

3. Press the [HOLD Print] key to print.
4. Press the [FUNC Quit] key to close the menu.

© 0N U A WN

o
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4.17.2 Printout examples

Communications Log (Menu 42

------ 42 Conmuni cation Log <1999-01-01 00: 00(UTC) > --------
OR LES-Destination Prty Type Date & Tine (Duration) Char ge

01 AE T0030081798668851 Rou TEL1 2000- 03-01 13: 01( 63’
02 P R222 Rou TLX 2000-02-29 00:30( 5
< ( OVER ) OVERFLOWN >

03") 38300
10") ---oo--

Communications log printout (by LES)

------ 42 Conmuni cation Log <1999-01-01 00: 00(UTC)> --------

OR LES-Destination Prty Type Date & Tine (Duration) Change
01 AE T0030081798668851 Rou TEL1 2000- 03-01 13:01( 63’ 03") 38300
NAME: GEORGE
02 P R222 Rou TLX 2000-02-29 00:30( 5'10") --------

Communications log printout (by personal ID)

Communications log printouts

Time&Charge (Menu 43)

------ 43 Total Comm Tine & Charge <2000-06-20 00: 00( UTC) >

LES ORG ti nme ANS tine Char ge( SDR)
001 0000: 20’ 00" 0000: 00’ 00~ 00000010
003 0001: 20’ 00" 0000: 20’ 00~ 00001500

TOTAL 0001: 40’ 00" 0000: 20’ 00" 000001510

Toll charge prinout by LES

------ 43 Total Conm Tinme & Charge <2000-06-20 00: 00( UTC) >
NANME COUNT  ORG Char ge( SDR)

GEORGE 010 0000: 20" 00" 00000010

HENRY 005 0001: 20’ 00” 00001500

TOTAL 0015 0001: 40’ 00" 00001510

Toll charge prinout by personal ID

Toll charge printouts

System Log (Menu 44

00-06-20 11:00[ 0123] ALARM HSD Faul t.
00-06-20 12:34[1234]Call Ceared by MES.

------ 44 System Log <2000- 06-20 00: 00(UTC) > ------========-

System log printout

4-36



http://www.reelschematic.com

www reelschematic.com

4. HANDSET COMMUNICATIONS

Setup (Menu 46

------ 46 System Setup Print <2000-06-20 00: 00(UTC) > ---------mmmmmmnonnn-
55 Area:
No. 1 No. 2 No. 1 No. 2
WVO 255 000 | CAO 255 000
I MO 255 000 NAVAREA 255 000
56 Backup NCS:
ACRE 306 Sat 5 000
POR 005 Sat 6 000
I OR 003 Sat 7 000
ACRW 306 Sat 8 000
57 Distress LES:
ACRE 306 Sat 5 000
POR 005 Sat 6 000
I OR 003 Sat 7 000
ACRW 306 Sat 8 000
58 DMz
Abbrevi ati on Ship’s Nane: ABCD
Maritime : YES
Nat ur e : Undesi gnat ed
Cour se : 000
Speed . 00
59 O D/ Dl D
ODDD IMW ODDD IM
TELFAX1  TEL1:01 01 343164801 HANDSET TELO: 10 10 343164810
FAX1:11 11 343164811 TELEX TLX :31 31 343164831
TELFAX2  TEL2:02 02 343164802 NMBD MSD :21 21 343164821
FAX2: 12 12 343164812 HsD 64k :42 42 343164842
TELFAX3  TEL3:03 03 343164803 56k :41 41 343164841
FAX3:13 13 343164813

System setup printout

MES settings (Menu 47)

—————— 47 MES Setup Print <2000-06-20 00:00(UTC)> ----------mmmmmommommom
65 Charge | nfo:
Unit Unit Unit Unit Unit Unit Unit Unit
Time Charge Time Charge Ti me Charge Tinme Charge
LES (Sec) (SDR) LES (Sec) (SDR) LES (Sec) (SDR) LES (Sec) (SDR)
001 60 3.00 003 60 3.00 004 60 3.00 006 60 3.00
012 60 3.00 222 60
68 Version List:

MAI' N 165- 0145- 0xx DEMOD 165-0142- 0xx
TERM 165- 0146- 0xx SYNC 165- 0143- 0xx
HANDSET 055- 0204- Oxx DECODE 165- 0144- 0xx

xx = Program Version No.

MES setup printout
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Print TELFAX menu settings (Menu 48)

------ 48 TEL/ FAX Setup Print <2000-06-20 00:00(UTC)> ---------------m----
71 Call Time Limt:

TEL1 : OFF (NO LIMT)

TEL2 : R/ O (ANSVER ONLY)

TEL3 : 30 minute(s)

72 Credit Call:
TEL1 : OFF
TEL2 : ON
TEL3 : OFF

73 Prefix Code:
1234567890

74 Echo Cancel :
TEL1 . OFF
TEL?2 . OFF
TEL3 . ON

HANDSET : OFF

TELFAX setup printout
MSD AT&V commands (Menu 49)

------ 49 MBD Setup Print <2000-06-20 00:00(UTC)> -------mommmmom oo
El COMVAND ECHO On

Q RESULT CODE SUPPRESSI ON Enabl e

V1 DCE RESPONCE FORVAT Ver bose

X4 RESULT CODE SELECTI ON Enabl e

&C1 RLSD( DCD) BEHAVI OR Nor mal

&D2 DTR BEHAVI OR Di sconnect
&S1 DSR BEHAVI OR Nor mal

¥K1 DTE- DCE BREAK CONTROL Cl ear Buffer
+| CF=3, 3 DTE- DCE CHAR FRAM NG 8N1

+l FC=2, 2 DTE- DCE FLOW CONTROL RFR/ CTS

+| PR=9600 FI XED DTE RATE 9600

+W\KSI ZE=25 SAT, ARQ W NDOW SI ZE 25

+W.ES=000 LAND EARTH STATI ON Def aul t
+WRATE=9600, 9600 CHANNEL DATA RATE 9600/ 9600
+WRTL=120, 240 RX BUFFER THRESHOLD 120, 240
+W645=1 ERROR CORRECTI ON ARQ and V. 42
+WITL=120, 240 TX BUFFER THRESHOLD 120, 240
+WKR=0 EXTENDED REPORTI NG St andard

MSD setup printout
HSD menu settings (Menu 40)

------ 40 HSD Setup Print <2000-06-20 00:00(UTQ) > -----------mmmommmoaa
81 Destination No.:

82 Call Tel ephone : HANDSET 83 Data Rate : 64k
84 Dial Method . Direct(DTR) 85 Auto Rate : OFF
86 Command : HDLC  8bit/ None

HSD setup printout
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D.

OPTIONAL EQUIPMENT

5.1
5.1.1

Telephone FC755D1

Telephone communication overview

The telephone FC755D1 functions to make land-to-ship and ship-to-land calls
and receive calls. Three telephones/facsimiles may be installed. The handset,
telephone and facsimile are assigned the following numbers.

Unit Port Telephone No.
Handset HANDSET 0
Telephone, TEL 1 1
Facsimile TEL 2 2

TEL 3 3

In addition to its basic functions, the telephone has the following functions:
* Forwarding a call to other telephones on board

* Intercommunicating with other telephone sets in the MES network on board the
vessel (intercom)

* Dialing a subscriber's number in two digits (abbreviated dialing)
 Dialing previously dialed number (redialing)

Note: If you wish to connect newly the line with an LES, wait for 30 seconds after
the line has been disconnected, otherwise the error message appears,
resulting in no connection.
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5.1.2  Telephone controls

Front panel

RING TONE lamp:
Lights when you speak;
blinks when holding a call.

Display: Shows number being dialed,

settings, etc.
VOLUME key:
Adjusts volume of receiver.

RCV lamp:
Blinks when call is received.

ONE-TOUCH DIAL keys:
Register/dial abbreviated dialing
numbers.

¥ &2 RING TONE key:
Sou @ Changes the dial number of
one-touch dial.

Numeric, symbol keys:

0-9: Manually dial telephone number.

*: Enables hold, forward, and
intercom functions.

#: End code

HOLD key: Holds call.

HOOK key: Starts/cancels forwarding.

REDIAL key: Redials subscriber last dialed. Also used in to insert a
pause when registering one-touch dialing numbers.

key (SPEAKER key): Allows you to dial telephone
number with handset on hook.

FUNCTION key: Registers/dials abbreviated dialing numbers.

Telephone FC755D1
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5. OPTIONAL EQUIPMENT

Underside

® ‘___::|——§—4— Support Leg: Changes the attitude of telephone.
® EE”‘@—/! &o.——- Telephone Jack: Telephone cord connects here.

™~ Handset Jack: Handset cord connects here.

™~ Abbreviated dialing card

\

Telephone FC755D1, underside

Catch: For bulkhead mounting

Remarks on usage

Confirming dial tone
Detach the receiver from the hanger and confirm the dial tone, to make a call.

How to detach receiver
Slide the receiver upward to release it from the catch and then pull it forward.

Receiver supporter

Slide upward.
Catch

How to detach the receiver
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5.1.3 Calling

Standard procedure

1. Pick up the receiver of the telephone.

2. Dial LES, complete subscriber's number (see procedures below) and press
the [#] key. (If you misdial hang up the receiver and then start this procedure
again. Dial each number within five seconds of the previous number,
otherwise the call will be cancelled.)

Land subscriber

U0 i) O O HOOHOH

LES No. Service Country Area Subscriber's End
Code Code Code No. Code

MES (Inmarsat B) - MES (Inmarsat A or B)

000 ol 000 000 A0

LES No. Service Sea Area End
Code No. Vessel ID No. Code

Sea area no.
AOR-E: 871
POR: 872
IOR: 873
AOR-W: 874

Calling procedures

3. Wait for call from LES and then talk with subscriber. (You can adjust the
volume of the earpiece with the [VOLUME] key.)

Note: If the LES cannot be reached, a tone sounds in the receiver according
to LES status as below.

LES status and tone interval

Reason Tone Interval
Busy ‘—’0'5 sec_ | 0dsec |
ON OFF

: 0.25 sec|0.25 sec

Congestion 4} .........

: ON OFF ‘
No Service Continuous |
ON I

4. Hang up the receiver upon completion of call.

Note: Wait at least 30 seconds between calls, otherwise an error message
appears.
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5.1.4

5. OPTIONAL EQUIPMENT

Redialing
The redialing feature automatically redials number last dialed.

1. Pick up the receiver of telephone.
2. Press the [REDIAL] key.

On-hook calling

1. Press the [SPEAKER] key.
2. Dial party’s number and then press the [#] key.
3. Communicate with party.

Receiving

Receiving a telephone call in the Inmarsat system is exactly the same as with a
conventional telephone: simply pick up the receiver and talk with party. If plural
telephones share the same ID number, they all ring when receiving a call. Pick up
any receiver to answer call.

Receiving

1. When a telephone rings, pick up its receiver and talk. (You can adjust the
volume of the earpiece with the [VOLUME] key.)
2. Hang up the receiver upon completion of call.

Call type and tone interval
Call type is notified as below.

Call type and tone interval

Call Tone Interval
. * 0.2 sec 2 sec
Distress H """""""""""""""""
WOFFWOPFWOFFWOFF ON OFF * 2 01 sec
ok *k w1 (), 4 sec 2 sec
Urgent """"""""""""""""""" * = 0 1 sec
on Tore | oN T oFF OFF ‘ * = ()2 sec

* 0.7 sec 2 sec
Safety WOFF}O—Nf OFF { =01 sec
1 sec 2 sec
Routine | gy R |
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5.1.5

5.1.6

5.1.7

5-6

Intercom

In the MES network on board the vessel you can communicate with another
telephone by dialing its intercom number.

How to use the intercom

1. Pick up the receiver of the telephone and confirm the dial tone.

2. Press [*], dial intercom number and then press [#]. (If you dial an invalid
number, you will hear the "busy tone". Hang up the receiver and dial again.)

3. Talk with party.

4. Hang up the receiver upon completion of call.

When receiving a call during intercom use

When you receive a outside call while talking via the intercom, you will hear three
beeps of 0.3 second duration followed by 2.1 seconds of no tone. Conclude
communications and hang up the receiver. Pick up the receiver when it rings, to
talk with other party.

Holding a call

1. Press the [HOLD] key or [*] key.
2. Hang up the receiver. (See note.)
3. Pick up the receiver to talk.

Note: You can hold a call without hanging up the receiver, by pressing the
[HOLD] key again to talk.

Forwarding a call

You can forward a call to another telephone in the MES network on board the
ship by dialing its intercom number.

1. When you receive a call which is for another telephone, press [*], dial
intercom number (0-3) and then press [#].

2. After confirming connection, hang up the receiver. (If you dial an invalid
intercom number, you will hear the "busy tone." Press the [HOOK] key and
repeat steps 1 and 2. If there is no answer, press the [HOOK] key to cancel
forwarding.)
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5.1.8 Abbreviated dialing

The abbreviated dialing feature lets you dial a subscriber's number in just two
digits. You may register 44 abbreviated dialing telephone numbers.

Notes on registration

* Press keys within ten seconds of each other, otherwise key input is cancelled.
* You may write over unnecessary telephone numbers.

Registering dialing numbers

1. Remove one-touch dialing card using the tip of a
mechanical pencil.

Press the [SPEAKER] key

Press the [ENTRY] button.

Press the [RING TONE] key.

Press one of the [ONE-TOUCH DIAL] keys.
Enter telephone number to register. To register
another abbreviated telephone dialing number,
repeat step 4 to 6.

7. Press the [ENTRY] button to confirm the registration.
Press the [SPEAKER] key.

9. Replace the one-touch dialing card.

o0k W

How to remove
the one-touch
dialing card

o

S5-7
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A A o

bbreviated dialing procedure

Press the [SPEAKER] key.

Press the [RING TONE] key.

Press one of the [ONE-TOUCH DIAL] key.
Pick up the receiver.

Replace the one-touch dialing card.

Deleting abbreviated dialing numbers

A A o

© 0N

Remove one-touch dialing card.

Press the [SPEAKER] key.

Press the [ENTRY] button.

Press the [RING TONE] key.

Use the one-touch dialing keys to select the abbreviated dialing number to
delete.

Press the [ONE-TOUCH DIAL] key pressed at step 5 again to delete.
Press the [ENTRY] button.

Press the [SPEAKER] key.

Replace the one-touch dialing card.

Eunction button

The functions buttons can be used as abbreviated dialing keys.

Registering numbers

ouhs~wnNPRE

© N

Remove the one-touch dialing card.

Press the [SPEAKER] key.

Press the [ENTRY] button.

Press one of the [Function] keys.

Enter abbreviated dialing number to register.

Press the [ENTRY] button. To register another abbreviated dialing number,
repeat steps 4 to 6.

Press the [SPEAKER] key.

Replace the one-touch dialing card.

Deleting function

o

oo

Remove the one-touch dialing card.

Press the [SPEAKER] key.

Press the [ENTRY] button.

Press the [Function] key to delete. To delete another abbreviated dialing
number of the function key, repeat step 4.

Press the [ENTRY] button.

Press the [SPEAKER] key.

Replace the one-touch dialing card.
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5.2

5.2.1

5. OPTIONAL EQUIPMENT

Facsimile FAX-8070P, FAX-2850

This section provides basic operating procedures for the Facsimile FAX-8070P
and FAX-2850. For detailed information see the their respective operator’s
manual.

Dialing subscribers
MES (FELCOM 82) - Land

D O0Udoonogi----— 00U MHLD]

LESNo. Service Country Fax No. (START)
Code Code

(Service code normally use "00" automatic call.)

MES (FELCOM 82) - MES (Inmarsat-B)

ooy odnm-— [ [ [&]

LES No. Service SeaArea Vessel ID No. (START)
Code No. (Inmarsat B)

(Service code normally use "00" automatic call.)

MES (FELCOM 82) —» MES (Inmarsat-A)

I O e I O H L]

LES No. Service SeaArea Common Vessel ID No.
Code No. number (Inmarsat A)

(Service code normally use "00" automatic call.)

Note 1. Wait at least 30 seconds between calls, otherwise an error message
appears, resulting in no connection.

Note 2: A facsimile can also function as a telephone, by assigning the same
OID/DID number for both facsimile and telephone. The facsimile
however must automatically output the CNG tone, which the FELCOM
82 uses to distinguish a facsimile call from a telephone call. A facsimile
cannot be properly sent without the CNG tone.

Note 3: A facsimile cannot be sent while conducting voice communications. This
is possible with a facsimile whose transmission rate is 2400 bps.

Note 4: The automatic receive function automatically treats all incoming calls as
facsimile calls. For this reason set the priority for the facsimile according
to how it is most often used, facsimile or telephone. For further details
see the owner’s manual for the fax.

Note 5: The satellite communication line contains longer propagation delays
than land lines. Further, transmission time depends on the
receiving/sending party’s facsimile. In some cases a facsimile may not
be transmitted.

5-9


http://www.reelschematic.com

www reglschematic.com

Note 6: Propagation delay is extremely great when a fax is sent between two
ships, since the fax sent via a satellite line makes a round trip between
the two ships. For this reason, fax success rate for a fax sent via the
satellite line is lower than that for a land line.

Note 7: The FELCOM 82 is designed to use the Facsimile FAX-8070P or
FAX-2850. Use of other facsimiles may not provide intended function.
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5. OPTIONAL EQUIPMENT

5.3 Incoming Indicator IB-372

The 1B-372 sounds an audible alarm when a telex, telephone or facsimile
message is received. To silence the audible alarm, press the [ALARM RESET)]
button on the I1B-372.

[Fununo INMARSATMES] @

O —> O
 C——

ALARM RESET

&

INCOMING INDICATOR
e
Y —
COMPASS SAFE DISTANCE
O SD [ Im STEER [ Im O

FURUNO ELECTRIC CO., LTD.

9-52 Ashihara-Cho, Nishinomiya
City, Japan MADE IN JAPAN

Incoming indicator IB-372
53.1 Ringer format

Ringer format depends on the call received as shown in table below.

Call received and tone interval

Unit Tone Interval
Terminal 1 sec 1 sec
Unit }T¢OFF .....
'(Ii'ﬁlflﬁgﬁ]r;e 0.5 sec 0.1 sec 15
.5 sec
2400 bps e
facsimile) ON  ON
UL ABse
Facsimile H H H OFF
(9600 bps) ON ON ON
*=0.1sec
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53.2 Automatic alarm shut off

Telex call: The alarm automatically shuts itself off one minute after a telex
message is received.

Telephone call: The alarm automatically shuts itself off when the receiver of the
ringing telephone is picked up.
Facsimile call: Buzzer stops when facsimile answers.

5.3.3 Disabling the buzzer

If you do not require the buzzer, you may disable it from the handset as shown
below.

1. Press [FUNC Quit], [5] and [0] to shown the RcvAlarm menu.

50RcVvAI arm

1 Disabl e
2 Enabl e

Enter: [ Ent]

RcvAlarm menu

2. Press [1] or [2] key as appropriate.
3. Press the [FUNC Quit] key to close the menu.

Note: The receive alarm may also be disabled from the terminal unit. The keying
sequence is [F4], [6], type @ @ @ M [Enter], [- ], [Enter], [Esc] (twice).
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6.

9.6k DATA COMMUNICATIONS

6.1

General

The Inmarsat-B 9.6k DATA services (hereinafter referred to as “9.6k DATA”)
enable data communications between (a) a computer (DTE) connected to MES
which supports the 9.6k DATA and (b) a remote computer (ground station) with a
modem, which allows data communications using telephone lines.

Source: Inmarsat - M/B Data Services User's Guide (published by Inmarsat)

telephone network

o mv‘-gﬂ“;\

: e b L S remote computer
e - remote modem
Ground station
your computer
satellite link terrestrial link

end-to-end link

9.6k DATA system configuration

The 9.6k DATA offers the maximum communication speed of 9600 bps in duplex
transmission. As shown in the figure above, there are two links involved between
the two computers. One is the satellite link {from the MES to the LES (ground
station)} and the other the terrestrial link (telephone line from the LES to the
remote modem).

Under the 9.6k DATA, the MES can be used almost like a modem for general use

and controlled with AT commands. In order to ensure the maximum efficiency of
data communications, however, the above two links must be set up properly.
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6.1.1

6.1.2

6-2

Main features
Flow control

Different procedures for the DTE to control the flow of data that is sent by the
MES and those for the MES to control the flow of data that is sent by the DTE can
be chosen. (For further details of flow control, see next section.)

Communication parameters setup

Various parameters can be set including the line communication speed; the line
error correction mode; the window size in the ARQ mode; and the boundary value
of transmit/reception buffer.

Extended line report display

Detailed information (such as communication speeds and error corrections over
the satellite and terrestrial links) can optionally be reported when a line is
connected.

Note: The FELCOM 82 conforms to Inmarsat-B standards ITU-TV25ter and
PCCA STD-101.

Terminology

DCE: Data circuit-terminating equipment. It means a communication control
unit for the FELCOM 82, or a modem of an earth station at the other end.

DTE: Data terminal equipment.

It means a personal computer or similar equipment connected to the
DCE.

<CR>: A code used to inform the MES that the character string for an AT
command has been ended. If the DTE has a keyboard, this code can be
sent to the MES by pressing the Enter or Return key.
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6. 9.6k DATA COMMUNICATIONS

About Data Communications
Modem

A modulator/demodulator is used for data communications over a telephone line.
The FELCOM 82 has a modem built into its communication unit. (The MES can
be thought of as a modem.)

AT commands

One of the command sets used to control a modem. For further information, see
paragraph 6.9 AT Commands.

Operation states

The following operation states are observed when the MES is used for data
communications:

Command state

The MES accepts AT commands when in this state. It recognizes the characters
entered via the DTE as a character string. The MES is not connected to any
remote station.

On-line data state

In this state, the MES is performing data communications with a remote station
connected to it. The characters entered via the DTE are sent to that station.

On-line command state

In this state, the MES is connected to a remote station, but still accepts AT
commands. The characters entered via the DTE are recognized as a character
string and are not sent to the remote station.

Note: The MES never enters the on-line data state unless it is connected to a
remote station.

Flow control

The data received from the DTE is stored in the transmit buffer of the MES. If the
data volume sent from the DTE is larger than that sent from the transmit buffer to
the LES, data is gradually stored in the buffer. Once the buffer becomes full with
the stored data, the MES tells the DTE to stop sending data. Accordingly, data is
no longer sent by the DTE. In turn, the data in the buffer is sent to the LES while
the DTE is stopping data transmission. When the buffer becomes empty, the
MES informs the DTE that it accepts data. Now the DTE starts sending data
again. The above procedure for controlling the flow of data is called “flow control.”
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Error correction

During data transmissions, data errors occur for various reasons. In text data
such as a sentence, a minor error does not hinder the reader from presuming the
correct meaning in the context. In binary data such as a program, however, even
a small error is not permitted. For this reason, the sender previously adds
information used to detect any data error and if an error is found in the received
data, the receiver requests the sender to retransmit the data. This procedure
ensures the error-free transmission of data. It is called error corrections.

The 9.6K DATA offers the ARQ mode in which error corrections are made over
the satellite link and the non-ARQ mode in which no error correction is made. It is
optionally possible to tell the LES whether error corrections should be made over
the terrestrial link regardless of either of the above two modes.

Normally, error corrections should be made for both the satellite and terrestrial
links. In some cases, however, error corrections are not recommended. For
example, when files are transferred, data transfer protocols such as ZMODEM
are used and they make error corrections by themselves. This means that if error
corrections are also made over a link, the transfer throughput decreases because
of the dual error corrections. In such a case, the use of the non-ARQ mode is
rather recommended. In addition, it may be better to determine whether error
corrections should be made for each of the satellite and terrestrial links, in
accordance with the states of those links.

Terminal speed (DTE speed

A communication speed between the DTE and the MES. Data communications
occur at 9600 bps between the MES and the LES, but this speed is not always
applicable to the communications between the LES and a remote station. Since
error corrections and flow control are performed in the communications between
the MES and the LES and between the LES and a remote station, data is not
sent without them between the DTE and a remote station. Therefore, the
communication speed between terminals, that between the MES and the LES,
and that between the LES and a remote station do not need to be identical. A
given communication speed can be selected for communications with any remote
station.
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6.3 Considerations

Note: If the equipment does not function properly, restore default settings (9600
bps, 8 bit, no parity, 1 stop bit) by pressing [FUNC Quit], [9], [6], [8] and [2]
at the handset. Note however that this procedure restores all default
settings and clears the non-volatile memory. For this reason you may want
to record settings before restoring default settings.

* The state of a data communication varies depending on the following factors,
some of which are influenced by the time zone of the communication, the LES
used, and the remote station connected, or change with each call:

e State of the satellite link

» State of the terrestrial link (delay due to routing; congestion of line; line
state; etc.)

» Settings of the MES, and the terminal and modem of the remote station
» Compatibility between the modem of the LES and that of the remote station

* Responsiveness and other similar characteristics of the DTE of the MES
and a terminal (e.g., a computer) of the remote station.

Therefore, the data transmission speed may become slower depending on the
call, or the call may be even aborted. If this occurs, retry the communication. In
some cases, you may need to change the settings of the MES and the remote
station.
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6.4
6.4.1

6.4.2

6-6

Preparations for Communications

Procedure for initial setup

Initialize non-volatile memory/set default settings of comm. parameters

From the DTE, input the command AT&F&W, <CR>(Enter or Return depending
on the PC). DTE appears when the equipment is initialized.

Resetting the communication parameters

When using the communications parameters stored in non-volatile memory:

1. Let the DTE operate as a communication terminal.

2. Enter “ATZ<CR>" via the DTE. When the DTE screen shows “OK,” the initial
setup of the communication parameters is now completed. Depending on your
application, this process can be automatically carried out every time a
communication is started. In this case, you do not need to perform this step.

Setting the communication parameters

For detailed information on each command, see paragraph 5.9 AT Commands.
Subsequently, the initial values are indicated in parentheses.

Communication format

AT+ICF (AT+ICF=3,3: 8-bit data; no parity; 1 stop bit)
Sets the format between the DTE and the MES

AT+WRATE (AT+WRATE=9600,9600)
Sets the maximum data rate for the satellite link and that
for the terrestrial link.
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Flow control

AT+IFC

AT+WRTL

AT+WTTL

Error correction

AT+WS45

AT+WKSIZE

Break signal
AT\K

Signal line control
AT&C

AT&D

AT&S

6. 9.6k DATA COMMUNICATIONS

(AT+IFC=2,2: DTE - DCE = hardware control flow; DCE
DTE = hardware control flow)
Sets the flow control between the DTE and the MES.

(AT+WRTI=120,240: Lower limit = 120; Upper limit: 240)
Sets the limits of the reception buffer for the flow control.

(AT+WTTL=120,240: Lower limit = 120; Upper limit = 240)
Sets the limits of the transmit buffer for the flow control.

(AT+WS45=1; Satellite link = With ARQ; Terrestrial link =
With error corrections)

Sets whether error corrections are made for the satellite
and terrestrial links.

(AT+WKSIZE=25)

Sets the ARQ window size for communications in the ARQ
mode.

(AT\K1: Clears the transmit and reception buffers and
sends the break signal)

Specifies the action that occurs when the break signal is
received.

(AT&CL1: Changes depending on the connection states)
Specifies the behavior of the CD (DCD) signal.

(AT&D2: Disconnects the signal line if its status changes
from ON to OFF)
Specifies the behavior of the ER (DTR) signal.

(AT&S1: Changes depending on the connection states)
Specifies the behavior of the DR (DSR) signal.

Display of command and result codes

ATE

ATQ

(ATEZL: With echo back)
Specifies whether the received command character string
is echoed back.

(ATQO: Returns a result code)
Sets whether a result code is returned.
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ATV (ATV1: Word format)
Specifies the format for result codes

ATX (ATX4: Displays the communication speed)
Sets whether the communication speed is displayed at
connection.

AT+WXR (AT+WXR=0: Without extended display)
Chooses the extended display of the CONNECT result
code.

Settings for Inmarsat communications

AT+WLES (AT+WLES=000: Stores LES access codes in memory)
Stores LES access codes in memory and display the
currently stored ones.

AT+WOR (Sea area specified with telephone and facsimile
terminals)
Displays the currently specified sea area and changes it.

AT+WS46 (AT+WS46=11: Uses the Inmarsat system)
Chooses the use of the Inmarsat system.

Note: The optimal values vary depending on the contents of communications,
remote stations, and the states of lines. Change the settings according to
the states of communications and store the modified values in the non-
volatile memory.

Some communication software can automatically store the settings. If such
software is used, you do not need to store the modified values in the non-
volatile memory.

A sudden failure or a similar event may cause the data in the non-volatile
memory to be lost (if the data is lost, the non-volatile memory is reset to the
values set at the factory). The non-volatile memory is located on the CPU2
circuit board. Therefore, if the circuit board is replaced, your own settings
must be stored again in the memory. For this reason, be sure to write down
the values you have stored in the memory. Your data stored in the non-
volatile memory is not covered by our warranty.
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Setting up the communication software

The setup procedure varies depending on the communication software used.
This section only mentions the points you should give attention to.

Number of remote stations

If an LES is specified with the +WLES command, do not specify an LES number.
If not, specify this number including an LES number.

Communication format

This format varies depending on the remote station you are connecting to.
Properly set the communication format according to that station.

Flow control

In principle, set this parameter to the hardware control (CTS/RTS). Choose the
software control (XON/XOFF) if necessary, e.g., when the hardware control
cannot be used by the terminal.

Note: For further information, refer to the instruction manual of the
communication software.
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6.5.4
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Starting and Finishing a Communication

Changing the sea area

Specify a sea area using the +WOR command.

For example, to change the sea area to the Pacific Ocean:
AT+WOR=2(sea area, see below for key)<CR>

0: Auto
1. AOR-E
2: POR
3:I0R
4: AOR-W

Changing the communication parameters

According to the contents of communications, remote stations, and the states of
lines, change the settings as necessary.

Outgoing calls

Specify the number of the remote station using the D command, and then make a
call.

For example, to call 123456789 in Japan for an automatic connection via the LES
of 003:

1. If no LES is specified (when AT+WLES=000), enter: ATD003-00-81-
123456789<CR>
2. If +WLES=003 is previously specified, enter: ATD00-81-123456789<CR>.

Incoming calls

If a call is received, the DTE screen shows “RING.”

1. Ifacallis received in the automatic reception mode (when register SO is set to
non-zero), the reception sequence is automatically started.

2. In the manual reception mode (when register SO is set to zero), enter
“ATA<CR>" after confirming the arrival of a call. The reception sequence is
started.
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6.5.5

Finishing a communication

Disconnection by the remote station

The satellite link is disconnected with “NO CARRIER” displayed. A different
message may be displayed depending on your communication software.

Disconnection by the MES
To finish the communication at the MES:

1. Use the ER (DTR) signal to disconnect the communication line.
a) Set up the MES and communication software beforehand as follows:
1- Set up the MES so that the line is disconnected with the AT&D2 {ER (DTR)}
signal.
2- Set up the communication software so that the line is disconnected with the
ER (DTR) signal.
b) If the line is disconnected with the communication software during a

communication, the communication can be finished.
2. Go to the on-line command mode with the break signal and then use the ATH

command.
a) Previously set up the MES as follows:
1- Using the AT\K command (to choose the break signal processing), set up
the MES so that it enters the on-line command mode with the break signal.
b) Send the break signal from the communication software.
¢) The MES enters the on-line command mode.
d) Enter the ATH command from the communication software. The
communication is finished.

Note: The first procedure is recommended.
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Viewing the State of MES

View a program name and number:

AT+GMI Displays a manufacturer name
AT+GMM Displays an equipment name
AT+GMR Displays a program version number.

View various settings stored in the non-volatile memory:

AT&V Displays the contents of the non-volatile
memory.

Find the details of an error that has occurred:

AT+WQ Displays the details of the error when OK
or CONNECT is not displayed (when
ERROR or NO CARRIER is shown).

View the brief description of a command:

AT&H Displays a list of commands.

View other states:

AT+GCAP Displays the class of the extended AT
command set.
AT+W Displays the command extension system

for the +W command set.
AT+WINMARSAT Displays a list of commands that have
been added by Inmarsat.
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6.7.1
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AT Commands

What are the AT commands?

They are model control commands that were developed by Hayes, a modem
manufacturer in the United States. At present, the AT commands are adopted in a
large number of modems for use with general telephone lines. The AT commands
are named as such because a character string, “AT” (meaning “attention”) is
prefixed to each of them.

The AT commands that can be used by the MES include:

* Basic commands (same as the commands that are generally used in most of
the modems)
* Extended commands (commands added for Inmarsat)

The data corrections and data compression (MNP, V42, and V.42bis) as used
over telephone lines are not used on any satellite channel. Therefore, there is no
command available for them.

To enter a command, prefix “AT” to it like “ATA” and “ATEQ” (except “A/"). Except
for some specific commands, you may want to describe multiple commands on a
single line, like “ATV1QO0.” A different command may be placed immediately after
any basic command. However, a character “;” must be placed immediately after
any extended command.

Any command parameter enclosed in brackets ([ ]) may be omitted. If it is omitted,
the default value is assumed.

Note 1: Any parameter included in a command followed by (%) may be stored in
the non-volatile memory.

Note 2: In principle, the commands that were specified in the SDM by Inmarsat
are employed, but some of the added and omitted commands or
parameters are different because of reasons related to the specification
of equipment.
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6.7.2 Basic AT commands
Command Description
A Forcibly puts the MES in the ANSWER mode.
If this command is entered when a call arrives, the connection sequence is started.
e.g.. ATA<CR>
A/ Executes the just previously entered command again.
This command is independently used without entering "AT."
You do not need to enter <CR> after "/."
e.g.:
ATxxxxxxxxxxxx (just previously entered command) (i)
A/
The command in (i) is executed again.
D Sends a call to a remote station with the specified number.
D[dialed character string>]
The following characters may be used for the dialed character string:
0-9 Used to specify the telephone number of a remote station.
()and - Used to delimit the telephone number.
# Used to indicate the end of the telephone number (may be omitted).
; Used to return to the command mode after dialing.
e.g.. 1.ATDO003-00-81-123456789%# (when AT+WLES=000)
123456789 in Japan is dialed for automatic connection via the LES of 003.
2. ATD00-81-123456789 (when AT+WLES is not 000)
The number is dialed via the LES specified with the +WLES command.
The tailing character "#" may be omitted.
3. ATD003-00-81-123456789%#;
This is the same as the above 1, except that the MES returns to the com-
mand mode after the number is dialed.
Specifies whether the received command character string is echoed back.
Ea E[<n>]
n=0 Not echoed back
n=1 Echoed back
* If <n> is omitted, it is assumed as "1."
e.g.. ATE1<CR>
Disconnects the connected line.
H H[<n>]
Disconnects the connected data line. If a telephone or facsimile ma-
n=0 chine is in use, its communication cannot be cut off. (To cut off the
communication, the MES must be in the on-line command mode.)
n=1 Does nothing.
«If <n> is omitted, it is assumed as "0."
e.g.. ATH<CR>
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Command Description

(0] Causes the MES to go from the on-line command mode to the off-line data mode.

e.g. ATO<CR>

Qa Sets whether a result code is returned.
Q[<n>]
n=0 The MES returns a result code.
n=1 The MES does not return a result code.

« If <n> is omitted, it is assumed as "0."
« If the Q1 command is used, no result code is returned for the subsequent com-
mands.

e.g.. ATQO<CR>

S Stores a value in an S register or reads data from it.
For further information, see the section "S Registers."

e.g.. 1.ATS3=13<CR>: Stores "13" in register S3.
2. ATS3?<CR>:  Displays the contents of register S3.

VA Specifies the format for a result code.
V[<n>]
n=0 Displays a result code in the numeric format.
n=1 Displays a result code in the word format.

* |f <n> is omitted, it is assumed as "1."

e.g.. ATV1<CR>

XA Specifies whether the communication speed (plus BUSY/NO DIALTONE) is displayed.
X[<n>]
n=0 Does not display the communication speed (plus BUSY/NO DIA-
LTONE) when a communication is established.
Displays the communication speed (plus BUSY/NO DIALTONE)
n=1-4 when a communication is established.
* |f <n> is omitted, it is assumed as "4."

e.g.. ATX4<CR>

Z Initializes the command parameters.
The parameters stored in the non-volatile memory are initialized with its initial values.

e.g.. ATZ<CR>
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Command

Description

&Ca

Specifies the behavior of CD (DCD) signal.

&C[<n>]
n=0 The CD signal is always ON.
n=1 The CD signal varies depending on how the MES is connected to the
LES

* If <n> is omitted, it is assumed as 1.

e.g.. AT&C1<CR>

&D a

Specifies the behavior of the ER (DTR) signal.

&D[<n>]
n=0 Ignores the ER signal.
n=1 If the ER signal changes from ON to OFF during a connection, the
MES returns to the on-line command mode.
n=2 If the ER signal changes from ON to OFF during a connection, the

line is disconnected.
* If <n> is omitted, it is assumed as 2.

e.g.. AT&D2<CR>

&F

Initializes the command parameters.

All of the parameters are initialized to the values set at the factory. However, the con-
tents of the non-volatile memory remain unchanged. (To initialize the contents of the
non-volatile memory, enter the AT&F command and then enter AT&W.)

e.g.. AT&F<CR>

&H

Displays a list of commands.

&H[<n>]
n=0 Displays a list of basic commands.
n=1 Displays a list of extended commands.
n=2 Displays a list of values in the S registers.

« If <n> is omitted, it is assumed as 0.

e.g.. AT&H1<CR>

&S a

Specifies the behavior of the DR (DSR) signal.

&S[<n>]
n=0 Always keeps the DR signal ON.
n=1 Follows the sequence of the communication protocol.
n=2 Follows the CD signals.

* If <n> is omitted, it is assumed as 1.

e.g.. AT&S1<CR>

&V

Displays the contents of the non-volatile memory.

e.g.. AT&V<CR>

&W

Stores the currently set parameters in the non-volatile memory.

Note: Ensure that the power never be turned OFF for approximately 10 seconds after
this command is executed. Otherwise, the data may not be successfully written to
the non-volatile memory.

Note: If the parameters stored in the non-volatile memory are not correct when the
power is turned ON, they are reset to the values set at the factory.
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Command | Description

\Ka Specifies the action that occurs when the break signal is received.
\K[<n>]
n=0,1 Clears the data in the transmit/reception buffer and sends the break
signal.
n=2,3 Skips the data in the buffer and takes priority in sending the break
signal.
When n=0,2, the MES sends the break signal and then enters the on-line com-
mand mode.

« If <n> is omitted, it is assumed as "1."

e.g.. AT\K1<CR>

\Qa Sets the flow control between the DTE and the MES (further detailed settings can be
made using the +IFC command).
\Q[<n>]
n=0 No flow control (equivalent to +IFCO0,0)
n=1 XON/XOFF flow control (equivalent to +IFC1,1)
n=2 RS/CS flow control (equivalent to +IFC2,2)
n=3 CS flow control (equivalent to +IFC0,2)

n=4 Mono-directional XON/XOFF flow control (equivalent to +IFCO0,1)
« |f <n> is omitted, it is assumed as "2."

e.g.:. AT\Q1<CR>
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Extended AT commands

Command

Description

+GCAP

Displays the class of extended AT command set supported by the MES.
+GCAP
+GCAP="?

Once this command is accepted, the following character string is displayed:
+GCAP: +W

e.g.. AT+GCAP<CR>

+GMI:

Displays a manufacturer name.

Once this command is accepted, the following character string is displayed:
FURUNO Electric Co., Ltd. Copyright(C) 1996-97 All rights reserved.

e.g.. AT+GMI<CR>

+GMM

Displays an equipment name.

Once this command is accepted, the following character string is displayed:
FELCOM 81, Inmarsat-B Mobile Earth Station

e.g.. AT+GMM<CR>
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Command

Description

+GMR

Displays a program version number.

e.g.. AT+GMR<CR>

+ICF A

Sets the communication formation between the DTE and the MES.

+ICF=[<format>[,<parity>]]
format=3  8-bit data; without parity; 1 stop bit
format=4  7-bit data; without parity; 2 stop bits
format=5  7-bit data; with parity; 1 stop bit
* If <format> is omitted, it is assumed as "3."

parity=0 Odd-number parity

parity=1 Even-number parity

parity=3 Space parity

« If <parity> is omitted, it is assumed as "3."
+ICF?

« Displays the currently set value as follows:

+|CF:<format>,<parity>

+ICF=?

« Displays the effective ranges of parameters for this command as follows:

+ICF: (3-5), (0,1,3)

e.g.. AT+ICF=3,0<CR>

+IFCa

Sets the flow control between the DTE and the MES.
+|FC=[<DTE - DCE>[,<DCE - DTE>]]

<DTE - DCE> specifies how the data transmission from the DCE is controlled by

the DTE.
DTE -~ DCE=0 Does not perform the flow control.

DTE - DCE=1 Performs the flow control with DC1(XON)/DC3(XOFF). DC1/DC3

is not transmitted to the LES.
DTE -~ DCE=2 Performs the flow control with RFR(RTS).

DTE - DCE=3 Performs the flow control with DC1(XON)/DC3(XOFF). DC1/DC3

is transmitted to the LES.
« If <DTE - DCE> is omitted, it is assumed as "2."

<DCE - DTE> specifies how the data transmission from the DTE is controlled by

the DCE.
DCE - DTE=0 Does not perform the flow control.

DCE - DTE=1 Performs the flow control with DC1(XON)/DC3(XOFF).

DCE - DTE=2 Performs the flow control with CTS.
* If <DCE - DTE> is omitted, it is assumed as "2."
+IFC?
« Displays the currently set value as follows:
+IFC: DTE -~ DCE, DCE - DTE
+IFC=?

« Displays the effective ranges of parameters for this command as follows:

+IFC: (0-3),(0-2)

e.g.. AT+IFC=2,2<CR>
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Command Description
+IPR A Sets the communication speed (fixed speed at the DTE) between the DTE and the
MES).
+IPR=[<n>]
n=1200 Sets 1200 bps.
n=2400 Sets 2400 bps.
n=4800 Sets 4800 bps.
n=9600 Sets 9600 bps.
n=14400 Sets 14400 bps.
n=19200 Sets 19200 bps.
« If <n> is omitted, it is assumed as "9600."
+IPR?
« Displays the currently set value as follows:
+IPR: n
+IPR=?
« Displays the effective ranges of parameters for this command as follows:
+IPR: (1200, 2400, 4800, 9600, 14400, 19200)
e.g.. AT+IPR=0<CR>
+W Displays the command extension system supported by the MES.
+W
+W=?
Once this command is accepted, the following character string is displayed:
"101", "+WINMARSAT"
e.g.. AT+W<CR>
+WINMAR | Displays a list of the commands in the +W<text> format, which have been added by
SAT Inmarsat.
+WINMARSAT
+WINMARSAT="?
Once this command is accepted, the following character string is displayed:
|I+WKSIZEII’II+WLESI|,II+WORll,ll+WQII,II+WXRII’II+WRATEII,II+WRTL||,II+WTTL|I
e.g.. AT+WINMARSAT<CR>
+WKSIZE Sets the ARQ window size that is used for communications in the ARQ mode.
A Normally, this command requires no modification.
+WKSIZE=[<n>]
* Sets the ARW window size to "n."
* If <n> is omitted, it is assumed as "25."
+WKSIZE?
* Displays the currently set ARW window size as follows:
+WKSIZE: n
+WKSIZE="?
Displays the effective ranges of parameters for this command as follows:
+WKSIZE: (1-63)
e.g.. AT+WKSIZE=25<CR>
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Command | Description

+WLES A Stores the LESs access code used for a data call, in the MES.
+WLES=<nnn>

« Specifies the LES whose access code is <nnn>. If any value other than 3-digit
one is entered, an error is generated.

¢ <nnn> cannot be omitted. If it is omitted, an error occurs.

« If "000" is entered, the leading three digits of the D command are assumed as
the LESs access code. If you enter any 3-digit value other than "000," you do
not need to specify the LESs access code in the D command. The access code
entered here is used.

+WLES?
* Displays the currently specified access code for the LES as follows:
+WES: nnn
+WLES=?

* No particular response is returned by the MES.

+WOR e.g.: AT+WLES=000<CR>

Changes the currently specified sea area or displays it.
+WOR[=<n>]
Enter a new sea area to <n> by choosing its value from:
0: The appropriate sea area is automatically chosen (Auto).
1: Eastern Atlantic Ocean (AOR-E)
2: Pacific Ocean (POR)
3: Indian Ocean (IOR)
4: Western Atlantic Ocean (AOR-W)
5-8:Currently not used (the sea area is not changed)
If <n> is omitted, the currently specified sea area is displayed as follows:

+WOR: n
+WOR=?
Displays the effective range of parameter for this command as follows:
+WOR: (0-8)

Note: The usage of this parameter differs from that in the SDM.

e.g.: AT+WOR=0<CR>
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Command | Description
+WQ Queries error information.
+WQ[=<n>]
* The following information is displayed in accordance with the just previous
result cord:
1. If the result code is NO CARRIER, BUSY, or NO ANSWER, a cause
code is displayed in the hexadecimal notation.
2. If the result codes is ERROR or NO DIAL TONE, an error state is
displayed in the decimal notation.
3. If the result code is OK, CONNECT, CONNECT<text>, or RING,
nothing is displayed.
« The following error information is displayed in accordance with the value for
<n>:
Decimal notation
<m> when n=0
+WQ: <m>,<text> when n=1
<m>: A value showing the error state
<text>: A text showing the error state
Hexadecimal notation
<XXXX> when n=0
+WQ: <xxxx>,<text> when n=1
<xxxx>: A cause code
<text>: A text showing the error state
* If <n> is omitted, it is assumed as "1."
* For the value for <m>, see the section for "Extended Error Codes"; for the value
for <xxxx>, see the section for "Cause Codes."
+WQ=?
Displays the effective ranges of parameters for this command as follows:
+WQ: (0,1)
e.g.. AT+WQ=1<CR>
+WRATE A | Sets the maximum data rate for the satellite link and that for the terrestrial link.
+WRATE=<sat_rate>[,<ter_rate>]
<sat_rate> Data rate for satellite link
<ter_rate> Maximum data rate for terrestrial link
* If <ter_rate> is omitted, it is assumed to be the same as <sat_rate>.
+WRATE?
« Displays the currently set data rate as follows:
+WRATE: sat_rate,ter_rate
+WRATE="?
Displays the effective ranges of parameters for this command as follows:
+WRATE: (9600),(1200-14400)
e.g.. AT+WRATE=9600,9600<CR>
+WRTLA | Sets the limits for the reception buffer, which are used for the flow control. Normally,
you do not need to set this parameter.
+WRTL=[<LOW>[,<high>]]
<low>  Value for lower limit (0-511)
<high>  Value for upper limit (1-512)
* If <high> is omitted, it is assumed to be <low>+120.
* If <low> is also omitted, it is assumed to be 120 with <high> assumed as 240.
« If any value that does not fall within the effective ranges is specified, an error is
generated regardless of whether that value is entered by the user or
automatically calculated as a default value. In this case, the previous value
remains valid.
+WRTL?
« Displays the currently set values as follows:
+WRTL: low, high
+WRTL="?
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Command Description

+WS45 A | Sets whether error corrections are made over the line.
+WS45=[<n>]
* Sets whether error corrections are made for the satellite and terrestrial links as

follows:
Value for <n> Satellite link Terrestrial link End-to-end
0 Without ARQ  Without error corrections NARQ
1 With ARQ With error corrections ARQ
200 Without ARQ  With error corrections NARQ
201 With ARQ Without error corrections NARQ

* |f <n> is omitted, it is assumed as "1."
The error corrections include those specified in ITU-T V.42 and others (such as
MNP) and differ depending on how they are used over the terrestrial link.

+WS45?
« Displays the currently set value as follows:
+WS45:n
+WS45="

« Displays the effective ranges of parameters for this command as follows:
+W8S45:(0,1,200,201)

e.g.: AT+WS45=1<CR>

+WS46 o | Specifies the radio system used. Normally, you do not need to set this parameter.
+WS46=<n>
Only 11 (showing Inmarsat) is valid for <n>. If you try to set this parameter to any
other value, an error is generated.
+WS46?
« Displays the currently set value as follows:
+WS46:11
+WS46="?
Displays the effective range of parameter for this command as follows:
+WS46:(11)

e.g.: AT+WS46=11<CR>
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Command | Description
+WTTL A Sets the limits for the transmit buffer, which are used for the flow control. Normally, you
do not need to set this parameter.
+WTTL=[<low>[,<high>]]
<low>  Value for lower limit (0-511)
<high>  Value for upper limit (1-512)
« If <high> is omitted, it is assumed to be <low> + 120.
« If <low> is also omitted, it is assumed to be 120 with <high> assumed as 240.
« If any value that does not fall within the effective ranges is specified, an error is
generated regardless of whether that value is entered by the user or
automatically calculated as a default value. In this case, the previous value
remains valid.
+WTTL?
* Displays the currently set values as follows:
+WTTL: low, high
+WTTL="?
Displays the effective ranges of parameters for this command as follows:
+WTTL: (0-511),(1-512)
e.g.. AT+WTTL=120,240<CR>
+WXR A Sets the extended display of the CONNECT result code.

+WXR=[<n>
Value for <n> Extended information Display of CONNECT result code
0 None CONNECT <DTE-DCE rate>
1 Included CONNECT <DTE-DCE rate>
2 None CONNECT <DCE-DCE rate><ARQNARQ>
3 None CONNECT <DCE-DCE rate>

* If <n> is omitted, it is assumed as "0."

* <DTE-DCE rate> shows the terminal speed at the MES.

* <DCE-DCE rate> shows whichever smaller value of the communication speed
from the MES to the LES and that from the LES to the remote station.

» For <ARQ|NARQ>, see the description of the +WS45 command.

* If INCLUDED is chosen for the extended information, the following information
is displayed when a communication is established:

+WXSR: <rate>,<ec> State of satellite link
+WXTR: <rate>,<ec> State of terrestrial link
+WXKR: <k> ARQ window size

CONNECT <DTE-DCE rate>
« <rate> shows each communication speed and <ec> whether error corrections
are made.
« This is only valid when you specify Q0, V1, or X1 that causes "CONNECT" to
be indicated.
+WXR?
* Displays the currently set value for <n> as follows:
+WXR: n
+WXR="?
* Displays the effective range of parameter for this command as follows:
+WXR: (0-3)
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6.8 S Registers
ATSm=<n>
» Stores the value “n” in the S register located in the “m”th
position.
ATSmM?
* Reads the value from the S register located in the “m”th
position.
Register name Description Initial value
Specifies whether an incoming call is automatically accepted.
SOa Setting range: 0 Not automatically accepted 0
1-255 Automatically accepted

S1 (Reserved) -

S2 (Reserved) -
S3a Specifies a CR code. 13

Setting range: 0-127
S4a Spegzltfii: r:FnSZde 0-127 10
ifi B .

So4 :Z’z;gersar?gezs 7 0-32, 127 8

S6 (Reserved) -

S7 (Reserved) -

S8 (Reserved) -
S10 (Reserved) -
S12 (Reserved) -

Note: Do not modify any value stored in the reserved S registers and the S
registers that are not listed here. The operation under any modified value is
not covered by our warranty.
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6.9 Result Codes
Result codes are used to represent responses to a command from the DTE or the
states of the MES. They are shown in the word or numeric format, which can be
specified with the V command. The meanings of result codes are listed below:
Word format Numeric Meaning +WQ command
format response
OK 0 The communication procedure has been successfully None
completed.
CONNECT 1 The line has been connected. None
RING 2 The incoming call has been displayed. None
The line has been cut off (the connection has not been Cause code
NO CARRIER 3 successfully completed or the communication has been :
- (hexadecimal)
finished).
ERROR 4 Command error Extended error code
NO DIALTONE 6 The outgoing call has failed. Extended error code
7 The line is busy (e.g., a telephone or facsimile machine is in Cause code
BUSY L .
use or the remote station is busy). (hexadecimal)
NO ANSWER 8 No response has been returned to the attempted outgoing Cause cpde
call. (hexadecimal)
CONNECT 1200 5 The communication has been established at 1200 bps. None
CONNECT 1200 ARQ 5 ;r:)ed ;:;)mmumcatlon has been established at 1200 bps. (ARQ None
CONNECT 2400 10 The communication has been established at 2400 bps. None
CONNECT 2400 ARQ 10 'r;r;z:)ommumcanon has been established at 2400 bps. (ARQ None
CONNECT 4800 1 The communication has been established at 4800 bps. None
CONNECT 4800 ARQ 11 ;r;z :)ommunlcatlon has been established at 4800 bps. (ARQ None
CONNECT 9600 12 The communication has been established at 9600 bps. None
CONNECT 9600 ARQ 12 ;r:; ;:)ommumcatlon has been established at 9600 bps. (ARQ None
CONNECT 19200 20 The communication has been established at 19200 bps. None
CONNECT 19200 ARQ 20 ;r;zz;)mmumcatlon has been established at 19200 bps. (ARQ None
CONNECT 38400 21 The communication has been established at 38400 bps. None
CONNECT 38400 ARQ 21 'rl;]r;e(:j ngmumcatlon has been established at 38400 bps. (ARQ None
CONNECT 1200 NARQ 30 The communication has been established at 1200 bps. (non- None
ARQ mode)
CONNECT 2400 NARQ 31 The communication has been established at 2400 bps. (non- None
ARQ mode)
CONNECT 4800 NARQ 32 The communication has been established at 4800 bps. (non- None
ARQ mode)
CONNECT 9600 NARQ 3 The communication has been established at 9600 bps. (non- None
ARQ mode)
CONNECT 19200 NARQ 4 The communication has been established at 19200 bps. None
(non-ARQ mode)
CONNECT 38400 NARQ 35 The communication has been established at 38400 bps. None
(non-ARQ mode)
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6.10 +WQ Cause Codes
Cause codes are used to indicate the states of communications. They are sent by
the LES. If the NO CARRIER, BUSY, or NO ANSWER result code is generated,
its details can be displayed with the +WQ command.
6.11 +WQ Extended Error Codes
Extended error codes are used to show the details of any error that has occurred
(with the ERROR or NO DIALTONE result code generated). The details of the
error can be displayed using the +WQ command. The values and meanings of
extended error codes are listed below:
Value Text Meaning

100 syntax error There is a syntax error in the command line.

101 invalid parameter There is an invalid parameter in the command line.

102 missing mandatory parameter There is a missing parameter in the command line.

103 too many parameters There are too many parameters in the command line.

104 invalid parameter length The length of any parameter is invalid (+WLES, +WTNID).

200 facility unavailable The entered command is unavailable.

201 no call announcement An A command has been entered when there is no incoming call.

202 not connected The data communication failed afteran O command was entered.

The MES is busy (e.g., a telephone is in use or the MES is not

300 G synchronous with trile EI'DSIJ\/I) p

301 MES unavailable The MES is not properly functioning.

302 MES not responding There is no response from the MES.

400 satellite not found The MES has failed in synchronizing with the NCS TDM in the sea area.

401 invalid LES The MES has failed in accessing the specified LES.

402 invalid TNID The MES has failed in accessing the specified TNID.

1000 Reserved.

2000 Reserved.
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7.

HSD COMMUNICATIONS

This section provides the setting information for operation of an HSD (High
Speed Data) Terminal. A computer fitted with an HSD interface is required. An
HSD Terminal communicates over land ISDN line and Inmarsat MES, at 64 kbps
or 56 kbps (USA). The HSD Terminal can be used to access the internet, send
digital images, teleconferencing, remote medical assistance, etc. For
communication procedures see the owners manual of the HSD interface.

This manual discusses the HSD Terminal contained in the HSD Interface. For
communication settings and operation refer to the manual for the HSD I/F
Terminal and Router.

Connecting a single PC as in the figure below you can connect to a subscriber
much easier than by using a dial-up router.

Pg Satellite PPP supported
IKIasHoééer FELCOM 82 |- - Line/ [~"1 — — Terminal
(Windows 95/98/NT) Land Line outer

internal HSD I/F Interface (option)
KlasHopper MCMCIA400 or PCI-400)

HSD configuration with TA/Router
This configuration offers these advantages:

* PPP (Point-to-Point Protocol) supported. Therefore, KlasHopper is not required
at the receiving end. You can connect to an internet service provider with an
ordinary modem or terminal adapter.

* Web browser, mail software may be used.
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7.1 HSD Setup

This procedure is done from the Administration mode. See page 2-10 for how to
choose the Administration mode.

1. Press [FUNC Quit] and [8] to select the HSD menu.

8HSD 8HSD 8HSD

v A A
1Dest. No mmee a5 AUt O Rat e e @9 Pri nt HSD
2Call TEL 6 Command
3Data Rate 7Char acter
4Di al Method <+—— |8l gnore DTR B —
Select: [ Ent] Select: [ Ent] Select: [ Ent]

HSD menu

2. Press appropriate numeric key to select item desired.
3. Press the [FUNC Quit] key several times to close the menu.

Destination No.

For direct call key in subscriber’s complete ISDN number, beginning with LES
number. Maximum 20 digits may be used. Prefix dialing cannot be used.

81Dest. No.

Enter: [ Ent]

HSD menu, destination no. input screen

Call TEL
Chooses the handset or telephone to use for HSD calling. The default setting is
Handset.

82Call TEL

1 TEL1

2 TEL2

3 TELS3

Enter: [ Ent]

HSD menu, Call telephone selection screen
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Data Rate

Choose the data rate from 64k (Japan, Europe) and 56k (USA). The default
setting is 64k. Confirm data rate of subscriber before setting.

83Dat a Rat e

1 64Kk
2 56k

Enter: [ Ent]

HSD menu, data rate selection screen
Dial Method

Choose the dial method from Direct (DTR) and Address (V.25bis). The default
setting is Direct.

Direct means direct call. When the HSD Terminal turns on communications
begins with party registered on the HSD menu. The owner’s manual for the HSD
Interface refers to Direct Dial as “Hot Dial.”

Address means address call. Calling begins after specifying subscriber (CRN
command) at the HSD Terminal. The owner’s manual for the HSD Interface
refers to Address as “V.25bis Dial.”

84 Di al Met hod

1 DI RECT
2 ADDRESS

Enter: [ Ent]

HSD menu, dial method selection screen
Auto Rate

Auto Rate determines whether or not to receive an HSD call whose data rate is
different from that set on the HSD menu. The default is OFF which prevents
receiving. Use the OFF setting for an HSD Terminal which cannot automatically
adjust its synchro clock to match data rate.

85Aut o Rate

1 OFF
2 ON

Enter: [ Ent]

HSD menu, auto rate selection screen
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Command (format)

Set the V.25bis command format for address calls sent from the HSD Terminal to
the FELCOM 82. Select HDLC (default setting) or BSC depending on
specifications of the HSD Terminal.

86 Command

1 HDLC
2 BSC

Enter: [ Ent]

HSD menu, command format selection screen
Character (format)

Choose the character format for address calls sent from the HSD Terminal to the
FELCOM 82. Select 8bit (default setting) or 7bit depending on specifications of
the HSD Terminal.

87Character

1 8bit/ None
2 7bit/ Odd

Enter: [ Ent]

HSD menu, character format selection screen
Ignore DTR

Choose whether the HSD terminal (router, etc.) from which to receive an
address call outputs the DTR signal or not. Choose “Normal” (default setting) for
HSD terminal which outputs the DTR signal; “Ignore” for HSD terminal which
does not output the DTR signal.

88l gnore DTR

2 lgnore

Enter: [ Ent]

HSD menu, ignore DTR selection screen
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7.2.1

71.2.2

7. HSD COMMUNICATIONS

Automatic HSD Call

How to make an automatic HSD call

Two types of automatic HSD calling are available: direct call and address call.
You can select the calling method from 4 Dial Method on the HSD menu, and the
default setting is direct call.

Direct call (Hot dial

A single subscriber’s ISDN number is preregistered at the handset.
Communications begin when subscriber’'s number is dialed from the HSD
Terminal. For further information see the owner’s manual for the HSD Terminal.

The FELCOM 82 begins processing an HSD call when it receives the DTR ON
signal from the HSD Terminal.

Address call (V25.bis dial)

For HSD communications with multiple subscribers, subscriber's number is
entered from the HSD Terminal to call.

Calling begins when the FELCOM 82 receives the CRN command.
“CRNxxxxx": CRN is a V.25bis command, xxxxx is a subscriber’'s number

When an HSD communications line is connected, the terminal unit status
displays RX C/H (HSD), RX IF AGC Level (HSD), and 2" Local (HSD).

How to clear an automatic HSD call
Clearing by caller

The line with the subscriber is cleared when the HSD Terminal turns off DTR,
which starts the call clearing sequence. When DTR goes off the FELCOM 82
sends the clear signal to the LES and the HSD modem in the communication unit
of the FELCOM 82 turns off DCD, CTS and DSR.

Clearing by callee

When the callee clears an HSD call, the LES sends the clear signal to the callee’s
HSD Terminal. The HSD modem in the communication unit of the FELCOM 82
turns off DSC, CTS, DSR. The HSD Terminal, in response to the DSR signal,
turns off DTR.
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7.3 Manual HSD Call
7.3.1 Manual HSD call

Dial HSD number manually when you cannot make an HSD call by direct call or
address call.

Using the telephone selected from “Call TEL” of the HSD menu, dial as follows:

Manual HSD call from the handset

1. Press the [ABBR Find] and [*] keys to show the ABBR MENU.
ABBR MENU

2Edi t

3Remove
4HSD Cal l
Select: [ Ent]

ABBR MENU

Note: 1 Entry, 2 Edit and 3 Remove may not be displayed depending on
abbreviated dialing setting.

2. Press the [4] key to select 4 HSD Call.
HSD CALL

Dat aRate: 64k
Call: OFFHOOK
Enter: [Ent]

HSD number input screen

3. Dial subscriber’'s complete number. To change data rate go to step 4,
otherwise got to step 6.
*55*
*56* aaa 00 bb XXXXXXXXX#
| I Subscriber’'s Number
Country Code
Automatic Dialing
Land Earth Station (LES)
Prefix for HSD Call#
55: 56 Kbps
56: 64 Kbps

# Not necessary when
dialing from handset.

Dialing sequence for manual HSD call

4. Press the [>] key.
5. Press [(] or [] to select appropriate data rate to 56 kbps or 64 kbps,
respectively.
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Note: To cancel an HSD call in progress, press [ABBR FIND], [*], [4] and
[Ent] key.

6. Press the [@m] key to start the call.
7. Operate the HSD Terminal to transmit data.

7.3.2 Manually clearing HSD connection

Using the telephone selected from “Call TEL” of the HSD menu, dial [*], [5], [9],
[#].


http://www.reelschematic.com

/. HSD COMMUNICATIONS

7.4

7-8

Receiving an HSD Call

When an HSD call is received the equipment normally answers it automatically.
Note: Some HSD terminals cannot receive.
The internal HSD interface

Direct call

The HSD Terminal uses the DTR signal to respond to received HSD call. DTR is
off when the equipment is idle. When a call arrives, the FELCOM 82 turns on RI.
The HSD Terminal detects the RI signal and turns on DTR. This causes the
FELCOM 82 to turn off Rl and turn on DSR, CTS, DCD, to communicate over
land line.

Address call

DTR is not used in receiving an address call; the HSD Terminal uses it for
sending data, such as control commands, to the FELCOM 82. When an address
call arrives the HSD Terminal responds according to DTR state as below.

Address call and DTR ON

When an address call arrives, the FELCOM 82 turns off Rl and sends the
indication “INC” to the HSD Terminal. The FELCOM 82 starts receiving
processing five seconds after receiving “INC.” When processing is completed, RI
goes off and DSR, CTS, DCD go on, to communicate over land line.

The HSD Terminal may send the “DIC” command to the FELCOM 82 within five
seconds of receiving “INC,” telling the FELCOM 82 to stop receiving processing.
This is done in the case of overlapping calls. If this occurs while is call is being
relayed, the CIC command is sent to the FELCOM 82 to reinitiate processing.

Address call and DTR OFF

When an address call arrives, the FELCOM 82 turns on RI. This tells the HSD
Terminal to turn on DTR, which causes the FELCOM 82 to send “INC” to the
HSD Terminal to indicate it is receiving. The HSD Terminal then sends the CIC
command to the FELCOM 82 to tell it to start receiving processing. When
processing is completed, RI goes off and DSR, CTS, DCD go on, to
communicate over land line.

When the HSD Terminal sends DIC instead of CIC, the FELCOM 82 sends the
indication VAL to stop receiving processing. Furthermore, when the CRN
command or other three-character command is sent the FELCOM 82 sends the
indication INV.
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7.5 V.25bis Commands and Indications

The HSD Terminal controls the FELCOM 82 with commands and the FELCOM
82 directs the HSD Terminal with indications. These commands and indications
are as below.

V.25bis commands

7. HSD COMMUNICATIONS

Command

Description

CRNxx O 0O x

Subscriber number specified and called.
xx O O x Subscriber number (20 digits max.)

Useable characters: "0-9", " " (space), "-", "#"

""and "-" can be used to separate digits for clarity; they are not recognized as
part of subscriber's number.

"#" is recognized as end code (input is not mandatory).

"rot-"and "#" are not sent to CU.

Examples:

CRN0030081123456789 (Subscriber's number is 003081123456789)
CRNO0030081-12-345-6789 (Same number as above except "-" inserted for
clarity)
CRNO0030081 12-345-6789# (Same number as first number above except " ", "-"
inserted for clarity and " #" inserted to show end of
number)

DIC

Prevents automatic reply to received calls.

Cic

Allows automatic reply to received calls.

Consecutive commands cannot be accepted. Commands use IA5 characters.
Upper or lower case may be input, but case cannot be mixed.

V.25bis indications

Indication

Description

INC

Informs DTE of incoming call

INV

Informs of invalid command from terminal.

VAL

Informs of valid command from terminal.

CFlIxx

Informs of "Call failed reply" in response to CRN command.

XX (reason) ET: Subscriber is busy.
CB: Telephone/fax busy (CU is busy).

AB: Subscriber not replying ("Scr Vec Ack" not received).

RT: Subscriber's DTE is not answering (subscriber not connected).
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Usage Hints
Applications

HSD communications can be used for

« Network connection via TCP/IP router
« Sending digital images

- Sending large files

« Teleconferencing

« Voice coding

Communication with other makes of Inmarsat-B terminals

For communication over a network, HSD communications time may increase
depending on communications content. In this case, normal telephone and fax
communications are disabled (except distress), thus frequency of
communications and communications time must be carefully considered when
drawing up communications plans. If communications overlap one another, it may
be necessary to install an additional MES.

Landline

Most landlines use ISDN circuits, and rules of operation vary with country. Thus
several ISDN terminals may be necessary.

Circuit delay

Most landlines uses ISDN circuits. Since the rules and regulations for ISDN vary
with country use the appropriate ISDN terminal.

Propagation delay

A delay of 240 msec exists on the satellite circuit line between the MES and coast
earth station. A 100 msec delay occurs in Tx processing and Rx. Furthermore, a
propagation delay may occur on the landline between the land terminal and coast
earth station depending on the distance between them.

Line delay

A delay of about 15-20 seconds occurs on transmission of file from an HSD
Terminal to coast earth station.
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TCPI/IP protocol

7. HSD COMMUNICATIONS

* When throughput is slow due to propagation delay, enlarge the size of the TCP
window to compensate for the delay. TCP size setting depends on protocol
stack and OS. Consult respective operator's manual for advice.

* When using a remote router, raising the communications cue (buffer) setting
can speed up throughput time. However, in some cases it may be necessary
for the ship and land terminals to have the same router. Some routers cannot
be used for Inmarsat HSD communications, especially those which cannot
accommodate circuits which have large propagation delay. Consult with router
maker and dealer to determine suitable router.

* For further details consult the network manager.

Router setting for network connection example

Name

Maker

Router

CISCO 1601

CISCO SYSTEMS (USA)

|IOS Software

SFC-1601C-11.33 | CISCO SYSTEMS (USA)

Cable CAB-449MT CISCO SYSTEMS (USA)
FELCOM 82
Communication Unit
IB-282 - | Router |10BASE-T
HSD ] CISCO 1601 ToLAN

Router connection

Router setting for network connection

Setting for CISCO1601 (DTR dial-up)
Set subscriber number as *51* ... #
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cisco1611#sh conf
version 11.3
service udp-small-servers
service tcp-small-servers
!
hostname cisco1601
!
enable password *****
!
username land-term password 0 *****
!
interface EthernetO
ip address 192.168.2.1 255.255.255.0
!
interface SerialO
ip address 192.168.10.10 255.255.255.0
encapsulation ppp
no keepalive
dialer dtr
dialer-group 1
ppp authentication chap
!
ip classless
ip route 0.0.0.0 0.0.0.0 192.168.10.1
ip route 192.168.0.0 255.255.255.0 192.168.10.1
ip route 192.168.1.0 255.255.255.0 192.168.10.1
dialer-list 1 protocol ip permit
snmp-server community public RO
!
line con O
exec-timeout 0 0
line vty 0 4
password *****
login
!
end

ciscol1601#
This example shows only the minimum necessary settings for confirmation.

Further details can be obtained from a Cisco dealer or Cisco’s home page
(http://www.cisco.com). For other router see its operator’s manual.
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Network configuration

* Network configuration depends on application and number of terminals used.
Generally, setup is done on the user’s equipment.

» Setup depends on shipboard network and land network. For details contact the
network manager.

* We recommend that identification be exchanged between sender and receiver.
Where required use packet filtering and firewall.

* FURUNO will assume no responsibility for security-related problems.
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8.

MAINTENANCE,
TROUBLESHOOTING

8.1
8.1.1

/N WARNING

Do not open the equipment.

Hazardous voltage which can
cause electrical shock exists
inside the equipment. Only
qualified personnel should
work inside the equipment.

Maintenance
Checks

» Keep the units clean and dry at all times. Dust or dirt may be removed with a
soft, dry cloth. DO NOT use commercial cleaners. They may remove paint and
markings.

* The connector, cables and earth terminal on the rear panel of the
communication unit should be checked periodically for tightness and cleaned if
necessary.

* Check the cable between the communication unit and handset for damage and
rust. Clean if necessary.
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8.1.2

8.1.3

8-2

Replacement of battery

The CPU and AD Converter Boards in the communication unit are each fitted with
a lithium battery which stores data when the power is turned off.

The life of the battery is about five years. When the battery is completely dead the
contents of the communications log are erased. For this reason, note the date of
battery replacement and have the battery replaced (by a qualified technician) well
before its expected expiration.

Name Type Code No.
Lithium Battery CR1/2 8.L-F 000-103-769

Replacement of fuse

Afuse is on the AD Converter Board in the communication unit. If the fuse blows
the gyro signal will be lost. In this case “GYRO” flashes on the handset,
regardless of whether the gyro signal is normal or the gyro is properly connected.
Have a qualified technician replace the fuse.

Name Type Code No.
Fuse FGMB 2A 250V | 000-122-000
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8.2  Checking Equipment Status

You can check equipment status, and print out the results, from the handset.

1. Press [FUNC Quit], [4], [1] to show the Monitor display. Scroll the display as
below with the [=] and [*] keys to view data.

41Monitor 41Monitaor

0 v LJAY
Heading 270 | =, |Tx EIRP 000
Az 119 Tx RF 000
El 30 Rx C/ N 053
LAT 34:00. 00N |«———|Rx I F AGC 154
LON135: 00.00E
41Monitor 41Monitor

OA DAV
Rx Synth OK | <«-—| ANT REMOTE
Tx Synth OK ElI AXxi s oK
Rx Ch 06000 Az Axi s OK
Tx Ch 10000 Cross EI OK

Monitor display

2. To print the contents of the monitor displays, press the [Hold Prt] key. A
sample printout is shown below.

——————— 41 Monitor <2000-06-20 00:00(UTC) > -------mmmmmm e e e oo oo
Current Satellite POR Tx El RP Level 000
Channel Status SYNC @ Tx RF Level 000
MES St at us Ready Rx C'N 053

Rx I F AGC Level 154
Headi ng 270 DEG
@ Ant enna Beari ng 209 DEG @ Rx Synt hesi zer (04
Ant enna Azi nut h 119 DEG Tx Synt hesi zer (04
Ant enna El evati on 30 DEG
Ant enna St at us REMOTE
@{Posi tion LAT 34:00. 00N @ El AXI'S oK
LON 135: 00. 00E Az AXI'S (014
NAV DATA NVEA Cross El AXIS (014
@{GYRO DATA K @ Rx Channel 11292
Tx Channel 10000

Sample monitor display printout
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Monitor display description

a) Displays status: satellite, channel, MES and Tx.

Current Satellite: Displays satellite currently being used.
Channel Status: “SYNC” (synchronized with channel) or “UNSYNC” (not
synchronized with channel).

MES Status: Shows “Ready” when system is ready to communicate;
“Busy” when communicating; “Wait” while searching for
satellite.

TX: OFF during no communication: ON while communicating.

b) Displays antenna data: heading, bearing, azimuth and elevation.

North

Ship’s
Heading

...................... > Antenna
Direction

Antenna

Antenna data
c) Ship's position from navigational device.

d) OK shown when gyro data is correctly received; NMEA when nav data is
correctly received. NONE appears when there is no gyro/nav data input.
HOLD indicates manual heading input.

e) Check of transmitter and receiver sections.

TX EIRP Level: Monitors output power from the Antenna Unit. (HPA Board
check: Normal value at transmission is more than 23.)

TX RF Level: Monitors output power from the Communication Unit. (RF
CONYV Board check: Normal value at transmission is 12-
38))

RX C/N: Shows RX C/N level. Normal value is more than 40.

RX IF AGC Level: Shows RX IF AGC level. Normal value is more than 150.

f) Check of transmitter and receiver sections. OK or NG (No Good) shown as

results.
Rx SYN: Rx synthesizer check
Tx SYN: Tx synthesizer check
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8.3

8.3.1

8.3.2

8. MAINTENANCE, TROUBLESHOOTING

g) Check of antenna status. OK or NG is shown for El Axis, Az Axis and Cross El
Axis. REMOTE is displayed for antenna status when the communications unit
is controlling the antenna; FAULT for antenna error.

El AXIS: Elevation axis
Az AXIS: Azimuth axis
Cross El AXIS: Cross elevation axis

h) Rx and Tx channel number

Note: Equipment status may also be checked from the terminal unit.

Tests

This section provides information necessary for running the equipment’s
diagnostic facilities.

Displaying the test menu

The communication and antenna units can be checked the handset. This
procedure is done from the Administration mode. See page 2-10 for how to
choose the Administration mode.

1. Press [FUNC Quit], [6] and [8] to display the Test menu.

68Test
— Version no. display
2 Memory — Memory test
3 Distress — Distress test
Select: [ Ent]

Test menu

2. Press appropriate numeric key to select a test and press the [Ent] key.
3. Press the [FUNC Quit] key several times to close the menu.

Program version no.

1. Press the [1] key at the Test menu to show the program version no. list.

68Test 68Test

O v OA
Version List ——» |Version List
MAI N X X SYNC X X
TERM X X DECODE X X
DEMOD X X - HANDSET Xx X
Quit:[Quit] Quit:[Quit]

xx = Program Version No.

Program version no. list
2. Press the [FUNC Quit] key several times to return to the Test menu.
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Printing the program version no. list

Press the [HOLD Print] key at the Version List display to print the program version
no. list.

165- 0145- 0xx DEMOD 165-0142- 0xx
165- 0146- 0xx SYNC 165- 0143- 0xx
HANDSET 165- 0152- 0xx DECCDE 165- 0144- 0xx

68 Version List <2000-06-20 00: 00(UTC)> ---------------------------

xx = Program Version No.

Program version no. list printout

Memory test

1. Press the [2] key at the Test menu.
2. Press the [Ent] key to start the test.

The test results, OK or NG (No Good), are shown on the display. For any NG
contact your dealer for advice. After the results appear you may print them by
using the [HOLD Print] key.

68Test 68Test

0o v Oa
Memory Test ———» |Memory Test
MAI1 N OK SYNC OK
TERM OK DECODE OK
DEMOD OK <+—— |HANDSET OK
Quit:[ Quit] Quit:[Quit]

Memory test results
3. Press the [FUNC Quit] key several times.

Printing the memory test results

Press the [HOLD Print] key at the memory test display to print the memory test
results.

------ 68 Menmory Test <2000- 06-20 00: 00(UTC)> -------csmmmommmmmmmnx-
- TEST RESULT -

MAI N oK DEMOD oK

TERM oK SYNC K

HANDSET K DECODER K

ANTENNA K

Memory test printout
Note: The memory can also be tested from the terminal unit. The keying
sequence is [F4], [6], [Enter], [Y] and [Enter].
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8. MAINTENANCE, TROUBLESHOOTING

8.3.4 Distress test

The distress test checks the telex and telephone DISTRESS buttons for proper
operation.

A CAUTION

Operate the DISTRESS button within 30
sec. after activating the distress test
mode.

An actual distress alert will be transmitted
if the button is pressed later than 30 sec.
after activating the test.

Telephone distress test

1. Press the [3] key at the Test menu.
68Test

Di stress Test

Start OK?

Start: [ Ent]

Distress start prompt

2. Press the [Ent] key to start the test.

2000-08-29
12:34 UTC

DI STRESS
TEST MODE

Yil AORE Ready

Distress mode activated

Note: The distress test is automatically cancelled after 30 seconds. For this
reason complete the next step within 30 seconds.

3. Handset IB-882: Open the distress button cover on the 1B-362 and press the
[DISTRESS] button six seconds.

Handset IB-882-362: Open the distress button cover on the hanger and press
the [DISTRESS] button six seconds.

Press the [am] key.

Key in LES and press the [#] key.

6. Press the [#m] key when you hear the guidance.

S
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Telex distress test

1. Press the [3] key at the Test menu.
2. Press the [Ent] key to start the test.

Note: The distress test is automatically cancelled after 30 seconds. For this
reason complete the next step within 30 seconds.

3. Open the distress button cover on the IB-352 and press the [DISTRESS] six
seconds. A distress test message is automatically sent.

4. When you receive a message from the LES, press [F10] on the terminal unit
keyboard to disconnect the line.

Restoring Default Settings

You may clear all data and logs from the handset to start operation anew with
default settings. This procedure is done from the Administration mode. See page
2-10 for how to choose the Administration mode.

1. Press [FUNC Quit], [6], [9] to display the Initialize display.

691 nitialize

Al'l dataé&l ogs

are cleared.
ARE YOU SURE?
Clear:[82]

Quit:[Quit]
Initialize display

2. Press [8], [2] to clear. “Now Initializing” appears while data is being cleared.
After default settings are restored the standby display appears.
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Antenna Orientation (for technicians)

This procedure is intended for use by the service technician. The operator should
not attempt to orient the antenna manually; communications may not be possible
if the antenna is incorrectly oriented. This procedure is done from the

Administration mode. See page 2-10 for how to choose the Administration mode.

1. Press [FUNC Quit], [5] and [3] to show the Antenna menu.
53Antenna

Azi mut h oo
El evation: 00
Heading 000
Aut otrack: ON

Enter: [ Ent]

Antenna menu

Select Azimuth, enter azimuth (000-359) and press the [~] key.

Select Elevation, enter elevation (00-90) and press the [¥*] key.

Select Heading, enter heading (000-359) and press the [*] key.

Select AutoTrack and press the [)] key to select OFF.

Press the [Ent] key. (If invalid data is found the message “Input Error! Input
data is invalid.” appears for about three seconds and then the main menu is
displayed.)

7. Press the [FUNC Quit] key to close the menu.

SREIRE L N
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8.6 Error Messages at the Terminal Unit

The tables which follow show the error messages which may appear on the

terminal unit.
8.6.1 Call failure

Call failure error messages
Error Messages Reason Remedy

Call failed, request data invalid. (4561)
Call failed, insufficient digits in service address. (4562) W LES bscrib
Call failed, invalid service address. (4563) * nurr(r):k])ger or Subscriber
Call failed, invalid credit card data. (4564) ' Redial.

Call failed, credit card type not acceptable at this LES. (5522)
Call failed, credit card not accepted. (5539)
Call failed, selected LES is not valid. (0049)

e Wrong card number in
case of credit card.

Call failed, long interruption in reception at MES. (4962)

Unstable reception (MES not
synchronized with satellite.)

Call failed, LES time-out (no assignment). (5569)

Call failed, LES time-out (invalid assignment). (5585)
Call failed, LES time-out (no service address). (5570)
Call failed, LES time-out (no scrambling vector). (5571)
Call failed, LES time-out (no credit card data). (5573)
Call failed, LES time-out (no return carrier identifier). (5574)
Call failed, LES time-out (no MES connect). (5575)

Call failed, LES time-out (no answer). (7969)

Call failed, long interruption in reception at LES. (5729)
Call failed, LES time-out (no MES SCPC carrier). (5826)
Call failed, LES time-out (no MES telex carrier). 85825)
Call failed, LES time-out (no telex answerback). (5576)

Unstable communications
(LES cannot receive reply
from ship.)

Call failed, MES time-out (no scrambling vector ack). (4801)
Call failed, MES time-out (no credit card accepted message).
(4802)

Call failed, MES time-out (no terrestrial answer). (4803)

Call failed, MES time-out (no ship terminal answer). (4129)

Unstable communications
(MES cannot receive reply
from LES.)

Change satellite
or LES.

Call failed, service not authorised at this LES. (5538)

Call failed, service not provided at this LES. (5505)

Call failed, service temporarily not available at this LES. (5521)
Call failed, no service and no scrambling vector. (5572)

Call failed, bulletin board update commenced. (0051)

Call failed, call request failure by LES. (0052)

LES does not offer requested
service.

Change LES.

(Continued on next page)
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Call failure error message (con'’t

Error Message

Reason

Remedy

Call failed, LES congested (no channel unit). (5713)

Call failed, terrestrial circuits congested. (5201)

Call failed, LES congested (no channel and no circuit). (5202)
Call failed, LES congested (no channel). (5457)

Call failed, LES congested (no time-slot). (5458)

Call failed, terrestrial party busy. (7953)

 Lineis busy.

Try again a little

Call failed, terrestrial circuit failure. (8033) " Line trouble. while ater.

Call failed, terrestrial party cleared before MES

connection.(8034)

Call failed, set-up between LES and terrestrial circuits failed.

(7265)

Call failed, MES not authorised at this LES. (5537) RS ansygisaskessusngy | Contact your
properly entered. dealer.

Call failed, shore distress call being setup. (0055)
Call failed, Distress call in progress. (0062)

Call failed, Higher priority call received. (0063)
Call failed, Call in progress. (0064)

Call of higher priority in
progress.

Try again a little
while later.

Call failed, MES busy. (0060)
Call failed, MES terminal not enabled. (0061)

MES not ready for
communications.

Try again a little
while later.

Call failed, Hardware abnormality. (4241)

Call failed, antenna circuit abnormality. (0032)

Call failed, no channel assignment received from LES. (0033)
Call failed, invalid power level assignment. (0034)

Call failed, RX DEMOD circuit abnormality. (0035)

Call failed, TX MOD circuit abnormality. (0036)

Call failed, RX-RF circuit abnormality. (0037)

Call failed, TX-RF circuit abnormality. (0038)

Call failed, Selectively cleared by LES. (0039)

Call failed, no distress service avail. in this OR. (0040)
Call failed, MES unable to sync. to NCSAin time. (0041)
Call failed. (0042)

Equipment trouble*

Contact your
dealer.

* = Another error message accompanies these messages and is printed out.
Trouble can be determined from the printout.

Note 1: Number in parentheses is error message number.
Note 2: Wait 30 seconds before calling again.

8-11
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Antenna trouble

Antenna trouble error message

Error Message

Meaning

Cause

Remedy

OR Change failed. (0100)

Satellite selected from Satellite

menu not acquired.

Satellite is tracked based
on ship’s position.

» Select correct
satellite.
* Check navigator.

Sky Scan failed. (0108)
Sky Scan halted. (0109)
Sky Scan disabled.(0110)

Satellite not found although all

areas searched.

OR Search failed. (0103)
OR Search halted. (0104)
OR Search disabled.
(0105)

Couldn't search for satellite.

Search automatically
stopped. (Equipment
trouble or object in
transmission path of
satellite)

Contact your dealer.

Step-track failed. (01012)
Step-track halted. (0113)

Step track problem.

Equipment problem

Contact your dealer.

Step-track out of bounds.
(0114)

Satellite lost during step
tracking.

Search again after
waiting five minutes.

* Select correct
satellite.

» Check navigator.

8.6.3 Printer trouble
Printer trouble error message
Error Message Cause Remedy
CAUTION: Main Unit Printer error: off-line. (0169) Check
CAUTION: Main Unit Printer error: out of paper. (0170) Printer error connection,
CAUTION: Main Unit Printer error: no connection. (0171) paper, etc.

8-12
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Communication unit trouble (internal)

Communication unit trouble error messages

Error Message Cause Remedy
ALARM: ADE Non-carrier EIRP abnormality. (0139) PCU getects EIRP trouble
during standby.
ALARM: ADE EIRP power too low. (0140) HPA output at Tx is below
ratings.
ALARM: ADE EIRP power too high. (0141) Output power too high at Tx.
ALARM: ADE EIRP burst too long. (0142) PCU detects abnormal Tx
burst width.
ALARM: ADE RF abnormality - No TX power detected. (0143) PCU cannot detect HPA
output power.
ALARM: ADE HPA deactivated during transmission. (0144) HPA trouble
ALARM: TX Synthesizer unlock. (0145) .
. Unlock | detected.
ALARM: RX Synthesizer unlock. (0146) pICEE signat derecte
ALARM: Cross EL axis control error. (0147) Cross EL axis control trouble
ALARM: Az axis control error. (0148) AZ axis control trouble
ALARM: El axis control error. (0149) EL axis control trouble
ALARM: 28V power abnormality. (0154) +28 V not output.
ALARM: RF-CONV circuit abnormality, TX-RF level RF CONV Board trouble,
insufficient.(0160) TXRF level insufficient. Contact your
ALARM: RF-CONV circuit abnormality, TX-RF level too high. RF CONV Board trouble, dealer.
(0161) TXRF level too high
ALARM: RF-CONV circuit abnormality, Unexpected TX-RF level | RF CONV Board trouble,

detected. (0162)

TXRF level error detected

ALARM: AGC level abnormality. (0163)

AGC level error

ALARM: TX-RF circuit abnormality, TX power insufficient. (0164) .OutpL.Jt.power a T
insufficient.

ALARM: TX-RF circuit abnormality, TX power too strong. (0165) | Output power at TX too high.
EIRP trouble detected for

ALARM: TX circuit abnormality, unexpected TX power detected.
Please power off the FELCOM82!! (0166)

period more than 3 sec. at
standby.

ALARM: Telephone Distress Box Cable abnormality. (0167)

Cable for telephone distress
button may be damaged or
disconnected.

ALARM: Telex Distress Alert Box Cable abnormality. (0168)

Cable for telex distress
button may be damaged or
disconnected.

ALARM: FAN FAILURE (0174)

Trouble with fan for power
supply

(Continued on next page)
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Communication unit trouble error messages (con't

Error Cause Remedy

ALARM: SYSCPU error detected. (0176)
ALARM: HANDSET error detected. (0177)
ALARM: DEMOD-CPU error detected. (0178)

ALARM: SYNCCPU-CPU error detected. (0179) CPU error dcé’;z‘:t your
ALARM: DECODER-CPU error detected. (0180)

ALARM: TERM-CPU error detected. (0181)

ALARM: ANTENNA error detected. (0182) Antenna Error

8.7 When the Power Cannot be Turned On

The communication unit and terminal unit have a (red) breaker switch on their
rear panel. If power cannot be supplied, press the breaker switch to restore

normal operation.
5.
COM1 )
7 a«j

Communication Unit Terminal Unit

Breaker

Breaker

Location of breaker

8-14
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APPENDIX

A Menu Overview

Handset

— 2

[FUNC Quit] keyt— 1
Reservi
— 3

—— 5 Setup —

ed for user customizing.

— 4 Display ——— 1 Monitor (Displays system status.)
— 2 Comm. Log (Displays, prints communications log.)

+—— 3 Time&Charge 1 Listby LES
_E 2 List by PID

3 Data Clear

— 4 System Log (Prints system log.)

—— 5 Print All (Prints Setup, TELFAX, MES, TELFAX and

HSD menu settings, and MSD commands.)
—— 6 Print Setup (Prints Setup menu settings.)
— 7 Print MES (Prints MES menu settings.)
— 8 Print TELFAX (Prints TELFAX menu settings.)
—— 9 Print MSD (Prints MSD commands input from MSD terminal.)
—— 0 Print HSD (Prints HSD menu settings.

HSD terminal must be registered in handset.)

— 1 Satellte — — 1 AOR-E
- 2 POR
— 3 I0R
— 4 AOR-W
—— 5 Satb
—— 6 Sat6
—— 7 Sat7
—— 8 Sat8
— 0AUTO

Not used

2 Gyro GYRO (000-359) (degrees)

|_ HOLD (ON, OFF)

3 Antenna Azimuth (000-359)
Elevation (00-90) ! N
—E Heading (000-359) | For technicians
iAutoTrack (ON, OFF)'

LAT (00.00 N)

— 4 Position .
‘: LON (000.00 E)

3 ICAO (No.1, No. 2)

5 Area 1 WMO (No.1, No. 2)
E 2 IMO (NO 1, No. 2) Not used
4 NAVAREA (No.1, No.2)

— 6 Backup NCS (Not used)

(Continued on next page)
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[FUNC Quit] key ——— 5 Setup ——

A-2

— 6 MES ——

7 Distress LES———— 1 AOR-E
L 2POR
— 3I0R
—— 4 AOR-W
—— 5 Satb
— 6 Sat6
—— 7 Sat7
— 8 Sat8

- 8DMG ————— 1 Name

— 2 Maritime (Yes, No)

—— 3 Nature (Fire/Explosion, Flooding, Collision,
Grounding, Lisiting, Sinking,
Disabled&Adrift, Undesignated,
Abandoning)

—— 4 Course (000-359, 000)

— 5 Speed (00-99, 00)

9 OID/DID (Sets OID and DID numbers. For details see the
installation manual.)

0 RevAlarm —|: 1 Disable
2 Enable
1 Handset 1 BackLight (0-3, 3)
2 IdleLight (ON, OFF)
3 LCDBright (0-9, 5)

4 Buzzer Vol (0-9, 7)
5 KeyClick (ON, OFF)

2 Menu Style —\: 1 Simple
2 Detailed

3 Change Mode (Changes mode from User to Admin and vice
versa. Default: User)

4 Date&Time 1 Date&Time
2 Date Form (YYYY-MM-DD, MMM-DD,YYYY,
(DD-MMM-YYYY)

3 Time Zone (-13:30 - +13:30, 00:00; Zone Name, UTC)
5 Charge Info (Displays toll charge information.)
6 Personal ID 1 PID (Disable, Enable)
E 2 PID Entry (Enter PID number.)
3 List/Edit (Display PID list.)
7 Password (Enter password.)
8 Test 1 Version (Displays program version no.)
E 2 Memory (Executes memory test.)
3 Distress (Tests telex and telephone distress
buttons.)

9 Initialize (Clears all data and logs.)
0 Forced Clear (Manually clears communications line.)

(Continued on next page)
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[FUNC Quit] key ——— 7 TELFAX ——— 1 Time Limit ————— 1 TEL1 (OFF, Limit Time (00-99), Answer Only)

—— 2 Credit Call — 1 TELFAX1 (OFF, ON)
—— 2 TELFAX2 (OFF, ON)

— 3 TELFAX3 (OFF, ON)

— 3 Prefix Code (Enter prefix code.)

4 Echo Cancel 1 TEL1 (OFF, ON)
2 TEL2 (OFF, ON)
3 TEL3 (OFF, ON)
4 HANDSET (OFF, ON)

— 5 Print TELFAX (Prints telephone, fax settings.)

—— 8 HSD ———— 1 Dest. No. (Set destination no. (DTR Dial)
—— 2 Call TEL 1TEL1
2 TEL2
3 TEL3
4 HANDSET
—— 3 Data Rate 1 64k
2 56k
—— 4 Dial Method 1 DIRECT
2 ADDRESS
—— 5 Auto Rate 1 OFF
2 ON
— 6 Command—|: 1HDLC
2BSC
—— 7 Character 1 8bit/INone
2 7hit/Odd

— 8 Ignore DTR —|: 1 Normal
2 Ignore

—— 9 Print HSD (Prints HSD menu settings.)

[ABBR FIND] key 1. Entry (Registers abbreviated dialing numbers.)
(Press [*] after
[ABBR FIND].) — 2. Edit* (Edits abbreviated dialing numbers.)

— 3. Remove** (Deletes abbreviated dialing numbers.)

— 4. HSD Call

* Not displayed when no abbreviated dialing
numbers are registered.

** Not displayed unless HSD OID/DID number
is registered and HANDSET is selected at
the Call TEL menu.

—— 2 TEL2 (OFF, Limit Time (00-99), Answer Only)
L 3 TEL3 (OFF, Limit Time (00-99), Answer Only)
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Terminal Unit (Class 1 only)

A-4

[F1] (File)

1.
— 2.

[F2] (Edit)

- 8.
9

. Replace (ALT + R)

New Text (ALT + N)
Open Text (ALT +0O) —I:

. Close Text (ALT + Q)
. Save Text (ALT + S)
. Delete File (ALT + D)
. Rename File

. Print File (ALT + P)

. Clear Comm Memory
. Format Disk

. Undo (ALT + X)

. Cut (DEL)

. Copy (ALT + C)

. Paste (INS)

. Select All (ALT + A)
. Search (ALT +F) ———

Goto Top (HOME)
Goto Bottom (END)

. Goto Line (ALT + L)
. Change Text (ALT + V)

Load
Merge

Forward
Backward
Forward

Query
Backward j [AII
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[F3] (Telex)
— 1. Auto Telex (ALT + T) 1. Station Name SEND
2. LES Access Code —_|: CANCEL
3. File to Send
—— 2. Call LES ——— 1. LES Access Code SEND
- 2. Priority 1. Routine L CANCEL
2. Safety ——
3. Urgent |
L— 3. Service Code
——— 3. Call Station
| 4. Transmit File
L 5. Program Telex 1. Station Name ENTRY
2. LES Access Code L DELETE
3. File to Send

2. Interval —

— 4. Program Mode -E 1. One Time —

3. Schedule —
- 6. Confidential Msg

——— 7. Communication Log

— 8. Change Window (ALT + W) : Default Setting

[F4] (Setup)

— 1. Station List — 1. Stn. Name
_ 2. Telex No.
3. Answerback

4. Remarks
—— 2. LESList 1. LES Access Code
| 2. LES Name

L 3. Remarks

(Continued on next page)
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(Continued from previous page)

- 3. Terminal Setup ———

— 4. Editor Setup —

(Continued on next page)

— 1. Date

— 2. Time

— 3. Date Display Form 1. YY-MM-DD
E 2. MMM-DD-YY
3. DD-MMM-YY
— 4. Screen Saver —’— 1. Mode ON
2. Mode OFF

—5. Comm Time Display —[ 1. Display ON

2. Display OFF
— 6. Incoming Call Alarm —I: 1. Alarm ON
2. Alarm OFF
— 7. Special Char 1. Default
— 2. Norway
— 3. Sweden
— 4. UK
— 5. Spare 1
— 6. Spare 2
— 8. Answerback Code
—1. Text Mode 1. TELEX
— 2. ASClI
— 2. Edit Mode 1. Insert
— 2. Overwrite
— 3. Word Wrap 1. ON
2. OFF
— 4. Line No. 1. ON
— 2. OFF
— 5. Tab Width 1.2 char
—2. 4 char
— 3. 8char
—6. Column Width (Fixed)
—7. Cursor Type 1. Block
I_ 2. Underline
— 8. Scroll 1. Full Screen

A-6
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(Continued from previous page)

5. Polling Configuration —|:Polling Response File
Personal ID Entry

6. Comm Unit Setup =1 1. Ocean Region —|: 1. Satellite T—0. Auto
E. Exit — 1. AOR-E
— 2. POR
— 3.10R
4. AOR-W
— 5. Sat5
— 6. Sat 6
7 sat7 Not used
— 8. Sat 8
— 2. DMG Setup ———— 1. Abbr. Ship’s Name
— 2. Maritime — Maritime
or ng L Non-Maritime
— 3. Nature of — 1. Fire/Explosion
(istiess - 2. Flooding
— 4. Course 3. Collision
— 5. Speed — 4. Grounding
— E. Exit — 5. Listing
— 6. Sinking

— 7. Disabled and Adrift
— 8. Undesignated
— 9. Abandoning Ship

(Continued on next page)
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(Continued from previous page)

— 6. Comm Unit Setup T—— 3. Network Setup——1. Preferred LES — 1. AOR-E ——|: NCS Backup*
— 2. POR —— Distress
— 3. IO0R —| .
4 AORW_ Not used.
L E. Exit
L 2. Additional
AreaType _ 1. WMO
— 2. IMO Not used
— 3. ICAO
— 4. Navarea
L E. Exit
— E. Exit
L— 4. Test
L— 7. Window Color 1. Window Color Setup Window# ——— Base Window
I: 2. Default Color —E Fore Colore — TLXBACK-SCROL
Back Colore |— Telex
# Choose foreground and background m
colors for these items, from the colors [ Edit2
listed below. L — Function
— Sub Menu1
— Sub Menu2
+ White, Brown, Magenta, Red, Cyan, Green, Blue, Black, — Sub Menu3
Light-White, Yellow, Light-Magenta, Light-Red, Light-Cyan, | g,p Menu4

Light-Green, Light-Blue, Gray M
— Message

» White, Black, Blue, Green, Cyan, Red, Magenta, Brown
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APPENDIX B
Telephone, Telex Country Code Lists

Area and Country C;)rjlrﬁrr);(c):r:)?je Teleég:g:ntry Remarks for Telex Code
Afghanistan 93 79
Alaska 1 200
Albania 355 604
Algeria 21 408
American Samoa 684 770
American Virgin Is. 1 208 Telex calls to former WUI subscribers, insert the figure
“9” after the destination code “208”.
Andorra 33 590
Angola 244 991
Anguilla 1 391
Antigua & Barbuda 2 393
Argentina 54 33 Disregard the figure “0” at head of subscriber number.
Armenia 7 684
Aruba 297 303 Subscriber numbers are 2XXX or 5XXX
Ascension 247 939 Manual calls 3XXX
Australia 61 71
Australian External 672 766
Territories
Austria 43 a7
Azerbaijani 994 784
Azores Is. 351 404 Destination code is the same as for Portugal.
Bahamas 1 297
Bahrain 973 490
Bangladesh 880 780
Barbados 1 392
Belarus 7 681
Belgium 32 46
Belize 501 371
Benin 229 972
Bermuda 1 290
Bhutan 975 890
Bolivia (Rep. of) 501 371
Bolivia (ENTAL) 309
Bosnia-Hercegovina 387 600
Botswana 267 962
Brazil 55 38 Disregard the figure “0” at head of subscriber number.
British Virgin Is. 1 292
Brunei Darussalam 673 809
Bulgaria 359 67
Burkina Faso 226 978
Burundi 257 903
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Area and Country Cgﬁlrﬁ?;]%r:)%e Teleé(():ggntry Remarks for Telex Code
Cambodia 855 807 Kampuchea Rep.
Cameroon 237 970
Canada 1 21 Disregard the figure “0” at head of subscriber number.
1
Canary Is. 34 52 Destination code is the same as for Spain.
Cape Verde 238 993
Cayman Is. 1 293
Central Africa Rep. 236 971
Chad 235 976
TCH subscribers 2XXXXX
ENTEL subscribers 5XXXXX
Chile 56 34 TRA subscribers 3XXXXX
TECOM subscribers 6XXXXX
VTR CM subscribers 4XXXXX
China 86 85
Christmas Is. (Aus) 672 766
CIS (formerly USSR) 7 64
Cocos-Keeling Is. 672 766
Colombia 57 35 Disregard the figure “0” at head of subscriber number.
Comoros 269 994 Manual calls
Congo 242 981
Cook Is. 682 772
Costa Rica 506 376
Cote d’ Ivoire 225 983 Ivory Coast
Croatia 385 599
Cuba 53 28
Cyprus 357 605
Czechoslovakia 42 66
Denmark 45 55
Diego Garcia 246 938
Djibouti 253 979
Dominica 1 394
201 RCA subscribers 4XXXXX
Dominican Rep. 1 202 For subscriber number beginning with 346, disregard
“346” at head of subscriber number.
241 AGEM IR subscribers 61XX
Ecuador 593 308
Egypt 20 91
El Salvador 503 373
Estonia 372 537
(formerly USSR)
Ethiopia 251 980
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Area and Country Cgslnet?;%r;%e Tele)égggntry Remarks for Telex Code
Falkland Is. (Malvinas) 500 306
Faroe Is. 298 502
Fiji 679 701
Finland 358 57
France 33 42
French Guiana 594 300
French Polynesia 689 702
Gabon 241 973
Gambia 220 996
Georgia 7 683
Germany (Fed, Rep. of) 49 69 formerly East Germany
49 { 41 formerly West Germany
Ghana 233 94
Gibraltar 350 405
Greece 30 601
Greenland 299 503
Grenada 1 395
Guadeloupe 590 299
Guam (RCA) 671 700
Guatemala 502 372
Guiana 594 300
Guinea Conakry 224 995 Manual calls
Guinea Bissau 245 969
Guyana 592 295
Haiti 509 203 RCA subscribers 9XXX
704 RCA subscribers 8XXX or 2968XX
705 ITT subscribers 743XXX
Hawaii 1 708 WUI subscribers 63XXX or 63XXXX
709 WUH subscribers 39XXXX
(773) Telex calls to HTC subscribers can be made using
Semi-automatic calls.
Honduras 504 374
Hong Kong 852 802
Hungary 36 61
Iceland 354 501
India 91 81
Indonesia 62 73 Disregard the figure “0” at head of subscriber number.
Iran 98 88
Iraq 964 491
Ireland 353 500
Israel 972 606 Disregard the figure “0” at head of subscriber number.
Italy 39 43
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Area and Country CgﬁLetrrJ;]%r:)%e Teleé(c):g:ntry Remarks for Telex Code
Jamaica 1 201
Japan 72 KDDI (for 5 digits)
81 720 NTT
Jordan 962 493
Kazakhstan 7 785
Kenya 254 987
Kiribati 686 761 Subscriber numbers are 770XX
Korea (Demo. People's 850 (899)
Rep. of)
Korea (Rep. of) 82 801
Kuwait 965 496
Kyrgyzstan 7 788
Lao 856 804
Latvia (formerly USSR) 371 538
Lebanon 961 494
Lesotho 266 963
Liberia 231 997
Libya 21 901
Liechtenstein 41 45
Lithunia 370 539
(formerly USSR)
Luxembourg 352 402
Macao 853 808
Macedonia 389 597
Madagascar 261 986 Subscriber number beginning with 4, 5, 7, 8 and 9 can
be reached by Manual Calls.
Madeira Is. 351 404 Destination code is the same as for Portugal.
Malawi 265 904
Malaysia 60 84
Maldives Is. 960 896
Mali 223 985
Malta 356 406 Subscriber number beginning with 11XX can be
reached by Semi-automatic calls.

403
Mariana Is. 671 760
Marshall Is. 692 765
Maritinique 596 298
Mauritania 222 974
Mauritius 230 966
Mexico 52 22 Disregard the figure O00 at head of subscriber number,
Micronesia 691 764
Moldova 373 682
Monaco 33 42 Destination code is the same as for France.
Mongolia 976 800
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Area and Country C;—SLet[r);(C):r;%e Teleégggntry Remarks for Telex Code
Montserrat 1 396
Morocco 21 407
Mozambique 258 992
Myanmar 95 83
(formerly Burma)
Namibia 264 908
Nauru 674 775
Nepal 977 891
Netherlands 31 44
Netherlands Antilles 599 390
New Caledonia 687 706
New Zealand 64 74
Nicaragua 505 375
Niger 227 975 2XXXX other numbers are for Semi-automatic calls.
Nigeria 234 905
Niue Is. 683 776
Northern Mariana Is. 670
Norfolk Is. 672 766
Norway 47 56
Oman 968 498
Pakistan 92 82
Palau 680 763
377 TRT subscribers
Panama 507 378 AACR subscribers
379 INTEL subscribers
Papua New Guinea 675 703
Paraguay 595 305
Peru 51 36
PHILCOM subscribers 2XXXX
RCPI subscribers 7XXXX
Philippines 63 75 < | GMCR subscribers 4XXXX
ETPI subscribers 6XXXX
CAPWIRE subscribers 1XXXX
For PTT subscribers, insert the figure “8” after the
L | destination code “75".
Poland 48 63 Disregard the figure “0” at head of subscriber number.
Portugal 351 404
205 RCA subscribers 2XXX
Puerto Rico 1 206 ITT subscribers 345XXX
207 C&W, WUI subscribers
209 ACPR (PRCA) subscribers
Qatar 974 497
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Telephone | Telex Country

Area and Country Remarks for Telex Code

Country Code Code
Reunion 262 961 Subscriber numbers are 916XXX
Romania 40 65 Disregard the figure “0” at head of subscriber number.
Russian Federation 7 64
Rwanda 250 909
Saipan 670 760
San Marino 378 505
Sao Tome & Principe 239 967 Manual calls
Saudi Arabia 966 495
Senegal 221 906
Seychelles 248 965
Sierra Leone 232 998
Singapore 65 87
Slovak 42 66
Slovenia 386 598
Solomon Is. 677 778
Somalia 252 900

Cape Town subscribers XXXXXX
South Africa 27 95 Bophuthatswana subscribers 08XXXX
Transkei subscribers 09XXX

Spain 34 52
Spanish North Africa 34 52
Sri Lanka 94 803
St. Helena 290 (960) Manual calls 4XXX
St. Kitts & Nevis 1 397
St. Lucia 1 398
St. Pierre & Miquelon 508 204
St. Vincent & 1 399
the Grenadines

Sudan 249 984
Suriname 597 304
Swaziland 268 964
Sweden 46 54
Switzerland 41 45
Syria 963 492
Tajikistan 7 787
Taiwan 886 769
Tanzania 255 989
Thailand 66 86
Togo 228 977
Tokelau 690 762
Tonga 676 777
Trinidad & Tobago 296 294
Tunisia 21 409
Turkey 90 607
Turkmenistan 7 789
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Area and Country C;—S:ﬁ‘:;%%%e Teleé(c):g:ntry Remarks for Telex Code
Turks & Caicos Is. 1 296
Tuvalu 688 774
U.A. E. 971 893
Abu Dhabi 2XXXX, 3XXXX, EXXXX
Ajman 695XX
Dubai AXXXX
Fujairah 8XXXX
Ras Al Khaimah IXXXX
Sharjah 68XXX
Umm Al Qaiwain 697XX
Uganda 256 988
Ukraine 7 680
United Kingdom 44 51
United Arab Emirates 971 893
Upper Volta 226 978 Same as OBurkina FasoO.
Uruguay 598 32
Uzbekistan 7 786
CCI subscribers 7XXXXXX
U.S. A 1 23 ITT subscribers 4XXXXX, 4XXXXXX, 4XXXXXXXXX
RCA subscribers 2XXXXX
WUI subscribers BXXXX, BXXXXX, BXXXXXX
23 TRT subscribers IXXXXX, IXXXXXXXXX
FTCC subscribers 8XXXX, 8XXXXX
U. S. A. (Mainland) 3 GRPHNET subscribers 36XXXXX, 37XXXXX
For WUT subscribers, insert the figure "0" after the
destination code "23".
25 Telex calls to TWX subscribers whose numbers do not
contain "0" as the third figure of the 10 figure code can
L be made as Semi-automatic calls.
U.S. S. R. (Former) 7 640 Russian Federation
Vanuatu 678 771
Vatican 379 504
Venezuela 58 31
Viet Nam 84 805 Subscriber number beginning with 561XXX can be
made using manual calls
Walllis & Futuna Is. 681 707
Western Samoa 685 779
Yemen (Rep. of) 969 806 Formerly Yemen (P. D. Rep. of)
Yugoslavia (Former) 967 895 Formerly Yemen (Arab Rep.)
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Area and Country C;)rﬁlnetrr);%%%e Teleégggntry Remarks for Telex Code

Zaire 243 982 Telex calls to places other than Kinshasa Subscriber
beginning with 2XXXX can be made as Semi-automatic
calls.

Zambia 260 902

Zanzibar 259 990

Zimbabwe 263 907

Ocean Area og:;ipggg i?)n ngli?; aiiaer;s Remarks
Access Code

AOR-W 874 584 Atlantic Ocean-W

AOR-E 871 581 Atlantic Ocean-E

POR 872 582 Pacific Ocean

IOR 873 583 Indian Ocean
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APPENDIX C

LES ACCESS CODE LIST

LES code list (4/2002)

Land earth station operator Country AOR- E | AOR- W IOR POR
Beijing Marine China 311 211
Bezeq Israel 127 327
CAT Thailand 319
CP Radio Marconi Portugal 118
Embratel Brazil 114
France Telecom France 121 021 321 221
France Telecom (Ex DeteSat) |France 115 333
KDDI Japan 103 003 303 203
Korea Telecom South Korea 308 208
Morviasputnik (Nudel Les) Russia 117 317
OTE Greece 120 305
Polish Telecom Poland 116 316
Saudi Telecom Co Saudi Arabia 125 325
Singapore Telecom Singapore 328 210
Stratos Mobile Networks Canada 102 002 302 202
Telecom Company of Iran Iran 314
Telecom ltalia Italy 105 335
Telenor Satellite Services Inc  |USA 101 001 201
Telenor Satellite Services AS |Norway 104 004 304 204
Turk Telecom Turkey 110 310
Vishipel Vietnam 330
VSNL India 306
Xantic Netherlands 112 012 312 212
Xantic Australia 122 022 322 222
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APPENDIX D

Telex Abbreviations,

International Telegraphy Alphabet

Telex Abbreviations

Abbreviation Meaning
ADV Advise
ACK Acknowledge
AGN Again
BI (GS) Good bye
BK | cut off.
CEN Confirm
COL Collation
CRV How do you receive?
DER Out of order
DWN Down
EEE Error
FM From
GA Go ahead.
MNS Minutes
MOM Wait (Waiting)
MUTI Mutilated
NA Correspondence to this subscriber is not admitted.
NC No circuits
NCH Snbscriber's number has been changed.
NP The called party is not or no longer is a subscriber.
NR Indicate your call number.
ocCcC Subscriber is engaged.
OK Agreed.
P (or 0) Stop your transmission.
PLS (PSE) Please
PPR Paper
P (RCD) Received
RAP | will call you again.
RD Reed
RE Referring to
RPT Repeat
SRY Sorry
SVP Please
TAX What is the charge?
TEST MSG Please send a test message?
THRU You are in communication with telex position
TKS (TNX) Thanks
TLX Telex
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International Telegraphy Alphabet

D-2

No. FIGURES | LETTERS No. FIGURES | LETTERS
1 - A 17 1 Q
2 ? B 18 4 R
3 C 19 0 S
4 TP D 20 5 T
5 3 E 21 7 U
6 ] F 22 = V
7 - G 23 2 W
8 U H 24 / X
9 8 | 25 6 Y
10 BELL J 26 + Z
11 ( K 27 CARRIAGE RETURN
12 ) L 28 LINE FEED
13 M 29 LETTERS
14 N 30 FIGURES
15 9 o) 31 SPACE
16 0 P 32 BLANK
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APPENDIX E DIGITAL INTERFACE
(IEC 61162-2)

Input sentences
GGA, GLL, RMA, RMC, ZDA, VTG, RMB, WPL, MTW, DBT, VDR, BWC, BWR

Schematic diagram of NAV IN port

IB-313 IB-282
| | | R227
NAVRX-A 13 [T] {13—8¢ A Al —
- R228
- 390
| | | 2 pcano
NAVRX-B 14 [} {14 &—(9¢ 3 >
, S 17 CR56
. 155355

| |
Load requirements
Isolation: Optocoupler

Input Impedance: 100 ohm
Max .voltage: £15 V

E-1
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Data sentences: input
BWC — Bearing and distance to waypoint

$--BWC, hhmmss.ss, llILIl, a yyyyy.yy, a, x.x, T, x.x, M, x.x, N, c--c, a*hh<CR><LF>
L |—Checksum
Mode indicator

(see note 1)
Waypoint ID*

Distance, nautical miles
Bearing, degrees magnetic®
Bearing, degrees true
Waypoint longitude, E/W*

Waypoint latitude, N/S*
— UTC of observation*

*: Not used

NOTE 1: Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid
The Mode indicator field shall not be a null field.
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BWR — Bearing and distance to waypoint —rhumb line

$--BWR,hhmmss.ss, lliLIIL,a,yyyyy.yyy,a,x.x,T,x.x,M,x.x,N,c--c,a*hh<CR><LF>
[ I

+ 1

. UTC of observation

. Waypoint latitude, N/S

. Waypoint longitude, E/W

. Bearing, degrees true

. Bearing, degrees magnetic
. Distance, nautical miles

. Waypoint ID

. Mode indicator(see note)

. Checksum

OCoONOODWN-=-

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid
The Mode indicator field shall not be a null field.

DBT — Depth below transducer
$--DBT,x.x,f,x.x,M,x.x,F*hh<CR><LF>

1. Water depth, feet

2. Water depth, m

3. Water depth, fathoms
4. Checksum
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GGA - Global positioning system (GPS) fix data

$--GGA ,hhmmss.ss, llILIILa,yyyyy.yyy,a,x,xx,X.X,X.X,M,x.x,M,x.Xx,xxxx*hh<CR><LF>

| I |1 ||
| I I A A A N O B AR R
| T I A A B O A [
| I
| R O I A B B B 8
| R N I B B e 7
| (. [+ 6
| || [ 5
| (. ||+ 4
| (. t—+ 3
| B — 2
+ 1
1. UTC of position
2. Latitude, N/S
3. Longitude, E/W
4. GPS quality indicator (see note)
5. Number of satllite in use,00-12, may be different from the number in view
6. Horizontal dilution of precision
7. Antenna altitude above/below mean sealevel, m
8. Geoidal separation, m
9. Age of differential GPS data

10. Differential reference station 1D, 0000-1023
11. Checksum
NOTE
0 = fix not available or invalid
1 = GPS SPS mode, fix valid
2 = differential GPS, SPS mode, fix valid
3 = GPS PPS mode, fix valid
4 = Real Time Kinetic. Satellite system used in RTK mode with fixed integers
5 = Float RTK. Satellite system used in RTK mode with floating fingers
6 = Estimated (dead reckoning) mode
7 = Manual input mode
8 = Simulator mode
The GPS quality indicator shall not be a null field.
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GLL — Geographic position, latitude and longitude

$--GLL,llILIlLa,yyyyy.yyy,a,hhmmss.ss,A,a*hh<CR><LF>
| [

|
|
| R 3
+

[

. Latitude, N/S

. Longitude, E/W

. UTC of position

. Status: A=data valid, V=data invalid
. Mode indicator(see note)

. Checksum

OO WN -~

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The Mode indicator field supplements the Status field. The Status field shall be
set to V=invalid for all values of Operating Mode except for A=Autonomous and
D=Differential. The positioning system Mode indicator and Status field shall not
be null fields.

MTW — Water temperature

$--MTW,x.x,C*hh<CR><LF>
| 1]
|

1. Temperature, degrees C
2. Checksum
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RMA — Recommended minimum specific LORAN-C data

$--RMA A IILIILa,yyyyy.yY,a,X.X,X.X,X.X,X.X,X.X,a,a*hh<CR><LF>

+

+-—t

+---+

. S —

. Status: A=data valid, V=blink, cycle or SNR warning
. Latitude, degrees N/S

. Longitude, degrees E/W

. Time difference A, microseconds
. Time difference B, microseconds

. Course over ground, degrees true
. Magnetic variation(see note 1),degree E/W

. Mode indicator(see note 2)

0. Checksum

1
2
3
4
5
6. Speed over ground, knots
7
8
9
1

NOTE 1 - Easterly variation(E) subtracts from true course
Westerly variation(W) adds to true course

NOTE 2 Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The Mode indicator field supplements the Status field. The Status field
shall be set to V=invalid for all values of Operating Mode except for
A=Autonomous and D=Differential. The positioning system Mode indicator
and Status field shall not be null fields.
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RMB — Recommended minimum navigation information

$--RMB, A x.x,a,c--c,c--c,llILIILa,yyyyy.yyy,a,x.x,x.X,x.x,A,a*hh<CR><LF>
|1 || I

S — 6
+ 5

+

|
|
I
|
|
|
|
|
|
| 4
| + 3

2

+
+ 1

. Data status: A=data valid, V=navigation receiver warning
. Cross track error(see note 2) n.miles

. Direction to steer L/R

. Origin waypoint ID

. Destination waypoint ID

. Destination waypoint latitude,N/S

. Destination waypoint longitude,E/W

. Range to destination, n.miles(see note 1)

. Bearing to destination, degrees true

10. Destination closing velocity, knots

11. Arrival status: A=arrival circle entered or perpendicular passed
12. Mode indicator(see note 3)

13. Checksum

O©CoO~NOOOAWN-=-

NOTES
1 If range to destination exceeds 999.9 nautical miles, display 999.9.
2 If cross track error exceeds 9.99 nautical miles, display 9.99.

3 Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N= Data not valid

The Mode indicator field supplements the Status field. The Status field
shall be set to V=invalid for all values of Operating Mode except for
A=Autonomous and D=Differential. The positioning system Mode indicator
and Status field shall not be null fields.
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RMC — Recommended minimum specific GPS/TRANSIT data

$--RMC,hhmmss.ss, A llILIILa,yyyyy.yyy,a,Xx.X,X.X,XXXXXX,X.X,a,a* hh<CR><LF>
||

I I I I I I

I I I I | | | +--10
I [ I O | | +---9
I [ I O 8
I I I I I 7

| I I I B 6

I [ I+ 5

I I +-mt 4

| | f— 3

I + 2

+ 1

1. UTC of position fix

2. Status: A=data valid, V=navigation receiver warning
3. Latitude, N/S

4. Longitude, E/W

5. Speed over ground, knots

6. Course over ground, degrees true

7. Date: dd/mm/yy

8. magnetic variation, degrees E/W

9. Mode indicator(see note)

10. Checksum

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The Mode indicator field supplements the Status field. The Status field
shall be set to V=invalid for all values of Operating Mode except for

A=Autonomous and D=Differential. The positioning system Mode indicator
and Status field shall not be null fields.

VDR - Set and drift

$--VDR,x.x,T,x.X,M,x.x,N*hh<CR><LF>

1. Direction, degrees true

2. Direction, degrees magnetic
3. Current speed, knots

4. Checksum
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VTG — Course over ground and ground speed

$--VTG,x.X, T,x.X,M,x.x,N,x.x,K,a*hh<CR><LF>

1. Course over ground, degrees true

2. Course over ground, degrees magnetic
3. Speed over ground, knots

4. Speed over ground, km/h

5. Mode indicator(see note)

6. Checksum

NOTE Positioning system Mode indicator:
A = Autonomous
D = Differential
E = Estimated (dead reckoning)
M = Manual input
S = Simulator
N = Data not valid

The positioning system Mode indicator field shall not be a null field.
WPL — Waypoint location

$--WPL,lIILIIla,yyyyy.yyy,a,c—-c*hh<CR><LF>

1. Waypoint latitude, N/S
2. Waypoint longitude, E/W
3. Waypoint identifier

4. Checksum

ZDA

$--ZDA, hhmmss.ss, XX, XX, XXXX,XX,XxX*hh<CR><LF>
| O O I A
I A
| ] 6
| L] ] A 5
| ] e 4
| | - 3
| + 2
+ 1

1. UTC

2. Day, 01 to 31(UTC)

3. Month, 01 to 12(UTC)

4. Year(UTC)

5. Local zone hours, 00h to +-13h

6. Local zone minutes, 00 to +59
as local hours

7. Checksum
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APPENDIX F Parts Location,
Parts List

Antenna Unit IB-182

\ Radiator 1B-182

HPA

LNA

Antenna unit, radiator

F-1
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Communication Unit IB-282

CPU 16P0182
AD CONV Board
64P1106

RF CON Baord
16P0181

SAW FIL Board
16P0195

SW REG Board
16P0180A: 100-115 VAC
16P0180B : 220-230 VAC

Communication unit, bottom view, cover removed
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Terminal Unit IB-582

CPU Card
Power Supply
ACE-870C-B2
FIL Board
16P0186
VR Board
16P0187
CONV Board
16P0194
T. Board
16P0185 Inverter
104PWBR1

Terminal unit, rear view, FIL Board removed
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Telex Distress Alert Button IB-352, Telephone Distress
Button IB-362, Incoming Indicator IB-372

SW/BZ Board
16P0150

SW/BZ board (common to all above-mentioned units) for IB-352, IB-362, 1B-372
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FURUNO Model |[FELCOM 82A/82B
Unit 14 U ILYy ~-BiafifitthEk
ERIPLE INMARSAT-B MES
ELECTRICAL PARTS LIST Ref.Dwg. Page
2000 12H Blk.No.
SYMBOL TYPE CODE No. REMARKS SHIPPABLE
ASSEMBLY
ERES = -+ &S £ H T B 48
IB-182
1B1 IB-182, RADIATOR 004-445-220 X
1B3 LNA 004-445-230 16P0178 X
1B5 HPA 004-445-240 16P0179 X
X
IB-282
2B1 SWREG, 16P0180A 004-445-290 100-115 VAC X
SWREG, 16P0180B 004-445-690 220-230 VAC X
2B2 RFCON, 16P0181 004-445-300 X
2B3 CPU, 16P0182 004-445-310 X
2B4 AD100, 64P1106A 004-412-220 AD CONV X
Bl 16-150 (FAN-3P) 004-445-180 BL-PH Connector X
IB-582
3B2 16P0185, T.BOARD 004-445-390 X
3B3 16P0186, FIL 004-445-380 X
3B4 16P0187, VR 004-445-350 X
3B5 16P0194, CONV 004-445-360 X
CPU CARD 004-445-410 X
ACE-870C-B2 004-445-370  Power Supply X
104PWBR1 004-445-400 Inverter X
IB-352/362/372
16P0150, SW/BZ 004-437-980 X
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SPECIFICATIONS OF THE INMARSAT -B SHIP EARTH STATION
FELCOM 82 A/B (A: Class 1, B: Class 2)

1. ANTENNA UNIT
Antenna Type
Gain
Axial Ratio
Antenna Beamwidth
Stabilization
Positioning

Positioning Accuracy

Tracking

2. COMMUNICATION UNIT
Transmit Frequency
Receiver Frequency
Tuning Steps

GIT
EIRP
Modulation
-Voice
-9.6 kbps Data
-HSD
-Telex TX(Class 1)
-Telex RX (Class 1)
-TDM
Caoding
-Voice
-9.6 kbps Data
-Telex
Decoding
Voice Coding Method
Interface
Input:

Output:

0.9 m diameter parabola
Greater than 21.0dB

Less than 2dB

15 deg. approx. (at -3dB)
Triple-axis active control type
AZ: 360°, no-rewind

EL: 5° to 90° (-27.5° to 122.5°)
AZ: Better than £3 deg.

EL: Better than +3 deg.
Step-tracking system

1626.5MHz to 1646.5MHz

1525.0MHz to 1545.0MHz

10kHz (telex receiving), 20k (telex transmission, voice, 9.6 kbps
data), 100 kHz (HSD)

Better than - 4dB/K

33/29/25 dBW

24 kbps filtered O-QPSK
24 kbps filtered O-QPSK
132 kbps filtered O-QPSK
24 kbps filtered O-QPSK
6 kbps filtered BPSK

6 kbps filtered BPSK

Convolution; Rate 3/4, K=7 (punctured)

Convolution; Rate 1/2, K=7

Convolution; Rate 1/2, K=7

8-level soft - decision Viterbi

16 kbps APC-MLQ

IEC61162-1 Ed.2 (NMEA3.0)

GGA, GLL, RMA, RMC, ZDA, VTG, RMB, WPL, MTW, DBT,
VDR, BWC, BWR

GGA, ZDA, GLL, VTG, RMC, GSV

SP-1 E5624S01C
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3. TERMINAL UNIT

Display
Microprocessor
Memory

Disk Drive
Serial Port
Parallel Port
Keyboard

4. PRINTER

Printing System
Character Composition
Printing Speed
Emulation

Type of Characters

Type of Paper
Paper Advance Speed

Data Buffer

Number of Copies
Ribbon

Interface

Noise

5. INTERFACE

DGPS:
HSD:
GYRO:
NAVAID:
Phones:

6. POWER SUPPLY

wWww.reeischematic.com

10.4" Color TFT LCD

AL16117 (Intel 80386SX), 40MHz

RAM: 2MB, Video RAM: 1MB, Disk on chip: 8MB or more

720kB or 1.44MB 3.5" FDD

2 ports of RS-232C

1 port of Centronics

Enhanced 82-key keyboard emulates the IBM PS/2 keyboard
and includes embedded numeric and cursor control overlay and
dedicated cursor control keys.

Serial impact dot matrix

9 x 7 dot matrix

Draft: 200 characters/second, NLQ: 50 characters/second
Epson FX850 mode or IBM Proprinter 1l mode

324 letters (Epson FX850 mode)

262 letters (IBM Proprinter Il mode)

Roll paper, type “ 1P", non- carbon paper 34g/m?®
1/6, 1/8 or 1/216 inch steps,

8.3 lines/sec(at 1/6" step)

21K bytes (Epson FX- 850 mode)

9.3K bytes (IBM Proprinter 1| mode)

Original plus 2 copies (Total thickness: 0.2mm or less)
Original fabric ribbon (13mm x 14m)

Parallel interface (Centronics)

Less then 59 dBA

Frequency: 1525 to 1545 Hz, Level: -100 to —60 dBm
RS-422/RS-449, 56000/64000 bps (sync)
Gyro-repeater signal (sync/step)

IEC 61162 (NMEAO0183), 4800 bps

2-line modular cable

Communication unit/ Antenna unit/ Terminal unit/ Printer

Terminal Unit
Printer (PP-510)

100-115/220-230 VAC: 4.1/1.9 A (transmission),
2.2/1.1 A (receiving), 1 phase, 50/60 Hz
24VDC: 1.0 A

24VDC: 15 A

SP-2 E5624S01C
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7. ENVIRONMENTAL CONDITION
Category of Equipment
Antenna Unit: To be installed in a Exposed area
Others: To be installed in a Protected area

Ambient Temperature IEC 60945 3rd  Inmarsat-B SDM
Antenna unit: -25°C to +55°C  -25°C to +50°C
Communication unit: -15°C to +55°C  0°C to +45°C
Terminal unit: -15°C to +55°C  0°C to +45°C
Printer (Facsimile): +5°Cto +35°C  0°Cto +45°C
Relative Humidity IEC 60945 93% at 40°C (Inmarsat B SDM 95%)
Waterproofing IEC 60529;

Antenna Unit: IPx6
Communication Unit/Terminal Unit: IPx0
Handset w/bracket: IPx2

Printer: IPx0
Vibration IEC 60945 (Inmarsat B SDM)
Motion Roll: + 30°/8s, Pitch: + 10°/6s, Yaw: + 8°/50s, Surge: + 0.2G,

Sway: + 0.2G, Heave: £ 0.5G, Rotation: 6°/s, Speed: 30 kt

8. COATING COLOR

Antenna Unit Munsell N9.5
Communication Unit Panel: N3.0, Cover: 2.5GY5/1.5
Terminal Unit Panel: N3.0, Cover: 2.5GY5/1.5

Handset/ Handset bracket N3.0

SP-3 E5624S01C
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FURUNO ELECTRIC CO., LTD.

®
l:g @ @ @ I:::I @ 9-52 Ashihara-Cho, Nishinomiya City, 662-8580, Hyogo, Japan

Tel: +81 798-65-2111 Fax: +81 798-65-4200

Pub NO. DOC-462

Declaration of conformity

We FURUNO ELECTRIC CO., LTD.

(Manufacturer)

9-52 Ashihara-Cho, Nishinomiya City, 662-8580, Hyogo, Japan

(Address)

hereby declare under our sole responsibility that the product

Inmarsat-B satellite earth station models FELCOM 82A (Class 1) and FELCOM 82B (Class 2)
consisting of Communication unit IB-282, Terminal unit IB-582, Antenna unit IB-182, Printer PP-510,
Telephone PC622SL1, Junction box 1B-313, Telex distress button IB-352, Telephone distress
button I1B-362, Receiver call unit IB-372, Handset |IB-882

{Model names, type numbers)

to which this declaration relates conforms to the following staqdard(s) or normative document(s)

IMO Resolution MSC.36(63): 01.01.96 — International Code of Safety of High-Speed Craft (HSC Code)

IMO Resolution A,694(17): 06.11.91 — General requirements for shipborne radio equipment forming part of the GMDSS
and for electronic navigational aids

IMO Resolution A.570(14): 20.11.85 - Type approval of ship earth stations

IMO Resolution A.808(19): 23.11.95 — Performance standards for ship earth stations capable of two-way
communications

MSC/Circ.862: 01.02.99 — Clarification of certain requirements in IMO performance standards for GMDSS equipment

IEC 61097-10: June 1999, Edition 1

EN 60945: 1997-01 (IEC 60945 Third edition: 1996-11)

IEC 61162-1: 2000-07

(titte and/or number and date of issue of the standard(s) or other normative document(s))

For assessment, see

» EC type-examination certificate N% 01212001/AA/01 of 7 May 2002 issued by Telefication, The
Netherlands

* Test report TI-1726 of 21 November 2000 prepared by Furuno Electric Co., Ltd.

« Test report FLI 12-00-032 of 25 December 2000 prepared by Furuno Labotech International Co., Ltd.

This declaration is issued according to the provisions of European Council Directive 96/98/EC on
marine equipment modified by Commission Directive 2001/53/EC.

On behalf of Furuno Electric Co., Ltd.

Sy 0 22" N\
R S =
X 7 77284

Hiroaki Komatsu
Nishinomiya City, Japan Manager,
June 17, 2002 International Rules and Regulations

.....................................................................................................................

(Place and date of issue) (name and signature or equivalent marking of authorized person)
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